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3D Basemaps 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. The capabilities have been replaced with 3D Buildings and Tree Data 
Management. 

Mature phase 
Nov. 2023 – Oct. 2025 

Retired phase 
Nov. 2025 

 

Introduction to 3D Basemaps 
3D Basemaps can be used to author and maintain a 3D basemap for your organization. 

It provides a series of workflows that streamline the creation and maintenance of a 3D basemap 
that supports diverse information needs. This optimized approach allows organizations to use 
existing data (for example, lidar, building footprints, and utilities) and generate 3D visualizations 
that increase understanding and community engagement. 3D Basemaps is typically 
implemented by planning departments, emergency management agencies, GIS departments, 
and utilities that want to use 3D basemaps to visualize the built environment. 

The 3D Basemaps solution delivers a set of capabilities that help you use existing data, develop 
a standard set of 3D layers, and visualize your community in an immersive way. 

 

Requirements 
The 3D Basemaps solution requires the following: 

• ArcGIS Online 

• ArcGIS Pro 2.9 or later (Advanced) 

– ArcGIS 3D Analyst extension 

– ArcGIS Spatial Analyst extension 

 

Information products 
3D Basemaps includes the following information products: 

Item Description 
Minimum user 
type 

3D 
Basemaps 

An ArcGIS Pro project used by GIS analysts and mapping 
technicians to create and maintain a 3D basemap for their 
organization 

GIS Professional 
Advanced 

 

Release notes 
The following are the release notes: 

https://www.esri.com/en-us/privacy/overview
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Version Description 

1.6 • A new 3D Basemaps ArcGIS Pro project to support ArcGIS Pro 3.1. 

• Updated Classify trees in lidar using deep learning task to use the latest version 
of the Classify Point Cloud Using Trained Model geoprocessing tool. 

1.5 • A new 3D Basemaps ArcGIS Pro project to support ArcGIS Pro 3.0. 

• Added a workflow to create 3D water features such as lakes, rivers and coastal 
waters from 2D polygon features. 

• New offset option in the Modify Ground Surface tool. 

• Added the ability to buffer floor plates inwards as well as outwards. 

• 3D Tree symbols can now be set through the symbology pane. 

1.4 • Added deep learning for power line classification in lidar. 

• Added the ability to extract power line features from lidar. 

• Any web map with feature layers can now be quickly added to your 3D basemap. 

1.3 • Resolved an issue when a meter-based coordinate system is used with the 
Windows language set to other than English. 

• Resolved an issue with roof form extraction when running multiple times on large 
datasets. 

1.2 • Added an integrated mesh editing and maintenance workflow. 

• Added the ability to color trees in lidar point clouds. 

• Lidar class codes can now be preserved when classifying trees using deep 
learning. 

• Improved stability of footprint segmentation. 

• Resolved an issue with extracting tree points using cluster analysis. 

1.1 • Added deep learning for tree classification in lidar. 

• Added tree extraction using cluster analysis. 

• Significantly improved the performance and quality of building footprint 
extraction. 

• Added links to 3D analysis solutions that can use 3D basemaps layers. 

• Resolved an issue with building footprint extraction in ArcGIS Pro 2.6. 

1.0 • First release of 3D Basemaps. 
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Use 3D Basemaps 
The 3D Basemaps solution delivers a set of capabilities that help you leverage existing data (for 
example, lidar, building footprints, utilities), develop a standard set of 3D layers, and visualize 
your community in an immersive way. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Get to know 3D Basemaps 
You will assume the role of a mapping technician responsible for creating a 3D basemap for 
your community. The 3D Basemaps ArcGIS Pro project includes a series of tasks to help guide 
you through these workflows. The first set of tasks will help you get to know 3D Basemaps. 

1. Start the ArcGIS Pro application and open the 3D Basemaps project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Getting to know 3D 
Basemaps task and go through the various subtasks. 

 

Understand the 3D Basemaps solution 

The 3D Basemaps solution uses existing data within the organization such as lidar, building 
footprints, power lines, and underground pipe features. Your 3D basemap can be created at 
different levels of detail (LOD) depending on the quality of the input lidar data. This first task will 
guide you through the data requirements and help you learn how you can utilize your 3D 
basemap in other workflows and applications. 

 

Download sample data 

Sample data is provided to help you learn how to use the 3D Basemaps solution. Click to 
expand the Getting to know 3D Basemaps task group and double-click the Download sample 
data task. Click the sample data hyperlink to download sample data for Naperville and 
Philadelphia. Using the sample data the first time will help you learn how to use the tasks and 
how to organize your data. 

 

Start using 3D Basemaps 

The 3D Basemaps project includes a task workflow that provides a structured sequence using 
tasks and steps. Follow the steps in this task to learn how to use the 3D Basemaps solution. 

 

Publish data for your 3D Basemaps 
After you have reviewed the Get to know 3D Basemaps section, you can begin using the 
solution with your data. The following set of tasks will help you learn how to use 3D Basemaps. 

1. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

https://www.esri.com/en-us/privacy/overview
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2. In the Catalog pane, expand the Tasks folder, and double-click the How to use 3D 
Basemaps task and go through the various subtasks. 

 

Publish ground elevation surface 
Detailed elevation layers can be automatically generated from the input lidar data. These layers 
are used to create buildings and vegetation layers. The ground elevation layer can be used to 
enhance the existing elevation in your 3D scene. 

To publish your ground elevation surface, click the Publish ground elevation surface task and 
follow the steps provided. 

 

Extract elevation surfaces from LAS dataset 

This task extracts three elevation surfaces from the LAS dataset: a ground elevation (dtm), a 
surface elevation (dsm), and a normalized surface elevation (ndsm). These surfaces are used to 
create buildings and vegetation layers. The ground elevation layer can also be used to improve 
the ground in your scene. 

 

Publish ground elevation 

This task publishes the ground elevation layer to your organization. Reprojection to Web 
Mercator with height in meters is only required if you want to use the published layers in a global 
web scene. 

 

Publish buildings 
Buildings with simple roof structures can be generated automatically from the lidar. Attributes 
such as building height, eave height, and the roof form are extracted from the lidar and added to 
the building footprints. Procedural rules are then used to create the 3D roof structures. High-
density lidar (point spacing less than 3 feet) and building footprint segmentation are needed to 
model complex roof structures. 

Note: 

The quality of the roof structures is dependent on the quality of the input lidar and building 
footprint data. A lidar point spacing of 3 feet or less is required, 1 foot or less is 
recommended. Building footprints with one roof type within their boundary (for example, 
suburban areas) will produce higher-quality roof structures than footprints with multiple roof 
types (for example, city centers). These footprints require splitting, segmentation, and 
updating of the roof form attributes. 

To publish your buildings, expand the Publish buildings group task and follow the steps 
provided. 
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Extract building footprints (optional) 

Run the Extract building footprints task to optionally extract building footprints from lidar. It is 
not required if you have an accurate footprint feature class. 

 

Preprocess building footprints (optional) 

Run the Preprocess building footprints task to prepare the building footprints for a realistic 
3D visualization. Some building footprints may contain several roof types and roof parts. To 
accurately represent these buildings, they need be split into their separate parts. Building 
footprints can be split with another feature class or by differences in elevation. 

 

This image shows the result of building extraction before preprocessing of building footprints. 

 

This image shows the result of building extraction after preprocessing of building footprints. 
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Tip: 

Separate features of similar size into separate feature classes before running segmentation 
to improve segmentation quality. Use different spectral and spatial detail for each of these 
feature classes to tweak the roof segmentation for your data. Merge the feature classes 
when finished. 

 

Create buildings 

Run the Create buildings task to create a 3D building layer. This task uses the elevation 
surfaces and building footprints to find both flat and sloped planar areas within a roof area of a 
building. It estimates a standard architectural form for the roof based on the attributes collected 
from these planar surfaces. These attributes are then used to inform a procedural rule that 
generates these features in 3D. 

 

This image shows the roof types that will be automatically classified. 

 

Review buildings 

Run the Review buildings task to inspect your building roof forms. The Confidence 
Measurement tool reports the following measurement (attribute added to the building 
footprints): 

Note: 

The RMSE field shows the root mean square error of the generated building multipatch to 
the underlying surface model. The higher this number, the more likely that the building 
creation encountered an error in classification. In general, a value of 1 meter (3 feet) or less 
is desirable, though this depends on the required application of the output features, and the 
resolution of the input data. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


 

Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal Page 8 

Modify buildings 

Use the Modify buildings task to further improve the quality of the building roof forms. The 
building roof form is driven by the attributes that are generated by the Create buildings task and 
by the underlying the building footprint. To refine the building roof form, modify the attributes or 
the building footprint. 

Tip: 

The attributes that control the roof form are building height, eave height, roof direction, and 
the type of roof are BLDGHEIGHT,EAVEHEIGHT, ROOFFORM, RoofDirAdjust. By 
editing these attributes, you can adjust your building models to better match the lidar data. 

 

Building footprint attributes that control the roof form. 

 

Building height 

If the ridge of the building is not at the correct height, identify the elevation of a LAS point on the 
true ridge by clicking the LAS point while having the Explore tool active. You will need to 
subtract the BASEELEV value from the LAS elevation to get the correct BLDGHEIGHT value. 

 

Results of manual updating of the BLDGHEIGHT attribute are shown. 

 

Eave height 

Similar to building height, reference the lidar to obtain the correct eave height. You will need to 
subtract the BASEELEV from the lidar elevation to get the correct the EAVEHEIGHT value. 

 

Results of manual updating of the EAVEHEIGHT attribute are shown. 
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Roof form 

If your roof type does not match the lidar data, change the roof type by choosing the correct roof 
form from the drop-down list. 

 

Results of manual updating of the ROOFFORM attribute are shown. 

 

Roof direction 

Adjust the direction of the roof by modifying the RoofDirAdjust field. The default value is 0. A 
value of 1 will rotate the roof counterclockwise 90 degrees, or a value of 2 will rotate it 180 
degrees. 

 

Results of manual updating of the RoofDirAdjust attribute are shown. 

 

Split roof segments 

Some building footprints may contain several roof types and roof parts. To accurately represent 
these buildings, you can split the footprints into separate features manually and update the 
attributes for each feature accordingly. 

To edit the building footprints, complete the following steps: 

1. Select the feature you want to segment. 

2. Use the Split tool in the Roof Segmentation task, or in the Modify Features pane to 
segment the selected feature. 

3. Edit the attributes as needed with the new sections of the building footprint. 
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Results of manual splitting of buildings are shown. 

 

Modify building vertices 

Sometimes building footprints may have been created incorrectly and do not represent the 
building adequately, resulting in lower-quality roof forms. 

To edit the building footprints, complete the following steps: 

1. Select the feature you want to modify. 

2. Use the Vertices tool in the Modify Building Vertices task, or on the Edit tab to modify the 
selected feature. 

3. Edit the attributes as needed with the modified building footprint. 

 
Results of manual updating of building vertices are shown. 

 

Create cross gable roof forms 

You can also use vertex editing to make cross gable roof forms. To do so, complete the 
following steps: 

1. Select the feature you want to modify. 

2. Use the Split tool in the Roof Segmentation task, or on the Edit tab to segment the 
building footprint according to the roof forms present within the footprint. 
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3. Use the Vertices tool in the Modify Building Vertices task, or in the Modify Features pane 
to extend one gable roof into the other one. 

4. Edit the attributes as needed with the modified building footprint. 

 

Results of manual updating of cross gable roof forms are shown. 

 

Fuse buildings 

If you have segmented some building footprints into separate features, you can use the Fuse 
buildings task to fuse the building features that represent building parts back together in the 
resulting 3D building features. 

Note: 

Review and modification of buildings is done on the building footprint layer with procedural 
symbology. Fusing saves the modification to multipatch format for texture adding and 
publishing. 

 

Add textures to buildings (optional) 

Use this task to add realistic textures to the previously extracted buildings. 

Note: 

Textures depict generic usage of buildings and are applied based on footprint size. Using 
high-resolution textures will result in large output, potentially leading to decreased 
visualization performance. 

 

Publish buildings layer 

This task publishes the building layer to your organization. Reprojection to Web Mercator with 
height in meters is only required if you want to use the published layers in a global web scene. 

 

Update buildings (optional) 

Use this task if new lidar is available. It compares an existing 3D multipatch building layer with a 
new lidar dataset to verify whether there are any updates required due to new construction or 
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demolition. If changes have been detected, these can then be merged back into the original 3D 
building layer. 

To update your existing buildings, you will need the following data: 

• Multipatch buildings 

• Lidar with ground and buildings classified 

The Update Buildings process accomplishes the following purposes: 

• Detects changes between input 3D multipatch buildings and new lidar. The output is 
building update polygons where changes have been detected depending on the input 
parameters. 

• Creates LOD2 update buildings using the building update polygons and the lidar. 

• Merges the LOD2 update buildings with the existing 3D buildings. 

 

Publish floors 
Building Floors can be created using the Publish floors task. The input is multipatch buildings, 
which can come from the Publish buildings task or from other sources such as CityEngine or 
third-party providers. The output is building floor plates and floor volumes. Floors can be created 
using a Building Space Use table where the building will be split into tiers or groups of floors, 
each with their own number of floors, floor height, space use, and color. Alternatively, building 
attributes such as number of floors, ground floor height, upper floor height, and roof height can 
be used to create the floors. 

Note: 

Splitting buildings into floors can take a long time to run, especially when the initial split 
failed, and a more time-intensive splitting algorithm must be used. Ensure you only split the 
buildings that are required. Also, factors such as building size and complexity will affect the 
processing time. 

In the Task Pane, click the Publish floors task and follow the steps provided. 

 

Create building floors 

This tool splits existing 3D buildings into floors based on building attributes. You can use the 
buildings created in the Publish buildings task or bring in your own buildings. 

One option to create building floors is to use the building space use table to split the building 
into tiers or groups of individual floors with defined space use. The building space use table has 
several attributes that describe the different tiers within the building. Each tier has an attribute 
defining space use, number of floors, floor color, and floor height. The BuildingTypeName 
attribute is the identifier that links the Building Space Use table to the building features. An 
example building space use table can be found in the tables folder of the 3D basemaps ArcGIS 
Pro project. 
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Create floor volumes 

If you require floor volumes, use the Create floor volumes task to create floor volumes out of the 
3D floor plates. The Extrude By Attribute geoprocessing tool requires a building feature class 
with space usage information that includes floor height. 

 

Publish trees 
Tree location, size, and width can be extracted from ground classified lidar as point features. 
Tree point features are then symbolized using procedural rules and can be schematic or 
realistic. If trees are classified in the lidar, the quality of the tree extraction will improve. 

In the Task pane, expand the Publish trees group task and follow the steps provided. 

 

Classify trees in lidar using deep learning 

Run this tool to optionally classify trees in the lidar using a deep learning model. Classified trees 
will improve the vegetation extraction but keep in mind that deep learning is computationally 
very intensive, and a powerful GPU is needed to process large datasets faster. Depending on 
data size and available hardware, it can take hours to finish. Start with one LAS file to see 
processing time on your system. 

To work with the deep learning tools in ArcGIS Pro, you need to install supported deep learning 
frameworks packages. See deep learning frameworks for ArcGIS. 

A tree classification model trained by Esri can be downloaded from ArcGIS Living Atlas of the 
World or you can create your own model using the Training a Deep Learning model for Point 
Cloud Classification notebook that can be found in the notebooks folder of the 3D basemaps 
ArcGIS Pro project. 

 

Extract tree points using surface analysis 

Use this tool to extract tree points from the lidar using surface analysis. This type of extraction is 
faster for large lidar datasets, but the results are less accurate than using cluster analysis for 
dense lidar (point spacing less than 1.5 feet/0.5 meters). 

 

Extract tree points using cluster analysis 

Use this tool to extract tree points from the lidar using cluster analysis. This type of extraction is 
slower for large lidar datasets, but the results are more accurate than using surface analysis. 

Note: 

When creating the 3D trees, make sure to verify the Vegetation class code. The correct 
class codes for vegetation is typically 5. The tool will verify whether your lidar has this code, 
but trees might be represented by other codes as well. Visually review your lidar and verify 
what class code tree points have by clicking a tree lidar point. If the vegetation has not been 
classified, enter the class code that represents the vegetation, for example, 0 or 1. 
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Tip: 

Use the Extract tree points using surface analysis tool to create an initial vegetation layer. 
Run the Extract tree points using cluster analysis tool for lidar files for which you need 
detailed trees and replace the trees from the initial layer with the more detailed trees where 
needed. 

 

Create colorized lidar trees 

Classified lidar can also be used directly to visualize trees. This step extracts just the tree points 
from the input lidar and uses aerial imagery to colorize them. 

 

Publish bridges 
If bridge surfaces are classified in the lidar and the lidar is dense enough, it is possible to extract 
the bridge surfaces as 3D polygons. 3D bridges can then be created by applying procedural 
rules. 

In the Task pane, expand the Publish bridges group task and follow the steps provided. 

 

Create bridges 

In the Extract bridge surfaces from lidar step, enter the following: 

• Class Code—The class code that represents the bridge surfaces. 

• Sampling Value—Experiment with this value to improve processing speed and output 
quality. 

• Bridge Area—This is the minimum area that defines a bridge surface. 

Note: 

The bridge surface should be a separate class code. If bridge surfaces are not classified in 
the lidar, you can interactively classify the bridge surfaces in ArcGIS Pro. 

Note: 

Only rectangular bridge surfaces and models are supported. 

 

Publish power lines 
Power line features such as wires and support structure locations with height can be extracted 
from classified lidar as line and point features. Simple symbology or procedural rules can be 
used to visualize the power lines in 3D. A wide variety of conductor and tower configurations are 
supported when using procedural rules. It is also possible to use your existing GIS data instead 
of the features extracted from lidar. 
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In the Task pane, expand the Publish power lines group task and follow the steps provided. 

 

Classify power line features in lidar using deep learning 

Run this tool to optionally classify wires and support structures in the lidar using a deep learning 
model. Classified power lines will improve the wire and support structure locations extraction, 
but keep in mind that deep learning is computationally very intensive, and a powerful GPU is 
needed to process large datasets faster. Depending on data size and available hardware, it can 
take hours to finish. Start with one .las file to see processing time on your system. 

To work with the deep learning tools in ArcGIS Pro, you need to install supported deep learning 
frameworks packages. See Install deep learning frameworks for ArcGIS. 

A power line classification model trained by Esri can be downloaded from ArcGIS Living Atlas, 
or you can create your own model using the Training a Deep Learning model for Point Cloud 
Classification notebook that can be found in the notebooks folder of the 3D basemaps ArcGIS 
Pro project. 

After classification using deep learning, you can manually improve the classification further in 
the next step. 

 

Extract wires from lidar 

This step extracts the wires as features from the classified lidar. It models each segment of a 
power line between two suspension points as individual line features. Use this step if you need 
to extract all wires as PolylineZ features. 

Note: 

For best extraction results, ensure the average lidar point spacing is less than 1 foot or 30 
centimeters. 

 

Extract support structure locations from lidar 

Use this step to extract the support structure locations from lidar as PointZ (x,y,z) features with 
height as the attribute. 

Note: 

For best extraction results, ensure the average lidar point spacing is less than 1 foot or 30 
centimeters. 

 

Symbolize wires 

Use this step to visualize the wire features that were extracted from lidar as 3D tubes. 
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Symbolize support structure locations 

Use this step to symbolize the support structures as complete transmission or distribution lines 
including wires and towers or poles. This can be useful if you need a realistic visual 
representation of the transmission or distribution lines with wires connected to the support 
structures. 

Note: 

In this step, wires are modeled as catenary curves with a default sag to span ratio of 0.035, 
which may differ from the classified wire points in the lidar. 

Run the Create transmission lines task to create 3D transmission lines. Enter the following: 

• Voltage—Select the voltage for the transmission line. The values for the voltage list are 
read from the TowerLUTable table located in the project tables directory. Change these 
values to modify conductor and tower features. 

• Tower configuration—Experiment with these parameters to create the desired towers. 

Run the Create distribution lines task to create 3D distribution lines. Enter the following: 

Pole configuration—Experiment with these parameters to create the desired poles. 

Note: 

Both tools support point features as input. You can use existing features or features that 
have been extracted from lidar, or you can manually create features. A line and tower 
attribute must be present. The line attribute should describe which line the points belong to 
and the tower attribute should describe the tower order per line. Connected lines are not 
supported. 

Note: 

This tool requires that the Microsoft Access Database Engine driver be installed. 

 

Publish underground pipes 
You can turn your existing 2D underground utility features into 3D features using elevation 
attributes. 

In the Task pane, expand the Publish underground pipes group task and follow the steps 
provided. 

 

Create gravity mains 

Run the Create gravity mains task to create 3D gravity-driven mains. The first time you run this 
step, you evaluate the current state of the gravity mains and highlight errors. After reviewing the 
errors and updating fields that are incorrect, run Interpolate gravity mains to calculate any 
remaining missing values. 
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Create manholes 

Run the Create manholes task to create 3D manhole features. 

 

Create laterals 

Run the Create laterals task to create 3D lateral features. 

 

Create a surface trench 

Run the Create a surface trench task to better visualize underground pipe features. 

 

Publish integrated mesh 
An integrated mesh is a textured continuous meshed surface capturing a current state of an 
area or city. They are often derived from drone, aerial, or satellite imagery via photogrammetric 
processing. 

In the Tasks pane, expand the Publish integrated mesh group task and follow the steps 
provided. 

 

Add integrated mesh 

This step adds an integrated mesh to your scene. A mesh (.slpk) is typically created from 
photogrammetric sources, like imagery captured by drones and processed with Drone2Map or 
SiteScan. There are also several Esri partners that specialize in producing city-scale integrated 
mesh for purchase. 

 

Modify integrated mesh 

Use this step to make a modification to an integrated mesh layer. You can create a new 
modification or import from an existing polygon feature layer. Mesh modifications are useful to 
be able to show other 3D layers such as buildings, trees or bridges together with the integrated 
mesh. 

 

Publish integrated mesh layer 

This step publishes the integrated mesh layer to your organization. Reprojection to Web 
Mercator with height in meters is only required if you wish to use the published layer in a global 
web scene. 

Run Share as new web scene to publish the entire scene as web scene to your organization. 
Remove all the layers that you don't want to publish from the scene before publishing. 

Run Share as scene layer if you need to add an integrated mesh to an existing web scene. 
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Modify integrated mesh in web scene 

This tool modifies an integrated mesh in a published web scene without having to republish the 
entire mesh as a new web scene. 

 

Publish water features 
This task allows you to create and publish 3D water features as multipatch features and polygon 
features. Water features can represent flat water bodies such as lakes and coastal waters as 
well as rivers with a certain gradient. This task works well with flat water features and river 
features at city scale. Larger features with a lot of gradient will results many polygons which 
may lead to performance degradation. 

 

Create water features 

This step creates water features as 2D polygons. You can skip this step if you already have a 
polygon feature class that defines the water features. 

 

Modify water features 

The water features need to have a depth attribute that describes the average depth for each 
water feature. These values are used to modify the ground elevation for the area of the water 
features so that the water surface features display properly. 

In this step you can calculate the depth values for all water features. If you want specific depth 
values for each water features, open the feature attribute table and set the values manually. 

 

Create 3D water features 

This step allows you to create 3D water features from the 2D water features and a ground 
elevation (dtm) surface as input. 

This tool outputs a multipatch layer and a polygon layer representing the 3D water level. Use 
the multipatch layer to visualize large areas of flooding as this format is suited for fast rendering 
of many features. Use the polygon layer if you want to leverage water animation in ArcGIS Pro 
and the Scene viewer. 

 

Symbolize water features 

Use this step to symbolize the water features with a water renderer. 

 

Publish 3D Basemaps 
The 3D basemap is a web scene that can be used across the ArcGIS platform. 

In the Task pane, expand the Publish 3D basemap web scene group task and follow the 
steps provided. 
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Publish 3D basemap web scene 

Use this step to create a web scene containing the 3D basemap layers. 

Tip: 

For more information on creating a web scene, see Get started with scenes. 

 

Add web map to web scene 

Use this step to add the layers of a web map to a web scene; for example, you can add a web 
map to the 3D basemaps web scene. 
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Address Field Operations 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. The capabilities have been replaced with Address Data Management. 

Mature phase 
Nov. 2023 – Oct. 2025 

Retired phase 
Nov. 2025 

 

Introduction to Address Field Operations 
Address Field Operations can be used to crowdsource missing address information from 
stakeholders, manage address fieldwork, and collect and verify address information while in the 
field. 

Current and accurate address data is an essential requirement for a variety of functions, 
including emergency management, as well as administration, research, publications, mapping, 
routing, navigation, and many other purposes. Successful address authorities assign addresses 
early in the development life cycle and improve the integrity of their address repository with 
quality control procedures that incorporate feedback from stakeholders. Address Field 
Operations is typically implemented by planning departments, public safety agencies, GIS 
departments, and other local government organizations that want to continuously improve an 
address repository that supports a variety of government functions. 

The Address Field Operations solution delivers a set of capabilities that help you solicit missing 
or inaccurate address information from internal and external stakeholders, verify these 
submissions in the office, or create work assignments and dispatch staff to verify and collect 
new address information from a mobile device in the field. 

 

Requirements 
Address Field Operations requires the following: 

• ArcGIS Online 

• ArcGIS Workforce 

• ArcGIS Collector 

 

Information products 
Address Field Operations includes the following information products: 

Item Description 
Minimum 
user type 

Address 
Crowdsourcing 

An ArcGIS Survey123 form used by addressing staff to 
crowdsource missing address information from stakeholders. 

Editor 
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Address 
Assignments 

An ArcGIS Workforce Classic project used by addressing staff 
to manage address field operations. Field users access the 
Address Assignments project using the Workforce for ArcGIS 
mobile app. 

Mobile 
Worker 

Address Field 
Inventory 

An ArcGIS Collector map used by addressing staff to collect 
address information while in the field. 

Mobile 
Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Address Field Operations 
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Use Address Field Operations 
The Address Field Operations solution delivers a set of capabilities that help you solicit missing 
or inaccurate address information from internal and external stakeholders, verify these 
submissions in the office, or create work assignments and dispatch staff to verify and collect 
new address information from a mobile device in the field. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Submit a missing address 
You will first assume the role of an employee in the public works department. When attempting 
to issue a permit, you search for an address, but no result is returned. You will use the Address 
Crowdsourcing form to report the missing address. 

1.  Sign in to your ArcGIS organization and browse to the Address Crowdsourcing form. 

2. Open the item page and click Open in Survey123 > Open in browser. 

3. In the Address Crowdsourcing form, fill in the following details: 

  Questions 
  Answers 

  Address 
Number 

  Type an address number. 

  Full Road Name   Type the name of a road. 

  Municipality   Type the name of your municipality. 

  Select Location   Zoom and pan in the map to the approximate location of the 
missing address. 

  Full Name   Type your name. 

  Email   Type your email address. 

  Phone   Type your phone number. 

4. Click Submit. 

 

Assign a missing address for verification 
You will now assume the role of a supervisor at an addressing authority. As a supervisor, you 
are responsible for assigning field crews to verify missing or incorrect address reports from 
stakeholders. Using the Address Assignments ArcGIS Workforce Classic project, you will create 
a new assignment using the missing address report and assign it to one of your mobile workers. 
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1. Verify that you are signed in to your ArcGIS organization and click the Apps button  in 
the header of the site. 

2. From the app launcher, click  Workforce to open the app. 

3.  Under Classic projects, click Address Assignments to open the project. 

  Tip: 

  When implementing the Address Field Operations solution in your organization, you 
must add anyone responsible for verifying addresses in the field to the Address 
Assignments ArcGIS Workforce Classic project with a Mobile Worker role. You can add 
users and assign roles in the configuration settings of the project. To access 
configuration settings, hover over Address Assignments project and click Configure. 
Click the Users tab. For the purposes of this exercise, ensure your named user account 
is assigned as a dispatcher and as a mobile worker. Click My Projects tab to return to 
your projects. 

4. On the map, select the address you created in the previous section and click the + Create 
Assignment at the bottom of the pop-up window. 

5. From the Create Assignment panel, fill in the following details: 

– For Assignment Type, choose Verify Address. 

– For Assigned to, choose a worker. 

– For Priority, choose Medium. 

– For Due Date, choose tomorrow. 

6. Click Create Assignment. 

 

Verify missing addresses 
You will now assume the role of a mobile worker at an addressing authority. As a mobile worker, 
you are responsible for verifying missing or incorrect address reports. Using the Address 
Assignments ArcGIS Workforce Classic project, you will review and update the status of your 
assignments and open the Address Field Inventory map in ArcGIS Collector to verify missing 
addresses. 

1. Download Workforce for ArcGIS and ArcGIS Collector apps onto your mobile device. 

2. Open the Workforce for ArcGIS app and sign in to your ArcGIS organization. 

3. Tap the Address Assignments project. 

4. Tap Verify Address from the To Do list. 

5. Tap Start. 

6. From the overflow menu, tap Collect at Assignment. 

  This opens the Address Field Inventory map in ArcGIS Collector and defaults to the 
location of the assignment and drops a pin. 

7. Tap Close to cancel the dropped pin. 

8. Tap the missing address point at the same location. 

9. Tap Edit to modify the details of the address. 

  At this point, verify the details of the address and make any necessary changes to the 
attributes and location of the address. 

10. Tap Verified and tap Yes. 
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11. Tap Submit. 

  The address point changes from red to green and now reflects any edits you made during 
verification. 

12. Return to the Workforce for ArcGIS app and tap Finish to complete the assignment. 

 

Collect new addresses 
You will continue your role as a mobile worker at an addressing authority. You are responsible 
for collecting addresses for a new subdivision in the community. You will use the Address Field 
Inventory map in ArcGIS Collector to collect new addresses in the field. 

1. From your mobile device, open the ArcGIS Collector app. 

  Tap the back arrow, if necessary, to go back to the Maps list. 

2. Tap the Address Field Inventory map. 

3. Tap Add. 

4. By default, the point is set at your current location. Adjust the location on the map as 
necessary and tap Add Point. 

5. Swipe up and enter the details of the address. 

  When adding multiple addresses, they may have common attributes such as the road 
name and municipality. You can create a copy of an existing address point by selecting it 
and tapping Copy. 

6. Tap Submit. 
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Coronavirus Business Continuity 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. 

Mature phase 
Nov. 2023 – Oct. 2025 

Retired phase 
Nov. 2025 

 

Introduction to Coronavirus Business Continuity 
Coronavirus Business Continuity can be used to maintain business operations and share 
authoritative information with customers and stakeholders during the coronavirus disease 2019 
(COVID-19) pandemic. 

The rapid switch to home offices, frequently changing government regulations, and employee 
inability to report to work has made it difficult for organizations to understand the capacity of 
their workforce during the COVID-19 pandemic. Organizations need to know who is able to work 
and where employees are working from to make business continuity decisions. Having 
personnel perform a daily self-check-in or having supervisors check in with their teams gives 
organizations clarity into workforce capacity. Coronavirus Business Continuity is typically 
implemented by organizations that want a clear understanding of workforce capacity and facility 
status to help them adapt and ensure business continuity. 

The Coronavirus Business Continuity solution delivers a set of capabilities that help you 
understand the operational capacity of your workforce, monitor the status of your facilities, and 
communicate your reopening plans to customers and employees. 

 

Requirements 
Coronavirus Business Continuity requires the following: 

• ArcGIS Online 

 

Information products 
Coronavirus Business Continuity includes the following information products: 

 

Item Description 
Minimum user 
type 

Individual 
Check-in 

An ArcGIS Survey123 form used by employees or 
contract personnel to report their work status 

Editor 

Team Check-in An ArcGIS Survey123 form used by a manager, 
supervisor, or team lead to report the work status of 
their personnel 

Editor 
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Personnel 
Status 
Dashboard 

An ArcGIS Dashboards app used by human resources 
executives or incident commanders to monitor 
workforce capacity 

Viewer 

Team Status 
Dashboard 

An ArcGIS Dashboards app used by a manager, 
supervisor, or team lead to monitor the capacity of their 
team. 

Viewer 

Facility Status 
Reporter 

An ArcGIS Web AppBuilder app used by facility 
managers to look up facilities they are responsible for 
and submit a report 

Editor 

Facility Status 
Report 

An ArcGIS Survey123 form used by a building or facility 
manager to report facility and operational status 

Editor 

Facilities Status 
Dashboard 

An ArcGIS Dashboards app used by executives and 
managers to monitor the operational status of their 
facilities 

Viewer 

Coronavirus 
Business 
Continuity 

An ArcGIS Hub site used by businesses, utilities, and 
government agencies to share COVID-19 health and 
safety plans with employees returning to the workplace 
and customers who visit their place of business 

Viewer (required 
for internal 
destination page) 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

2.0 • A new ArcGIS Hub site used by businesses, utilities, and government agencies 
to share COVID-19 health and safety plans with employees returning to the 
workplace and customers who visit their place of business 

• A new Facilities feature layer that supports the implementation of the 
Coronavirus Business Continuity and Coronavirus Business Reopening solutions 

• A new Individual Check-in survey that supports the implementation of the 
Coronavirus Business Continuity and Coronavirus Health Screening solutions 

1.0 • First release of Coronavirus Business Continuity 
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Configure Coronavirus Business Continuity 
Coronavirus Business Continuity can be used to maintain business operations and share 
authoritative information with customers and stakeholders during the coronavirus disease 2019 
(COVID-19) pandemic. 

In this topic, you'll learn how to configure the Coronavirus Business Continuity solution to meet 
specific needs in your organization. 

 

Load data 
To load personnel and facilities data, complete the following two workflows. 

 

Load personnel data from a spreadsheet 

Personnel information must be loaded before using the Individual Check-in, Team Check-in, 
and related dashboards. The Check-in forms require a user to sign in with a user name. The 
signed-in user name is automatically associated with their full name, team, and office location 
whenever a check-in is submitted. Personnel information is stored in a table in the Personnel 
feature layer, and you can use the PersonnelSource.csv file to organize your personnel 
information before loading it into ArcGIS. Ensure that you populate the user name column in the 
PersonnelSource.csv file with the ArcGIS user names in your organization that use the 
Individual Check-in or Team Check-in forms. 

To load personnel data from a spreadsheet, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the PersonnelSource.csv item. 

2. From the item page, click Download. 

3. Open the CSV file and edit it with your information. 

4. Save and close the file. 

5. In your ArcGIS organization, browse to the Personnel feature layer. 

6. From the item page, click Update Data. 

7. Follow the steps in the Update data wizard to load your data. 

  Tip: 

  In some cases, you may need to add or modify past check-in information. The Creator 
and CreationDate fields on feature layers are not editable when editor tracking is 
enabled. However, you can temporarily disable editor tracking on the layer and then load 
or modify your check-ins. Once you have completed loading your source data, reenable 
editor tracking on the layer. 

 

Load facilities from a spreadsheet 

Facilities must be loaded before using the Facility Status Reporter and Facility Status 
Dashboard. You can use the FacilitiesSource.csv file to inventory your facilities before loading it 
into ArcGIS. 
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To load your facilities from a spreadsheet, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
FacilitiesSource.csv item. 

2. From the item page, click Download. 

3. Open the CSV file and edit it with your information. 

  Note: 

  At a minimum, you must provide a unique facilityid and the latitude and longitude for 
each facility. If you don’t have a unique ID, you can edit the .csv in Excel and copy this 
formula into the first row of the facilityid column: =CONCATENATE("Facility-", 
TEXT(ROW(A1),"00000")). You can then drag the right corner of the cell to fill the 
formula down for all facilities giving each a unique ID. 

4. Save and close the file. 

5. In your ArcGIS organization, browse to the Facilities feature layer. 

6. From the item page, click Update Data. 

7. Follow the steps in the Update layer wizard to load your data. 

 

Configure the Coronavirus Business Continuity site 
The Coronavirus Business Continuity solution includes the Coronavirus Business Continuity 
ArcGIS Hub site. This site can be configured with your organization's branding and used to 
share information with the public and employees about how the organization is keeping 
customers, residents, and employees safe as organizations return to work during the 
coronavirus disease 2019 (COVID-19) pandemic. 

The Coronavirus Business Continuity site contains information for the public and is intended to 
be shared with everyone and available to anonymous users. The Internal Destination page 
contains information for employees and is intended to be shared inside the organization and 
only available to named users in the organization. The Internal Destination page also includes 
content intended for facility managers or executives and is only visible to users in the 
organization who are members of specific groups. 

 

Update with organizational information 

After deploying the Coronavirus Business Continuity solution, the Coronavirus Business 
Continuity Hub site layout only requires a few updates to fit your local context. 

To update the site with your organizational information, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to Coronavirus 
Business Continuity site. 

2. From the item page, click Configure. 

3. Scroll to any sections that you want to update, hover over the card, and click the edit pencil 

 that appears in the horizontal toolbar, and then edit the content with information 
specific to your organization.  

4.  In the side panel, click Footer. 
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  A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

5. Click the HTML text box. 

  The HTML window appears. 

6. Make the necessary changes and click Apply. 

7. Click Save. 

8. Click the Save drop-down arrow and click Publish Draft. 

9. To edit content on the associated Internal Destination Hub page, follow these steps: . 

a. At the top left, click the Coronavirus Business Continuity drop-down arrow and 
choose Site Home. 

b. To the right of Customize, click the number of associated pages button. 

c. Under Home, click Internal Coronavirus Business Continuity. 

d. Scroll through the page to a section that you want to update, click the edit pencil, 
and edit the content with information specific to your organization. 

e. Click Save. 

f. Click the Save drop-down arrow and click Publish Draft. 

 

Extend business continuity surveys 
The Coronavirus Business Continuity solution includes a series of surveys (Individual Check-in, 
Team Check-in, and Facility Status Report) that can be used to understand the capacity of your 
workforce and status of facilities you operate. 

Review the preconfigured questions and adjust as necessary to remain in compliance with your 
organizational policies and any applicable laws. In addition, ensure you secure the survey and 
underlying layers and only share the content with appropriate members of your organization. 

 

Update feature layer views 

The Coronavirus Business Continuity solution includes a series of views created from the 
Facilities and Personnel feature layers. Organizations may want to modify the Facility Status 
Report and Individual Check-in surveys by first adding new fields to the feature layers and then 
configuring the surveys to use the newly created fields. When doing so, the new fields must be 
exposed in the appropriate views. Additionally, some views are created by joining two sources 
together, and these views must be re-created with the same name and URL after a new field is 
added. 

Organizations may want to modify the Facility Status Report, Individual Check-in, and Team 
Check-in surveys by adding new survey questions. When adding new questions, begin with the 
Update feature layer views section below. For changes such as removing questions or 
formatting the survey, proceed to the Modify business continuity surveys section. 

To add one or more fields to a layer and re-create the views, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization. 

2. Add a new field to a layer in the Facilities or Personnel hosted feature layer. 

3. Browse to the view in your contents. 

4. Open the item page and click the Visualization tab. 
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5. Click More Options on the appropriate layer or table and click Set View Definition > 
Define Fields. 

6. Scroll to the newly created field and check the box next to the new field or fields. 

7. Click Apply. 

  The new field is added to the view’s definition. 

To update a join view, complete the following steps: 

1. Browse to the join view in your contents (for example, Facilities_current). 

2. Open the item page and scroll to the URL section. Click the Copy button. 

3. Paste the copied URL into Microsoft Notepad or another text editor for reference. 

  Note: 

  The feature layer name will be used below when re-creating the join. The name can be 
found after services in the URL structure and may also contain a unique GUID, for 
example, Facilities_current_a45f71a48587425c9b90ee5527cd26d1. 

4. Click the Settings tab. 

5. Click the Delete Item button and click Delete. 

6. Browse to the source hosted feature layer (for example, Facilities). 

7. Open the item page and click Open in Map Viewer Classic. 

8. Click the Analysis button and click Summarize Data > Join Features. 

9. Configure the join using the following table: 

Target 
layer 

Layer to 
join to the 
target 
layer 

Types 
of join 

Fields to 
match 

Join 
operatio
n 

Define which record 
is kept 

Result layer 
name 

Facilities Facilities 
Status 
Report 

Choos
e the 
fields 
to 
match 

GlobalID 
= 
facilitygui
d 

Join one 
to one 

Order by 
created_date/Newe
st 

Facilities_current 

Facilities Facilities 
Status 
Report 

Choos
e the 
fields 
to 
match 

GlobalID 
= 
facilitygui
d 

Join one 
to one 

Order by 
created_date/Newe
st 

Facilities_public 

Personnel Personnel 
Informatio
n 

Choos
e the 
fields 
to 
match 

Creator = 
username 

Join one 
to one 

Order by 
CreateDate/Newest 

Personnel_all 

Personnel 
Informatio
n 

Personnel Choos
e the 
fields 

Usernam
e = 
Creator 

Join one 
to one 

Order by 
CreateDate/Newest 

Personnel_curre
nt 
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to 
match 

  Note: 

  Ensure each new join view uses the names defined in this table. If you use the same 
names, the layers in the map and the existing dashboard widgets do not have to 
reconfigured. If your join view contains a unique GUID, the new join view needs to be 
named with the unique GUID. 

10. Uncheck Use current map extent, if checked.  

11. Check Create results as hosted feature layer view. 

12. Update the Personnel Status Dashboard or Facilities Status Dashboard to account for the 
new fields you added to the layers. 

 

Modify business continuity surveys 

To modify a Coronavirus Business Continuity survey, complete the following steps: 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Facility Status Report to download the survey. 

  Note: 

  The Facility Status Report survey is an example. The steps below are the same for the 
Individual Check-in or Team Check-in surveys. 

3. In the Download window, click Download and click OK. 

4. Click Facility Status Report again to open the survey. 

5. On the side toolbar, click the Open XLSForm Spreadsheet button. 

6. In the Microsoft Excel spreadsheet, click the choices tab.  

  This tab comprises all the selectable options for survey questions. 

7. Revise the survey to reflect your needs. 

8. Save and close the Microsoft Excel spreadsheet. 

9. In ArcGIS Survey123 Connect, click Publish on the side toolbar. 

10. Click Publish survey to publish your changes and click OK. 
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Use Coronavirus Business Continuity 
The Coronavirus Business Continuity solution delivers a set of capabilities that help you 
understand the operational capacity of your workforce, monitor the status of your facilities, and 
communicate your reopening plans to customers and employees. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Monitor workforce capacity 
The coronavirus disease 2019 (COVID-19) pandemic has significantly affected the workforce of 
many organizations. Personnel who typically report to an office may be forced to work from 
home, facilities may be closed or access may be restricted to essential workers, and workers 
may be unable to report to work due to household issues. Organizations need to know who is 
able to work and where employees are working from to make business continuity decisions. 
Having personnel perform a daily self check-in or having supervisors check in their teams gives 
organizations clarity into workforce capacity. 

The Coronavirus Business Continuity solution includes an Individual Check-in form that collects 
information from personnel including their work status, work location, and wellness information. 
Organizations deploying the Coronavirus Business Continuity solution should review the 
preconfigured questions and adjust as necessary to remain in compliance with organizational 
policies and applicable laws. In addition, ensure that you secure the survey form and underlying 
layers and only share the content with appropriate members of your organization. 

Some organizations may find it more efficient to have managers, supervisors, or team leads 
check their team members in using the Team Check-in form. If your organization decides to use 
the Team Check-in form, you can follow the same general steps described here but with the 
Team Check-in form and the Team Status Dashboard. 

 

Complete individual check-in 

You will start by assuming the role of an employee or contractor in a government agency, 
business, or utility. You have been asked to use the Individual Check-in form to share your work 
status each morning. 

1. In a browser, from the Coronavirus Business Continuity solution, view the Individual Check-
in form. 

2. Complete the form with as much information as possible. 

  Note: 

  Required questions are marked with a red asterisk. 

3. Click Submit. 
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Monitor individual check-ins 

Now, you will assume the role of a human resources or operations manager in the same 
government agency, business, or utility. You are asked to monitor the capacity of your 
workforce and are looking to see if your organization has business locations or teams that lack 
the staff required to continue operations. You will view the overall status of your workforce and 
then look more closely at specific locations and trends. 

Note: 

The steps below are the same if you choose to use the Team Status Dashboard app to 
monitor the capacity of your team. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Business Continuity solution. 

2. View the Personnel Status Dashboard app. 

  The Personnel Status Dashboard app opens with an overview of the current status. 

  The overview displays key metrics. This information gives management a quick overview of 
the number of team members working from their normal locations, from home, and offsite. 
Any absences and statistics related to the overall health of your workforce are also shown. 

3. On the left, in the filter panel, for Check-in Type, choose Individual. 

4. At the lower-right corner of the dashboard, click the All tab to see a complete list of check-
ins. 

5. On the left, in the filter panel, set additional filters to further refine the dashboard results. 

  You can filter by location, team, date, and other key metrics captured in the Individual 
Check-in form. In the Personnel list, you can click an employee to see additional details. 

6. On any indicator, click the History tab to review results over time; move the slider in each 
chart to adjust the time period displayed. 

7. At the lower-right corner of the dashboard, click the Offsite Personnel tab to see the 
location of all personnel working offsite. 

 

Track facility status 
As the COVID-19 pandemic develops, some organizations have been required to rapidly close 
facilities or have decided to greatly reduce the number of personnel working in certain facilities. 
Having visibility into the status of all facilities is a critical component in making business 
continuity decisions. Daily or periodic status reports from facilities help organizations make 
informed decisions and necessary operational changes. 

The Coronavirus Business Continuity solution includes a Facility Status Report form for facility 
managers to report the status of the facilities they are responsible for and a Facilities Status 
Dashboard app to monitor results. Organizations deploying the Coronavirus Business Continuity 
solution should review the preconfigured questions and adjust as necessary to remain in 
compliance with organizational policies and applicable laws. 
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Complete a facility status report 

You will start by assuming the role of a local facility manager in a government agency, business, 
or utility. You have been asked to use the Facility Status Reporter app and Facility Status 
Report form to share the status of your facility each day or on a weekly basis. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Business Continuity solution. 

2. View the Facility Status Reporter app. 

3. On the right, in the Locate facility widget, search for a facility; alternatively, click a location 
on the map. 

4. Review the facility details. 

5. Click Submit Status Report. 

6. Complete the Facility Status Report form with as much information as possible. 

7. Click Submit. 

 

Monitor facility status 

Now, you will assume the role of a facility manager or operations manager in the same 
government agency, business, or utility. You have been asked to monitor the status of your 
facilities and are looking to see if your organization has business locations that may be 
impacted by the COVID-19 pandemic. You will view the status of all facilities and then look more 
closely at specific locations and trends. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Business Continuity solution. 

2. View the Facilities Status Dashboard app. 

  The overview displays key metrics. This information gives management a quick overview of 
the number of facility reports they have received, operational status of their facilities, and 
staffing capacity at all facilities. 

3. On the left, use filters to refine the results by facility name, country, or geographic region, 
or by various key facility characteristics. 

4. On the right, in the Number of Facilities list, select a facility to review facility information; 
alternatively, click a facility on the map. 

  Note: 

  In some instances, organizations may want to review COVID-19 case information around 
their facilities. In the United States, this information is available at the county level and 
can be added to the Facilities Status Dashboard map. After you add it to the web map, it 
is available to facility managers and operations managers when they review the status of 
their facilities. 

 

Review return to work resources 
As an employee in a government agency, business, or utility, you are interested in learning 
more about what the organization is doing to keep you and your family safe as you begin to 
return to work. You will use the Coronavirus Business Continuity site to learn about which 
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facilities are open and how their hours may be impacted, the safety plans in place at those 
facilities, and how you can check in and complete a health screening if you are coming into the 
office. 

1. In a browser, from the Coronavirus Business Continuity solution, view the Coronavirus 
Business Continuity site. 

  This site is intended to be shared with the public and is where you can share content 
intended for your customers and residents in the community. 

2. Scroll through the site and review the content. 

3. On the site header, click the Internal Destination tab. 

  The Internal Destination page is intended to be shared inside the organization and is 
where you can share content that is only intended for your employees. The page also 
includes content intended for facility managers (Manage Facility Status) or executives 
(Gain Organizational Insight) and is only visible to those users in the organization who 
are members of specific groups. 

4. Scroll through the page and review the content. 
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Coronavirus Business Reopening 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. 

Mature phase 
Nov. 2022 – Oct. 2024 

Retired phase 
Nov. 2024 

 

Introduction to Coronavirus Business Reopening 
The Coronavirus Business Reopening solution can be used during the coronavirus disease 
2019 (COVID-19) pandemic to guide the reopening of locations that are in multiple jurisdictions. 

In the United States, business reopening has been delegated to individual states, and governors 
have established guidelines that must be met before each state can start to reopen. The 
disaggregated nature of these guidelines has made it difficult for organizations with business 
locations across geographically diverse jurisdictions to make reopening decisions. A 
consolidated view of authoritative case data and relevant health restrictions simplifies the 
decision to open or close a location and allows an organization to adjust its plans as the 
pandemic evolves. Coronavirus Business Reopening is typically implemented by organizations 
that want to take a proactive data-driven approach to reopening plans and adjust business 
operations, when necessary, during the COVID-19 pandemic. 

The Coronavirus Business Reopening solution delivers a set of capabilities that help you 
continuously evaluate business locations to determine readiness, visualize the latest 
authoritative COVID-19 case data and health restrictions for surrounding communities, and 
prioritize where reopening can begin. 

 

Requirements 
Coronavirus Business Reopening requires the following: 

• ArcGIS Online 

• ArcGIS Notebooks 

• ArcGIS Survey123 Connect 

 

 

 

 

 

Information products 
Coronavirus Business Reopening includes the following information products: 
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Item Description 
Minimum 
user type 

Coronavirus 
Business Reopening 
dashboard 

An ArcGIS Dashboards app used by business executives 
to evaluate COVID-19 case data and health restrictions 
and understand the impact on business locations that are 
in many diverse jurisdictions 

Viewer 

Coronavirus Daily 
Analysis 

An ArcGIS Notebooks app that populates daily COVID-19 
case information and health restrictions from county and 
state sources 

Creator 

Facility Status 
Reporter 

An ArcGIS Web AppBuilder app used by facility managers 
to look up facilities they are responsible for and submit a 
report 

Editor 

Facility Status Report An ArcGIS Survey123 form used by a building or facility 
manager to report the staffing, facility, and operational 
status 

Editor 

FacilitySource A .csv file that can be used to load an authoritative list of 
facilities into ArcGIS 

Not 
required 

 

Release notes 
The following are the release notes: 

Version Description 

2.0 • A new version of the Facilities feature layer used in both the Coronavirus 
Business Continuity and Coronavirus Business Reopening solutions 

• Addition of the Facility Status Reporter app and Facility Status Report survey to 
maintain facility report status 

1.1 • Updated the Health Restrictions layer due to schema change. 

• Updated field lengths to 4000 to support changes in the State Health Restrictions 
layer. 

• Updated ArcGIS Notebooks to account for facilities not located in the United 
States. 

1.0 • First release of Coronavirus Business Reopening in the ArcGIS Solutions 
application 
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Configure Coronavirus Business Reopening 
In this topic, you will learn how to configure the Coronavirus Business Reopening solution to 
meet specific needs in your organization. 

 

Load data 
The Coronavirus Business Reopening solution can be used by organizations as a source of 
information while making the decision to reopen locations in multiple states. 

Facility information must be loaded and the ArcGIS Notebooks must be run before using the 
dashboard. The FacilitySource file can be used to organize facility information before loading it 
into ArcGIS. Ensure that you populate the facilityid column with unique values in the 
FacilitySource; otherwise, the application will not work effectively. 

In some cases, you may have an inventory of facilities in ArcGIS already. If you do, review the 
layers provided with the solution and determine what, if any, source data you would like to load. 
Then load your existing data into the layers provided with the ArcGIS Solution before sharing 
the maps or applications. 

Note: 

If you do have to load data into the solution, you may want to develop a source-target 
matrix to track how your source data will be loaded into the target layer or layers used in the 
solution. 

To load your facilities from a spreadsheet, complete the following steps: 

1.  Sign in to your ArcGIS organization and browse to the FacilitySource item. 

2.  Open items details page. 

3. Click Download. 

4. Edit the CSV and populate your facility information in the document. 

  Note: 

  At a minimum, you must provide a unique facilityid and the latitude and longitude for 
each facility in the FacilitySource. If you don't have a unique id, you can edit the CSV in 
Excel and copy this formula into the first row of the facilityid column: 
=CONCATENATE("Facility-", TEXT(ROW(A1),"00000")). You can then drag the right 
corner of the cell to fill the formula down for all facilities giving each a unique id. 

5.  In your ArcGIS organization, at the top of the site, click Content. 

6. On the My Content tab, type facilities in the search box. 

7. Under the Item Type, click Layers - Feature Layers. 

8. Click on the item title for the layer that you want to load data into to view its details. 

9. Click Update Data and select Append Data to Layer. 

10. Under Filename, choose your spreadsheet. 

11. Click Upload and Continue. 

12. Click Show field matching to map the fields. 
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13. If you are only appending new features to the layer, click Apply Updates. 

  Tip: 

  To make additional updates to a hosted feature layer, see Append data to layers. 

 

Extend the business reopening facilities layer 
The Coronavirus Business Reopening solution contains a layer for facilities that represents your 
organization's assets. Organizations may want to modify the facilities layer or the Facility Status 
Report surveys by first adding new fields to the feature layers and then configuring the surveys 
to use the newly created fields. When doing so, the new fields must be exposed in the 
appropriate views. Additionally, some views are created by joining two sources together, and 
these views must be re-created with the same name and URL after a new field is added. 

Organizations may want to modify the Facility Status Report survey by adding new survey 
questions. When adding new questions, begin with the Update feature layer views section 
below. For changes such as removing questions or formatting the survey, proceed to the Modify 
Facility Status Report survey section. 

 

Update feature layer views 

To add one, or more, fields to a layer and re-create the views, complete the following steps: 

1. Add a new field to a layer in the Facilities hosted feature layer. 

2. Browse to the view in your contents. 

3. Click the Open in Map View drop-down arrow and click Add to new map. 

4. Click the More Options button on the appropriate layer or table, click Set View Definition, 
and click Define Fields. 

5. Scroll to the newly created field and check the box. Click Apply.  

  The new field is added to the view’s definition. 

To update a join view, complete the following steps: 

1. Browse to the join view in your contents (for example, Facilities_current). 

2. On the item details page, scroll to the URL section. Click the Copy button. 

3. Paste the copied URL into Windows Notepad or another text editor for reference. 

  Note: 

  The feature layer name will be used below when re-creating the join. The name can be 
found after services in the URL structure and may also contain a unique GUID. For 
example, Facilities_current_a45f71a48587425c9b90ee5527cd26d1. 

4. Delete the existing join view (for example, Facilities_current). 

5. Add the source hosted feature layer to a new web map (for example, Facilities). 

6. Click Analysis > Summarize Data > Join Features. 

7. Configure the join using the following table: 
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Name of join 
Target 
layer 

Layer to join to 
the target layer 

Fields to 
match 

Join 
operation 

  Define which 
record is kept 

Facilities_Statistics Facilities US Counties 
Coronavirus 
Trends 

countyfips 
= cty_fips 

Join one 
to one 

First record 

Facilities_current Facilities FacilitiesStatus 
Report 

GlobalD = 
facilityguid 

Join one 
to one 

Order by 
created_date/Newest 

  Note: 

  Ensure that each new join view uses the names defined in this table. If you use the same 
names, the layers in the map and the existing dashboard widgets do not have to be 
reconfigured. If your join view contains a unique GUID, the new join view must be named 
with the unique GUID. 

8. If necessary, uncheck Use current map extent. Check Create results as hosted feature 
layer view. 

9. Optionally, update the Coronavirus Business Reopening dashboard to account for the new 
fields you added to the layers. 

 

Modify a Facility Status Report survey 

To modify a Facility Status Report survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Facility Status Report to download the survey. 

4. Click Facility Status Report again to open the survey. 

5. In the left pane, click Open XLSForm Spreadsheet. 

6. In the Microsoft Excel spreadsheet, click the choices tab.  

  This tab comprises all the selectable options for survey questions. 

7. Revise the survey to reflect your needs. 

8. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 

Use Coronavirus Business Reopening 
The Coronavirus Business Reopening solution delivers a set of capabilities that help you 
continuously evaluate business locations to determine readiness, visualize the latest 
authoritative COVID-19 case data and health restrictions for surrounding communities, and 
prioritize where reopening can begin. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 
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Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Update health restrictions and case information 
To help businesses understand and prioritize reopenings, decision makers rely on the latest 
state health guidelines, as well as COVID-19 case information tabulated for counties in the 
United States. The layers supplied in the Coronavirus Business Reopening solution contain 
health restriction and case information from authoritative sources, at the state and county level. 
The ArcGIS notebook included with the solution will help organizations pull the latest health 
restriction and case information from the following layers on a daily basis: 

• US Counties and Territories for COVID-19 Trends layer 

• NEMA emergency measures status 

 

Update health restriction and case information 

First, you will assume the role of a data analyst in a business. You have been asked to use the 
Coronavirus Daily Analysis notebook to update health restriction and COVID-19 case 
information. 

1. In your browser, open the Coronavirus Daily Analysis notebook. 

2. Along the menu bar, click Kernel, and then click Restart and Run All. 

  Note: 

  This step must be done daily. If this step is not run, your dashboard will be blank or out 
of date. The notebook takes up to four minutes to finish. There will be no user message 
stating that the notebook is done. The notebook has finished running when all the cell 
indicators in the notebook have switched from * to numbers. 

  The notebook clears outputs from the previous run and refreshes the US Counties 
Coronavirus Trends and State Health Restrictions layers with the latest updated 
content. 

 

 

  Note: 

  Running this notebook may consume credits if your facilities layer has locations outside 
of the US, every time the notebook is run. It is recommended that you only have facilities 
that are located in the US in the facilities layer. 
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Understand health restrictions and case information 
As the COVID-19 pandemic unfolds, some businesses are being required to rapidly close 
facilities or readjust reopening of facilities based on the latest case and health restriction 
information. Having visibility into the status of all facilities alongside the latest information 
coming out at the state and county level is a critical component in making business reopening 
decisions. Daily or periodic status reports from facilities help organizations make informed 
decisions and necessary operational changes. The Coronavirus Business Reopening 
dashboard aggregates and summarizes information from authoritative sources on the latest 
guidelines and trends. 

 

Review health restrictions and case information 

You will start by assuming the role of an operations manager. You have been asked to explore 
the latest health restriction information in the Coronavirus Business Reopening dashboard and 
view the overall impact that COVID-19 health restrictions and cases are having on business 
locations. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Business Reopening solution. 

2. View the Coronavirus Business Reopening dashboard. 

  The Coronavirus Business Reopening dashboard opens with an overview of the overall 
status of your facilities, focused on health restrictions by state. 

– The global filters across the top allow conditions to be set, which limits data 
visualization in the dashboard. 

– The facility list on the left side is interactive; when an item is selected, the map will 
zoom to the selected facility. 

– Along the bottom are a set of tabs to focus your view based on health restrictions 
and case information. 

3. On the map, select a state where the stay-at-home restrictions have been lifted. 

  A pop-up window shows the latest restrictions and guidelines. 

4. Scroll through the pop-up. 

  The pop-up includes a link to an infographic with further state-level socioeconomic and 
demographic details as well as a link to the latest state-projected peak use of hospital 
resources provided by the Institute for Health Metrics and Evaluation (IHME). 

5. At the bottom of the pop-up, click the third button.  

  On the left, the facilities list and metrics filter to reflect the selected state. 

   

  Tip: 

  You can also filter for a state's metrics by selecting a state from the State drop-down list 
at the top of the app. 

6. Below the map, click the Case Information tab.  

  This tab reveals metrics of the latest case information by counties. All metrics are filtered 
down to the state that you selected on the previous tab. 
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  The metrics displayed on the right side of the panel provide context as to the number of 
facilities that are within each trend type. Along the bottom are a set of panels that display 
the overall case and mortality rate by counties for the selected state. 

  Note: 

  If no state is selected, an overall breakdown of the United States is shown. 

  A key indicator that a county may be recovering is the number of consecutive days with 
zero new cases. Counties with zero new cases over the past 14 or more days may no 
longer have active cases and can indicate an important milestone in reopening facilities. 
The global filter along the top, Number of Days with Zero Cases, enables a number to be 
entered representing the number of consecutive zero case days. Entering a value filters the 
counties and the facilities within those counties that meet or exceed the value. 

  Below the map, the Count of Counties with Zero New Cases chart provides context into 
the number of counties that have maintained zero cases over a period of time. Hovering 
over each dot in the chart displays the total number of counties that have consistently 
maintained zero cases for the given number of days. Furthermore, the chart provides 
additional fine-tuning capabilities by interactively selecting a range that refines your view to 
focus on counties that are within a given threshold range. 

7. In the map, select a county. 

  A pop-up shows the latest case information. 

8. Scroll through the pop-up. 

  The pop-up includes a link to an infographic with further county level socioeconomic and 
demographic details. 

9. At the bottom of the pop-up, click the third button.  

  Clicking this button selects the county and filters all metrics to that county. 

  The facilities list and metrics on the left and the panels below the map filter to reflect the 
selection. 

 

Locate counties with zero new cases 
To help businesses understand and prioritize reopenings, decision makers rely on the latest 
state health guidelines, as well as COVID-19 case information tabulated for counties in the 
United States. This workflow will show you how to identify the counties, in a given state, that 
have had zero case days for a given period of time. 

 

Filter counties with zero new cases 

You will start by assuming the role of an operations manager in a business. You have been 
asked to use the Coronavirus Business Reopening dashboard to find business locations in 
counties that have had zero new COVID-19 cases over a period of time. 

1. In the dashboard, click the Case Information tab to access county-level information. 

2. At the top of the dashboard, click the State drop-down menu and choose a state. 
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  The information at the bottom of the dashboard now reflects the counties for the selected 
state. 

3. At the top right of the dashboard, for Number of Days with Zero Cases, type the number 
of zero case days desired. 

  The dashboard updates to show counties with your specified number of zero case days. 

  Tip: 

  You can further filter this selection by selecting the days desired to view in the map. 

 

Locate zero new cases using the case chart 

Now, you will use the case graph to find business locations in counties that have had zero new 
cases over a period of time. 

1. At the bottom of the dashboard, click the Case Information tab to access county-level 
information. 

2. At the top of the dashboard, select a state from the State drop-down menu. 

  The information at the bottom of the dashboard now reflects the counties for the selected 
state. 

3. Select the number of zero case days desired. 

  The facilities list and metrics at the left and the panels below the map filter to reflect the 
selection. 

   

Track facility status 
As the COVID-19 pandemic develops, some organizations are being required to rapidly close 
facilities. Having visibility into the status of all facilities is a critical component in making 
business reopening decisions. Daily or periodic status reports from facilities help organizations 
make informed decisions and necessary operational changes. 

The Coronavirus Business Reopening solution includes a Facility Status Report form for facility 
managers to report the status of the facilities they are responsible for. Organizations deploying 
Coronavirus Business Reopening should review the preconfigured questions and adjust as 
necessary to remain in compliance with organizational policies and applicable laws. 

 

Complete a facility status report 

You will start by assuming the role of a local facility manager in a government agency, business, 
or utility. You were asked to use the Facility Status Reporter app and Facility Status Report form 
to share the status of your facility each day or on a weekly basis. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Business Reopening solution. 

2. View the Facility Status Reporter app. 

3. On the right, in the Locate facility widget, search for the name of a facility. 

4. In the results, select the facility, and then review the facility details. 
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5. Click Submit Facility Report. 

6. Complete the Facility Status Report with as much information as possible. 

7. Click Submit. 
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Coronavirus Force Readiness 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. 

Mature phase 
Nov. 2022 – Oct. 2024 

Retired phase 
Nov. 2024 

 

Introduction to Coronavirus Force Readiness 
Coronavirus Force Readiness can be used to understand force availability and share 
authoritative information with decision makers during the Coronavirus Disease 2019 (COVID-
19) pandemic. 

The solution provides units with information regarding which personnel can report for duty and 
an understanding of their capacity to respond to a request for assistance during the COVID-19 
pandemic. Units may be requested to assist in setting up alternate care facilities, detection 
testing sites, supporting food distribution, and so on. Having personnel perform a routine check-
in or having someone from the armory or unit provide the readiness status of a group of 
personnel gives units clarity into a unit’s readiness during the pandemic. Coronavirus Force 
Readiness is typically implemented by the National Guard, Air National Guard, and other 
service branches that want to take a data-driven approach to understanding force availability 
during COVID-19. 

The Coronavirus Force Readiness solution delivers a set of capabilities that help you to 
understand the operational capacity of a force, monitor the status of units, and communicate 
capabilities and disruptions to commanders and administrative staffs during the COVID-19 
pandemic. 

 

Requirements 
Coronavirus Force Readiness requires the following: 

• ArcGIS Online 

• ArcGIS Survey123 
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Information products 
Coronavirus Force Readiness includes the following information products: 

Item Description 
Minimum 
user type 

Admin Dashboard An ArcGIS Dashboards app used by administrative 
NCOs to monitor personnel availability. 

Viewer 

Personnel Readiness 
Dashboard 

An ArcGIS Dashboards app used by any unit member 
to track and monitor personnel readiness and 
availability. 

Viewer 

Commander's 
Dashboard 

An ArcGIS Dashboards used by commanders to 
quickly assess the overall unit readiness. 

Viewer 

Personnel Readiness 
Report 

An ArcGIS Survey123 form used by a military unit 
member to report availability. 

Not required 

Personnel Readiness 
Batch Report 

An ArcGIS Survey123 form used by an NCO or armory 
clerk to report the availability of their personnel. 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 First release of Coronavirus Force Readiness 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


 

Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal Page 48 

Configure Coronavirus Force Readiness 
In this topic, you will learn how to configure the Coronavirus Force Readiness solution to meet 
specific needs in your organization. 

 

Extend force readiness surveys 
The Coronavirus Force Readiness solution includes a series of surveys that can be used to 
understand the capacity of your workforce. 

Review the preconfigured questions and adjust as necessary to remain in compliance with your 
organizational policies and any applicable laws. Additionally, ensure that you secure the survey 
and underlying layers and only share the content with appropriate members of your 
organization. 

 

Update feature layer views 

The Coronavirus Force Readiness solution includes a series of views created from the 
Personnel Readiness feature layer. The feature layer is used in the surveys and the subsequent 
views are used in the dashboards. Organizations may modify the Personnel Readiness Report 
survey and ultimately add new fields to the feature layers. When doing so, the new fields must 
be exposed in the appropriate views. 

To add one or more fields to a layer and re-create the views, complete the following steps: 

1. Browse to the view in your contents. 

2. Click the Visualization tab. 

3. Click the Options button  on the appropriate layer or table, then click Set View 
Definition. 

4. Click Define Fields. 

5. Scroll to the newly created field and check the box. Click Apply. 

  The new field is added to the view's definition. 

6. Repeat steps 1 through 5 for the Personnel Readiness Dashboard. 

7. Update the Personnel Readiness Dashboard to account for the new fields you added to the 
layers. 

 

Modify readiness surveys 

To modify a Coronavirus Force Readiness survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization.  

3. Click Personnel Readiness Report to download the survey.  

4. Click the Personnel Readiness Report again to open the survey. 

5. In the left pane, click Open XLSForm Spreadsheet. 

6. In the Microsoft Excel spreadsheet, click the Choices tab. This tab comprises all of the 
selectable options for survey questions. 

7. Revise the survey to reflect your personnel readiness needs. 
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8. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 

 

Configure echelons 
The dashboards are preconfigured to display four battalions and four companies under each 
battalion. Follow the steps below to add or remove battalions or companies from your 
dashboard. 

 

Add a battalion 

To add battalions or companies to the dashboard, complete the following steps: 

1. Sign in to your ArcGIS Online organization. 

2. Browse to the Personnel Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Select the last battalion tab while in edit mode. 

5. Go to the editing tool within this element and select Duplicate. 

6. Drag the newly created copy and position it below the last battalion tab. 

7. Reference duplicated battalion settings, text, and configuration. 

8. Add a new name, for example, 5th BN, to the new component. 

9. Save your application. 

 

Remove a battalion tab 

To remove a battalion or companies from the dashboard, complete the following steps: 

1. Sign in to your ArcGIS Online organization. 

2. Browse to the Personnel Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Select the battalion tab you want to delete while in edit mode. 

5. Click the Delete button  to delete the selected battalion. 

6. Save your application. 

 

Configure alternate reporting periods 

The dashboards are preconfigured to display individuals reporting within the last 24 hours. The 
dashboard owner can configure the dashboard to display alternate reporting periods. The 
Personnel List is the most commonly configured element in regard to its contents and time 
frame. 

To modify the reporting period, complete the following steps: 

1. Sign in to your ArcGIS Online organization. 

2. Browse to the Personnel Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Go to the editing tool within the Personnel List  element and select Configure. 
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5. Below Battalion, select the And option and add Date Reported from the drop-down list. 
You can now select from any of the available options and time frames.  

6. Click Done and save your application displaying the new reporting period. 

 

Add readiness tabs for new battalions and companies 

The dashboards are preconfigured to display four battalions and four companies and their 
applicable total force/unit size. This tab also contains the availability based on survey 
submissions and percentage of readiness. 

To add percentages of readiness to the dashboard, complete the following steps: 

1. Sign in to your ArcGIS Online organization. 

2. Browse to the Personnel Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Select the 3rd Battalion tab while in edit mode 

5. Go to the editing tool within the Personnel List  element and select Duplicate. 

6. Drag the newly created copy and position it below the 3rd Battalion tab. Reference the 3rd 
Battalion settings, text, and configuration. 

7. Add a new name, such as 5th BN, to the new component and save your application. 

8. Go to the Reference section within the configuration tool and add the unit size below Fixed 
Value. 

  This number will provide the available value and percentage of readiness. 

9. Follow the previous step and enter your current Total Force for each unit level. 

10. If you need to remove a battalion tab, click the Delete button . 

11. Save your application. 
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Use Coronavirus Force Readiness 
The Coronavirus Force Readiness solution delivers a set of capabilities that help you to 
understand the operational capacity of a force, monitor the status of units, and communicate 
capabilities and disruptions to commanders and administrative staffs during the COVID-19 
pandemic. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Monitor force readiness 
The Coronavirus Force Readiness solution includes a Personnel Readiness Report survey that 
collects information from personnel, including their duty type, location, MOS (military 
occupational specialty), unit they belong to, and wellness information. Units deploying 
Coronavirus Force Readiness should review the preconfigured questions and adjust as 
necessary to remain in compliance with policies and applicable laws of your state or unit. In 
addition, ensure that you secure the survey and underlying layers and only share the content 
with appropriate members of your unit. 

Some organizations may find it more efficient to have an individual, such as someone from the 
armory, check their unit member in using the Personnel Readiness Batch Report survey. If a 
unit decides to use the batch survey, follow the same general steps below with the Personnel 
Readiness Batch Report survey and the Personnel Readiness Dashboard. 

 

Complete individual readiness report 

You will start by assuming the role of a military unit member. You are asked to use the 
Personnel Readiness Report survey to share your availability status each morning. 

1. In a browser, go to your Personnel Readiness Report survey. 

2. In the Personnel Readiness Report survey, fill in the following details: 

  Parameter 
  Value 

  State   Select California. 

  Battalion   Select 1st Battalion. 

  Company   Select A Company. 

  Rank   Select E-4/CPL. 

  MOS   Type 12W. 

  Select Duty Type   Select State Active Duty. 
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  First Name   Type your first name. 

  Last Name   Type your last name. 

  Commander   Type your commander's name. 

  Provide Location   Select your location on the map or provide your 
address. 

  Can you report for duty?   Select No. 

  Is it health related?   Select Yes. 

  Is it your health or someone 
else's? 

  Select Self. 

  Is it COVID-19 related?   Select Yes. 

  Select your status   Select Quarantined. 

  Select date quarantine started   Select a date within 14 days of today. 

  Check completed by:   Select Self. 

3. Click Submit. 

 

Monitor personnel readiness 

Now, you will assume the role of the Readiness NCO in the same unit. You are asked to 
monitor the readiness of your unit and are looking to see whether your unit is available to be 
assigned to a mission. You will view the overall readiness of your workforce. 

Note: 

The steps below are the same if you are an administrative NCO and will be using the Admin 
Dashboard to monitor the readiness of your team. The Admin Dashboard will contain 
personal information about the individual unit members. 

1. In a browser, go to the Personnel Readiness Dashboard app. 

2. The Personnel Readiness Dashboard opens with an overview of the overall readiness of 
the brigade and each battalion in the brigade. 

  The overview displays key metrics. This information gives leadership a quick overview of 
the number of unit members available. Statistics related to the availability of your unit are 
also shown. 
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3. In the filter at the top of the dashboard, click Last 24 Hrs to see a complete list of the 
submissions from the last 24 hours. 

4. Filter by Time frame, MOS by Battalion, and MOS by Company. Review the list of 
personnel and their locations in the map. 

5. Click each of the Battalion tabs to see the availability for each company in that battalion. 

6. Adjust the slider in the Quarantined (Start Date) - Last 14 Days chart to adjust the time 
period you want to review. 

In the lower left corner of the dashboard, you can review the COVID-19 Status submitted by 
individual unit members. 
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Coronavirus Health Screening 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. 

Mature phase 
Nov. 2022 – Oct. 2024 

Retired phase 
Nov. 2024 

 

Introduction to Coronavirus Health Screening 
Coronavirus Health Screening can be used to conduct coronavirus disease 2019 (COVID-19) 
health screenings before employees and visitors are permitted to enter a building, facility, or 
location. 

As employees return to work and locations reopen to the public, organizations are taking steps 
to protect the health and safety of all individuals in their facilities. As a result, many 
organizations are asking employees and visitors to attest each day that they are symptom free 
and have not had recent contact with anyone who has tested positive for COVID-19. Many are 
also requiring a temperature check before they are permitted to enter the building. Coronavirus 
Health Screening is typically implemented by organizations that want to conduct health 
screenings on all employees and visitors entering their facilities. 

The Coronavirus Health Screening solution delivers a set of capabilities that help you screen 
employees and visitors by requiring that they self-report symptoms or contact, record the result 
of a temperature check, and track who was permitted to enter a facility or location on a given 
date. 

 

Requirements 
Coronavirus Health Screening requires the following: 

• ArcGIS Online 

 

Information products 
Coronavirus Health Screening includes the following information products: 

Item Description 
Minimum 
user type 

Employee Health 
Screening 

An ArcGIS Survey123 form used by employees or contract 
personnel to self-report coronavirus symptoms or contact 
before entering a facility or location 

Editor 

Visitor Health 
Screening 

An ArcGIS Survey123 form used by visitors to self-report 
coronavirus symptoms or contact before entering a facility or 
location 

Not 
required 
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Temperature 
Check 

An ArcGIS Survey123 form used by health screeners to 
record temperature checks of employees and visitors before 
entering a facility or location 

Editor 

Health Screening 
Dashboard 

An ArcGIS Dashboards app used by health screeners and 
human resources executives to monitor health screenings and 
determine who was permitted to enter a facility or location on 
a given date 

Viewer 

  

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Coronavirus Health Screening 
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Configure Coronavirus Health Screening 
In this topic, you will learn how to configure the Coronavirus Health Screening solution to meet 
specific needs in your organization. 

 

Load screening locations 
Screening locations must be loaded into the HealthScreenings feature layer before using the 
Health Screening Dashboard. The ScreeningLocationsSource.csv file included with the solution 
can be used to organize your screening locations before loading into ArcGIS. 

To load your screening locations from the ScreeningLocationsSource.csv file, complete the 
steps below: 

1. Sign in to your ArcGIS organization and browse to the ScreeningLocationsSource item. 

2. Open the item page and click Download. 

3.  Browse to and open the ScreeningLocationsSource.csv file. 

  There are two fields in the .csv file, location and capacity, that match the Locations table in 
the HealthScreenings feature layer. 

4. Edit the .csv file and provide your list of screening locations and their capacity. 

5. In your ArcGIS organization, browse to the HealthScreenings feature layer. 

6. Open the item page and click Update Data > Append Data to Layer. 

7. Click Choose File and browse to your ScreeningLocationsSource.csv file, and click Open. 

8. Click Upload and Continue. 

9. Click the Choose the layer that you wish to append data into drop-down arrow and 
choose Locations. 

10. Uncheck Update existing features. 

11. Click Show field matching to map the fields. 

  Note: 

  If the capacity field isn't available as a Match Field option, check the .csv file to make 
sure the values in the capacity field are all numbers. 

12. Click Apply Updates. 

 

Update location choice list 

The Employee Health Screening and Visitor Health Screening surveys provide a default list of 
options for the Campus, Building, or Place Name question. You will update this choice list to 
reflect the locations you loaded into the HealthScreenings feature layer in the previous steps. 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Employee Health Screening to download the survey. 
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  Note: 

  The Employee Health Screening survey is an example. The steps below are the same 
for the Visitor Health Screening survey. 

4. In the Download window, click Download and click OK. 

5. Click Employee Health Screening again to open the survey. 

6. On the side toolbar, click the Open XLSForm Spreadsheet button. 

7. In the Microsoft Excel spreadsheet, click the choices tab. The location list defines the 
choices for the Campus, Building, or Place Name question. 

8. Update the list to reflect the locations you loaded in the previous steps. 

9. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

10. In Survey123 Connect, click Publish on the side toolbar. 

11. Click Publish survey to publish your changes and click OK. 

 

Extend health screening surveys 
The Coronavirus Health Screening solution includes a series of surveys (Employee Health 
Screening, Visitor Health Screening, Temperature Check) that can be used by an employee, 
contractor, or visitor to self-report coronavirus symptoms or contact before entering a facility or 
location. 

Review the preconfigured questions and adjust as necessary to remain in compliance with your 
organizational policies and any applicable laws. The screening surveys do not record any of the 
responses to the health-related questions and are only used to determine the result of the 
screening. 

 

Add additional fields 

The health screening surveys leverage a series of views created from the HealthScreenings 
feature layer. Organizations may want to modify the Employee Health Screening, Visitor Health 
Screening, and Temperature Check surveys by first adding new fields to the feature layers and 
then configuring the surveys to use the newly created fields. When doing so, the new fields 
must be exposed in the appropriate views. 

When adding new questions, consider if you need to store the answer when the survey is 
submitted. For example, the health question responses are not stored with the feature layer and 
don't require a field. 

To add one or more fields to a layer and update the views, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization. 

2. Add a new field to a layer in the HealthScreenings hosted feature layer. 

3. Browse to the view. 

4. Open the item page and click the Visualization tab. 

5. Click More Options on the appropriate layer or table, click Set View Definition > Define 
Fields. 

6. Scroll to the newly created field and check the box next to the new field or fields. 
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7. Click Apply. 

  The new field is added to the view’s definition. 

   

Modify health screening surveys 

To modify a Coronavirus Health Screening survey, complete the following steps: 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Employee Health Screening to open the survey. 

  Note: 

  The Employee Health Screening survey is an example. The steps below are the same 
for the Visitor Health Screening and Temperature Check surveys. 

3.  On the side toolbar, click the Open XLSForm Spreadsheet button. 

4. Revise the survey to reflect your health screening needs. 

5. Save and close the Microsoft Excel spreadsheet and preview your changes in Survey123 
Connect. 

6. In Survey123 Connect, click Publish on the side toolbar. 

7. Click Publish survey to publish your changes and click OK. 

 

Self-report temperature 
Health screenings typically involve a temperature check before an individual is permitted to 
enter a facility. By default, the Coronavirus Health Screening solution assumes a health 
screener will perform the temperature check, record the result, and admit or turn away the 
individual based on the result. Some organizations may choose to have employees or visitors 
perform their own temperature checks and record the result using the original health screening 
survey. This eliminates the need for a health screener to perform a temperature check before 
entering the facility. 

To enable employees or visitors to report their temperature in the health screening survey, 
complete the following steps: 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Employee Health Screening to open the survey. 

  Note: 

  The steps below can also be used to modify the Visitor Health Screening survey. 

3.  On the side toolbar, click the Open XLSForm Spreadsheet button. 

4. In the Microsoft Excel spreadsheet, find the ask_temperature question in the third row, 
column B (name). 

5. Scroll to the right to column J (default) and change the text from No to Yes for this row. 

6. Save and close the Microsoft Excel spreadsheet and preview your changes in Survey123 
Connect. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


 

Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal Page 59 

  Note: 

  After you answer no to the three COVID-19 symptom and contact questions, a new 
question asking for your temperature is now required. 

7. In Survey123 Connect, click Publish on the side toolbar. 

8. Click Publish survey to publish your changes and click OK. 

 

Remove the temperature check list from the dashboard 

When the health screening survey is configured to ask the employee or visitor for their 
temperature, the temperature check list in the screening dashboard no longer applies and can 
be removed. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Health 
Screening Dashboard. 

2. Open the item page and click Edit Dashboard. 

3. Hover over the upper left corner of the Temperature Check element and click Delete. 

4. In the Delete Element window, click Delete. 

5. Click Save to save the dashboard. 
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Use Coronavirus Health Screening 
The Coronavirus Health Screening solution delivers a set of capabilities that help you screen 
employees and visitors by requiring that they self-report symptoms or contact, record the result 
of a temperature check, and track who was permitted to enter a facility or location on a given 
date. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Self-report symptoms or contact 
You will start by assuming the role of an employee in a government agency, business, or utility. 
Each day before entering a facility, you are asked to attest that you are symptom free and have 
not had recent contact with anyone who has tested positive for COVID-19. 

1. In a browser, from the Coronavirus Health Screening solution, view the Employee Health 
Screening form. 

2. Complete the form with as much information as possible. 

  Note: 

  Required questions are marked with a red asterisk. 

  If you are signed in, the form automatically fills in your name and email address from your 
user profile. If you select Yes to any of the health-related questions, a message displays at 
the bottom of the form indicating that you are at risk for COVID-19 and are not permitted to 
enter the building, and no other questions display. 

3. Click Submit. 

 

Perform a temperature check 
Now, you will assume the role of a health screener in the same government agency, business, 
or utility. You have been asked to perform a temperature check of employees or visitors before 
they will be permitted to enter the facility. 

Note: 

If an organization chooses to ask employees and visitors to self-report their temperature, 
these steps do not apply. Follow these steps to expose a temperature check question in the 
health screening surveys. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Health Screening solution. 
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2. View the Health Screening Dashboard app. 

  The Health Screening Dashboard app opens to a list of employees and visitors who require 
a temperature check. The list is populated with the names of employees and visitors who 
have submitted the Employee Health Screening form. 

3. Locate an individual in the list, and then click the thermometer button to the right of the 
individual's name. 

  The Temperature Check form opens in a new tab. 

4. Confirm that the value for Full Name matches the individual that you selected. 

5. Type the temperature. 

  Note: 

  A temperature below 100.4 is not considered a fever and results in a message that 
states that the individual is permitted to enter the building. A temperature of 100.4 or 
higher returns a message that states that the person is not permitted to enter. 

6. Click Submit. 

7. Close the Temperature Check form and return to the Health Screening Dashboard app. 

 

Monitor health screenings 
You will continue your role as a health screener in the government agency, business, or utility. 
You have been asked to admit only employees or visitors who have passed the health 
screening into the building and to instruct those that have not passed the screening to return 
home. You have also been asked to monitor building occupancy to ensure that it doesn't exceed 
the maximum capacity. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Health Screening solution. 

2. View the Health Screening Dashboard app. 

  The Health Screening Dashboard app has three tabs: Temperature Check, Admit, and 
Rejected. At the bottom of the dashboard, an indicator shows the building's current 
occupancy rate. 

  Note: 

  If an organization chooses to ask employees and visitors to self-report their temperature, 
the Temperature Check list does not apply. 

3. On the left side of the app, click the arrow to display the filter panel. 

  Tip: 

  You can pin the filter panel to the dashboard by clicking the pin in the upper-right corner. 

4. For Location, select a building. 

  The Occupancy indicator updates to show the building's maximum capacity and the 
number of employees and visitors who have been admitted to that building. 
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  When additional individuals pass the health screening, the occupancy percentage updates. 
When occupancy reaches 100 percent, the value displays in red. 

5. Adjust additional filters to further refine the results. 

6. On the dashboard, click the Admit tab and review the list of individuals who have passed 
the screening and are permitted to enter the building. 

7. Click the Rejected tab and review the list of individuals who did not pass the screening and 
are not permitted to enter the building. 

 

Export a list of admitted employees and visitors 
You will assume the role of a human resources executive. An employee has tested positive for 
COVID-19 and was recently in one of your buildings. You need to export a list of every 
employee and visitor who was admitted to the facility on the same day and follow up with the 
health department. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Health Screening solution. 

2. Open the Employee Health Screening form item page. 

3. Click Open in Survey123 and choose Manage in Survey123 website. 

4. At the top right, click the Data tab. 

5. On the left, click Filter. 

6. Set the first expression to result is admit. 

7. Click Add expression. 

8. Set the second expression to EditDate is on and specify the date. 

9. Click Apply. 

10. Click Export and choose your output format. 

  After you select the format, the file downloads. 
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Coronavirus Recovery Dashboard 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. 

Mature phase 
Nov. 2022 – Oct. 2024 

Retired phase 
Nov. 2024 

 

Introduction to Coronavirus Recovery 
Dashboard 
Coronavirus Recovery Dashboard can be used to tabulate and monitor key recovery metrics 
and trends that support phased coronavirus disease 2019 (COVID-19) recovery efforts. 

As communities begin to reopen, balancing public health metrics with economic growth is 
essential and understanding how these metrics vary from one geography to another helps 
decision makers develop strategic reopening plans. Coronavirus Recovery Dashboard is 
typically implemented by government organizations that want to visualize key recovery metrics 
over time to help inform health restrictions, social distancing decisions and recommendations 
made to open certain sectors of the economy. 

The Coronavirus Recovery Dashboard solution delivers a set of capabilities that help you 
tabulate recovery and reopening metrics, monitor key trends and performance targets for 
defined geographies, and communicate progress to interested stakeholders. 

 

Requirements 
Coronavirus Recovery Dashboard requires the following: 

• ArcGIS Online 

• ArcGIS Pro 2.5 or later (Basic, Standard, or Advanced) 

 

Information products 
Coronavirus Recovery Dashboard includes the following information products: 

Item Description 
Minimum user 
type 

Coronavirus 
Recovery 
Dashboard 

An ArcGIS Dashboards app used by health and human 
services staff to monitor symptoms, cases, and hospital 
capacity metrics and trends to support phased recovery 
efforts 

Viewer 
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Coronavirus 
Recovery Mobile 
Dashboard 

An ArcGIS Dashboards app optimized for mobile 
devices, used by health and human services staff to 
monitor symptoms, cases, and hospital capacity metrics 
and trends to support phased recovery efforts 

Viewer 

Coronavirus 
Recovery Data 
Management 

An ArcGIS Pro project used by health and human 
services staff to tabulate key recovery metrics and 
calculate symptoms and case trends 

GIS 
Professional 
Basic 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new Coronavirus Recovery Dashboard and Coronavirus Recovery Mobile 
Dashboard that resolves an issue where the location selector fails to load in the 
new ArcGIS Dashboards app. 

1.0 • First release of Coronavirus Recovery Dashboard 
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Configure Coronavirus Recovery Dashboard 
In this topic, you will learn how to configure the Coronavirus Recovery Dashboard solution to 
meet specific needs in your organization. 

 

Configure recovery dashboard 
The Coronavirus Recovery Dashboard includes a series of key recovery indicators defined by 
the United States Centers for Disease Control and Prevention (CDC) and specific metrics 
identified by the United States National Governors Association (NGA). The indicators and 
metrics are tabulated for a specific reporting area. The reporting areas can be a country, state 
or province, region, county, zip code, municipality, or any other geographic area you are using 
to tabulate results. 

To configure the dashboard for new metrics and trends you want to monitor, complete the steps 
below: 

1. Sign in to your ArcGIS organization and browse to the Coronavirus Recovery Dashboard 
item. 

  Note: 

  The steps below are the same for the Coronavirus Recovery Mobile Dashboard item. 

2. Open the item page and click Edit Dashboard. 

3. Hover over the upper left corner of a element and click Duplicate. 

4. Hover over the upper left corner of the duplicated element and click Configure. 

5. Click the Data tab. 

6. For an indicator element, change the Value setting to the new metric field. For a serial 
chart element, change Series 1 to the new value field and change Series 2 to the new 
value trend field. 

7. Click the General tab. 

8. Change the name of the element. 

9. Modify the Title setting by clicking Edit and updating the title for the metric. 

10. Click Done. 

11. Hover over the  Coronavirus Recovery Dashboard in the upper right corner of the 
dashboard and click Configure. 

12. Click the Actions tab. 

13. For Filter, click Add Target and select the element you added. 

14. Scroll to the bottom, and for the new element, select Name for both Source and Target. 

15. Click Done. 

16. Click Save to save the dashboard. 

 

Set metric targets 
The Coronavirus Recovery Dashboard has target goals of 90 percent for testing and health care 
metrics. The target percentage is provided as an example of how you can set a target and 
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indicate whether you are meeting the target. You will want to configure these targets to meet 
your community's goals. 

To set the target for a testing or health care metric, complete the steps below: 

1. Sign in to your ArcGIS organization and browse to the Coronavirus Recovery Dashboard 
item. 

  Note: 

  The steps below are the same for the Coronavirus Recovery Mobile Dashboard item. 

2. On the dashboard item page, click Edit Dashboard. 

3. Hover over the upper left corner of the indicator element and click Configure. 

4. Click the Data tab. 

5. Change the Reference value to the desired target. 

  In some cases, you may not have a target associated with a metric and only want to 
indicate that the value is being measured. If so, you can disable the Conditional 
Formatting option. If you want to keep the target and don't want to disable this option, skip 
to step 10. 

6. Click the General tab. 

7. Click Edit to modify the Description setting. 

8. Click Source and copy the following HTML snippet into the editor: 

   
<table style="background-color:#2695bc; color:#ffffff; font-size:16px; padding:2px; text-
align:center; width:100%">  
    <tbody>  
        <tr>  
            <td>  
                <p>Measured</p> 
            </td>  
        </tr>  
    </tbody>  
</table> 

9. Click Source. 

10. Click Done. 

11. Click Save to save the dashboard. 
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Use Coronavirus Recovery Dashboard 
The Coronavirus Recovery Dashboard solution delivers a set of capabilities that help you 
tabulate recovery and reopening metrics, monitor key trends and performance targets for 
defined geographies, and communicate progress to interested stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Tabulate recovery metrics 
Past case and symptom information can be used to calculate 14-day trends to indicate if the 
community is seeing a downward or upward trend. New metric information can be added as 
frequently as you receive updates, and trend lines can be recalculated with the latest 
information to give an accurate picture of the current state in the community. 

You will start by assuming the role of an epidemiologist. You are asked to use the Coronavirus 
Recovery Data Management project to tabulate coronavirus disease 2019 (COVID-19) cases 
each morning. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Recovery Dashboard solution. 

2. Download the Coronavirus Recovery Data Management project, and then unzip the folder. 

3.  From the unzipped folder, open the Coronavirus Recovery Data Management project in 
ArcGIS Pro. 

4. In the Catalog pane, expand the Tasks folder, and then double-click the Coronavirus 
Recovery Data Management task. 

  Note: 

  If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Task Pane, expand the How to Use Coronavirus Recovery Data Management 
task group to see the collection of tasks. 

6. Open each task and follow the steps provided. 

 

Monitor coronavirus recovery 
Now you will assume the role of a public health officer or executive in the same government 
agency. You have been asked to monitor case and symptom trends over the last 14 days and 
verify that testing and health care facilities are meeting specific requirements. 

Before beginning a phased reopening, you want to confirm that there is a downward trend in the 
number of new positive cases and individuals experiencing flu-like and COVID-19 symptoms. 
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You also want to ensure a minimum percentage of testing sites and health care facilities are 
meeting minimum requirements defined by the community. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Recovery Dashboard solution. 

2. View the Coronavirus Recovery Dashboard app. 

  The Coronavirus Recovery Dashboard solution opens with trend information for cases and 
symptoms and metrics for testing and health care facilities. 

3. Observe whether the number of cases and symptoms has increased or decreased over the 
last 14 days. 

4. View the testing and health care metrics and validate that each is meeting the specified 
target. 

5. At the top right, from the drop-down list, choose another reporting area to view the metrics 
and trends for that area. 
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Coronavirus Response 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. 

Mature phase 
Jul. 2023 – Jun. 2025 

Retired phase 
Jul. 2025 

 

Introduction to Coronavirus Response 
Coronavirus Response can be used to understand the impact of the coronavirus disease 2019 
(COVID-19) pandemic and share authoritative information about the pandemic with the 
community. 

As the COVID-19 pandemic has spread, health and human services agencies are tabulating 
case and testing results to better understand the impact on the community. To prevent further 
spread, health orders have been issued that severely impact services delivered at many public 
gathering places (for example, schools, government buildings, hospitals, restaurants, 
businesses, and common places). As a result, many have closed or altered their hours and laid 
off employees. Community meal programs have responded by increasing capacity, switching to 
take out meals, limiting facility access and enforcing social distancing during pickups. 
Coronavirus Response is typically implemented by government agencies that want educate the 
public on the current case information and the pandemic's impact on public gathering places 
and meal programs. 

The Coronavirus Response solution delivers a set of capabilities that help you monitor COVID-
19 cases and response activities, communicate the impact on public places (for example, 
schools, government buildings, and common places), inventory meal sites, monitor meal 
programs, and share information with the public. 

 

Requirements 
Coronavirus Response requires the following: 

• ArcGIS Online 

• ArcGIS Survey123 Connect 

 

Information products 
Coronavirus Response includes the following information products: 

Item Description 
Minimum 
user type 

Community Impact 
Dashboard 

An ArcGIS Dashboards app used by health and human 
services staff to monitor key coronavirus response metrics 
and share this information with the public 

Viewer 
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Community Impact 
Mobile Dashboard 

An ArcGIS Dashboards app, optimized for mobile devices, 
used by health and human services staff to monitor key 
coronavirus response metrics and share this information with 
the public 

Viewer 

Coronavirus Case 
Dashboard 

An ArcGIS Dashboards app used by health and human 
services staff to visualize coronavirus cases in their 
community 

Viewer 

Coronavirus Case 
Mobile Dashboard 

An ArcGIS Dashboards app, optimized for mobile devices, 
used by health and human services staff to visualize 
coronavirus cases in their community 

Viewer 

Case Reporter An ArcGIS Survey123 form used by health and human 
services staff to tabulate coronavirus cases in their 
community 

Editor 

Public Place 
Manager 

A Crowdsource Manager app used by health and human 
services or emergency response staff to manage the status 
of public gathering places (for example, schools, and 
common places) 

Editor 

School Closings An ArcGIS Web AppBuilder app used by the public to obtain 
school closing information 

Not 
required 

Medical Facilities 
Locator 

An ArcGIS Web AppBuilder app used by the public to locate 
the nearest hospital or healthcare clinic 

Not 
required 

Community 
Closings 

An ArcGIS Web AppBuilder app used by the public to obtain 
information about gathering places (for example, 
government buildings and public places) in the community 

Not 
required 

Meal Sites 
Manager 

A Crowdsource Manager app used by school district or 
emergency response staff to inventory meal pickup locations 

Editor 

Meal Site Report An ArcGIS Survey123 form used by school district staff or 
volunteers to tabulate meals served at a site 

Editor 

Meal Sites Locator An ArcGIS Web AppBuilder app used by the public to locate 
the nearest meal site pickup location 

Not 
required 

Meal Sites 
Dashboard 

An ArcGIS Dashboards app used by school district or 
emergency response staff to monitor meal programs 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Coronavirus Response 
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Configure Coronavirus Response 
Learn how to configure the Coronavirus Response solution to meet specific needs in your 
organization. 

 

Load public places and meal sites 
Coronavirus Response can be used by public health agencies and other emergency response 
agencies to show the impact on public gathering places and inventory meal sites. In some 
cases, you may have this information in ArcGIS or a spreadsheet already. 

Review the layers provided with the solution and determine what, if any, source data you want 
to load. Then load your existing data into the layers provided with the solution before sharing the 
maps or applications. 

Once you have determined what source data must be loaded, complete one or more of the 
data-loading workflows below. 

 

Load data from a spreadsheet 

If you do not have an inventory of public gathering places in ArcGIS, you may have them in a 
spreadsheet. If you don’t have a spreadsheet already, you can use the sample .csv file included 
with the solution (FacilitySource.csv) to inventory the public gathering places, hospitals, 
educational facilities, and meal sites. Many times, you can use alternate data sources to start 
your inventory. For example, you can use the Homeland Infrastructure Foundation – Level Data 
(HIFLD) infrastructure data for all 50 U.S. states; Washington, D.C.; and the U.S. territories of 
Puerto Rico, Guam, American Samoa, Northern Mariana Islands, Palau, and Virgin Islands. 

Tip: 

If you decide to use the HIFLD data, download the data for your community and review the 
currency of this information. You may want to augment your facility list by adding additional 
facilities (for example, temporary facilities) to your spreadsheet. 

To load your public gathering places or meal sites from a spreadsheet, complete the steps 
below: 

1. Sign in to your ArcGIS organization and browse to the FacilitySources item. 

2. Open the item page and click Download. 

3. Edit the .csv file and provide your facilities information. 

4. In your ArcGIS organization, browse to the PublicPlaces, Hospitals, EducationalFacilities, 
or MealSites feature layer. 

5. Open the item page and click Update Data > Append Data to Layer. 

6. Click Choose File and browse to your .csv file, and click Open. 

7. Click Upload and Continue. 

8. Click the Choose the layer to update drop-down arrow and choose the layer to load into. 

9. Uncheck Update existing features. 

10. Click Show field matching to map the fields. 

11. Map the Latitude field to the y match field and the Longitude field to the x match field. 
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12. Click Apply Updates. 

 

Load data from a shapefile or file geodatabase 

If you already have your public gathering places or meal sites in ArcGIS, you can load them 
from a shapefile or file geodatabase by following the steps below: 

1. Create a .zip file of a shapefile or file geodatabase of your facilities. 

2. Verify that you are signed in to your ArcGIS organization and browse to the PublicPlaces, 
Hospitals, EducationalFacilities, or MealSites feature layer. 

3. Open the item page and click Update Data > Append Data to layer. 

4. Click Choose File and browse to your .zip file, and click Open. 

5. Click Upload and Continue. 

6. Click the Choose the layer to update drop-down arrow and choose the layer to load into. 

7. Uncheck Update existing features. 

8. Click Show field matching to map the fields. 

9. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Load COVID-19 reporting areas 
The Coronavirus Case Dashboard and Community Impact Dashboard help public health 
agencies share case metrics for a specified reporting area. The reporting areas can be a 
county, ZIP Code, state, municipality, or any other geographic area you are using to tabulate 
results. Once you identify the specific reporting area you want to use, you can use the Case 
Reporter survey to tabulate COVID-19 cases for the specific reporting area. 

 

Load data from a shapefile or file geodatabase 

Load reporting areas from a shapefile or file geodatabase by following the steps below: 

1. Create a .zip file of a shapefile or file geodatabase of your facilities. 

2. Verify that you are signed in to your ArcGIS organization and browse to the 
CoronavirusCases feature layer. 

3. Open the item page and click Update Data > Append Data to layer. 

4. Click Choose File and browse to your .zip file, and click Open. 

5. Click Upload and Continue. 

6. Click the Choose the layer to update drop-down arrow and choose the Reporting Areas 
layer. 

7. Uncheck Update existing features. 

8. Click Show field matching to map the fields. 
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  Note: 

  The Reporting Areas layer includes two important fields: Name and Aggregate Area. 
Name stores the names of the reporting area. Use the Aggregate Area field to report 
case data by differing jurisdictions. For example, a county may want to share case data 
tabulated by the entire county as well as broken down by ZIP Code or municipality. In 
that case, the county has a value of Yes for the Aggregate Area field. 

9. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Modify Case Reporter reporting area choice list 

To modify a Case Reporter survey reporting area choice list, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Case Reporter to download the survey. 

4. In the Download window, click Download and click OK. 

5. Click Case Reporter again to open the survey. 

6. On the side toolbar, click the Open XLSForm Spreadsheet button. 

7. In the Microsoft Excel spreadsheet, click the choices tab.  

  This tab comprises all the selectable options for survey questions. 

8. Update the reportin_area list to reflect the reporting areas you loaded into the 
CoronavirusCases feature layer. 

9. Save and close the Microsoft Excel spreadsheet and preview your changes in Survey123 
Connect. 

10. In Survey123 Connect, click Publish on the side toolbar. 

11. Click Publish survey to publish your changes and click OK. 

 

Load COVID-19 case information 
Coronavirus Response can be used by public health agencies and other emergency response 
agencies to tabulate and monitor COVID-19 cases. The solution includes a Case Reporter 
survey that you can use to enter updated case information for each day. In some cases, you 
may find it easier to manage this information in a spreadsheet and load it into the solution as 
you receive new information. 

To load your COVID-19 case information from a spreadsheet, complete the steps below: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
CoronavirusCaseSources item. 

2. Open the item page and click Download. 

3. Edit the .csv file and provide your COVID-19 case information. 

4. In your ArcGIS organization, browse to the CoronavirusCases feature layer. 
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5. Open the item page and click Update Data > Append Data to layer. 

6. Click Choose File and browse to your .csv file, and click Open. 

7. Click Upload and Continue. 

8. Click the Choose the layer to update drop-down and choose the Cases table. 

9. Uncheck Update existing features. 

10. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Extend response surveys 
The Coronavirus Response solution includes a series of surveys (Case Reporter and Meal Site 
Report) that you can use to tabulate COVID-19 case information and meal site counts. 

Review the preconfigured questions and adjust as necessary to remain in compliance with your 
organizational policies. In addition, ensure that you secure the survey and underlying layers and 
only share the content with appropriate members of your organization. 

 

Update feature layer views 

The Coronavirus Response solution includes a series of views created from feature layers 
provided with the solution. Organizations may want to modify the Case Reporter survey by first 
adding new fields to the feature layers and then configuring the surveys to use the newly 
created fields. When doing so, you must expose the new fields in the appropriate views. 
Additionally, some views are created by joining two sources together, and you must re-create 
these views with the same name and URL after a new field is added. 

Organizations may want to modify the Case Reporter survey by adding new survey questions. 
When adding new questions, begin with the Update feature layer views section below. For 
changes such as removing questions or formatting the survey, proceed to the Modify response 
surveys section. 

To add one or more fields to a layer and re-create the views, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization. 

2. Add a new field to a layer in the CoronavirusCases hosted feature layer. 

3. Browse to the CoronavirusCases_public or CoronavirusCases_reporter views. 

4. Open the item page and click the Visualization tab. 

5. Click More Options on the appropriate layer or table, and click Set View Definition > 
Define Fields. 

6. Scroll to the newly created field and check the box next to the new field or fields. 

7. Click Apply. 

  The new field is added to the view’s definition. 

To update a join view, complete the following steps: 

1. Browse to the join view (for example, CoronavirusCases_current). 
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2. Open the item page and scroll to the URL section. Click the Copy button. 

3. Paste the copied URL into Microsoft Notepad or another text editor for reference. 

  Note: 

  The feature layer name will be used below when re-creating the join. You can find the 
name after services in the URL structure. It may also contain a unique GUID—for 
example, CoronavirusCases_current_a45f71a48587425c9b90ee5527cd26d1. 

4. Browse to the existing join view (for example, CoronavirusCases_current). 

5. Open the item page and click the Settings tab. 

6. Click the Delete Item button and click Delete. 

7. Browse to the CoronavirusCases feature layer. 

8. Open the item page and click Open in Map Viewer Classic. 

9. Click the Analysis button and click Summarize Data > Join Features. 

10. When populating the Join Features tool, do the following: 

a. Click the Choose target layer drop-down arrow and choose Reporting Areas. 

b. Click the Choose layer to join to the target layer drop-down arrow and choose 
Cases. 

c. Click Choose the fields to match as the type of join. 

d. Click the Target field drop down arrow and choose name, and click the Join field 
drop-down arrow and choose name. 

e. Click the Choose join operation drop-down arrow and choose Join one on one. 

f. Under the Define which record is kept drop-down arrow, click Order by, click the 
Field drop-down arrow and choose Date reported, and click the Sort by drop-
down arrow and choose Newest. 

  Note: 

  Ensure the new join view uses the names defined in the table above. If you use 
the same name, the layers in the map and the existing dashboard widgets do not 
have to be reconfigured. If your join view contained a unique GUID, you must 
name the new join view with the unique GUID. 

g. In the Result layer name text box, enter CoronavirusCases_current. 

h. Uncheck Use current map extent, if checked. 

i. Check Create results as hosted feature layer view check box. 

11. Update the Coronavirus Case Dashboard or Community Impact Dashboard to account for 
the new fields you added to the layers. 

  

Modify response surveys 

To modify a Coronavirus Response survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Case Reporter to open the survey. 
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  Note: 

  The Case Reporter survey is an example. The steps below are the same for the Meal 
Site Report survey. 

4. On the side toolbar, click the Open XLSForm Spreadsheet button. 

5. In the Microsoft Excel spreadsheet, click the choices tab.  

  This tab comprises all the selectable options for survey questions. 

6. Revise the survey to reflect your needs. 

7. Save and close the Microsoft Excel spreadsheet and preview your changes in Survey123 
Connect. 

8. In Survey123 Connect, click Publish on the side toolbar. 

9. Click Publish survey to publish your changes and click OK. 

 

Configure directions 
Follow the steps below to connect to a routing service and configure the widget to enable 
directions in the app. 

 

Configure widget 

To configure an app to use routes and provide directions, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the ArcGIS Web AppBuilder app. 

2. Open the item page and click Edit Application. 

3. Click the Widget tab and click Set the widgets in this controller to open the page for an 
in-panel widget.  

4. Hover over the Near Me widget and click the Configure this widget button to open the 
widget configuration window. 

5. Check the Enable Directions check box if it is not checked. 

6. Click the Direction Settings tab, click Set, and choose a routing service. 

7. Click Next and choose one or more route layers, click OK, and click OK again. 

8. Save the app and share it with everyone. 

9. Open the app. 

 

Esri premium content 

The app draws routes and provides directions using the World Route Service. This service 
requires subscriber access because it consumes credits. Before generating routes, click the 
Attributes tab of the configuration of your ArcGIS Web AppBuilder app and configure 
Subscriber content access with the URL of the routing service used by the widget. 

The app draws routes and provides directions using the World Route Service. This service 
requires subscriber access because it consumes credits. See Configure ArcGIS Living Atlas 
content to enable access to premium content. 

Learn more about credit usage when creating simple routes 
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Use Coronavirus Response 
The Coronavirus Response solution delivers a set of capabilities that help you monitor 
coronavirus disease 2019 (COVID-19) cases and response activities, communicate the impact 
on public places (for example, schools, government buildings, and common places), inventory 
meal sites, monitor meal programs, and share information with the public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Tabulate and monitor COVID-19 cases 
The Coronavirus Case Dashboard and Community Impact Dashboard help public health 
agencies share case metrics for a specified reporting area. You can quickly tabulate COVID-19 
cases with the Case Reporter survey. Current and historical results can then be seen in the 
Coronavirus Case Dashboard and the Community Impact Dashboard. You can add new case 
information as frequently as you want. 

 

Tabulate coronavirus cases 

You will start by assuming the role of an epidemiologist. You are asked to use the Case 
Reporter survey to tabulate COVID-19 cases each morning. 

1. Sign in to your ArcGIS organization and browse to the Case Reporter form. 

2. Open the item page and click Open in Survey123 > Open in browser. 

3. Click the Reporting Area drop-down arrow and choose the appropriate reporting area. 

4. Enter your case information and click Submit. 

5. Repeat this process for each additional reporting area. 

 

Monitor COVID-19 cases 

Now, you will assume the role of a public health officer or executive in the same government 
agency. You are asked to monitor the number of COVID-19 cases and are looking to see if your 
organization has a growing number of cases and how the cases may be distributed across 
demographic segments of the population. You will view the overall status of COVID-19 cases 
and then review specific demographic segments and trends. 

1. Sign in to your ArcGIS organization and browse to the Coronavirus Case Dashboard app. 

  The Coronavirus Case Dashboard opens with an overview of the current status. 

  The overview displays key metrics. This information gives management a quick overview of 
the number of cases in their community. Source of Exposure, Cases by Gender, and 
Cases by Age are also shown. 

2. Open the item page and click View Dashboard. 

3. In the filter on the top of the dashboard, click another reporting area. 

4. Click the Over Time tab in the Source of Exposure chart to see a breakdown of 
exposures over time. 

5. Click the Testing tab in the Cases Over Time chart to see a breakdown of test results 
over time. 
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6. Finally, review the Cases by Location chart in the lower right corner to see the breakdown 
of cases by location. 

 

Manage status of public places 
As the threat of COVID-19 has spread, many public gathering places (for example, schools, 
government buildings, hospitals, and common places) have altered their hours. You can use the 
Public Place Manager to communicate the status of impacted places and encourage social 
distancing. You can then share the status of these public places with the public in the School 
Closings and Public Gathering Places apps. 

 

Update status 

You will start by assuming the role of an emergency response mapping technician. You are 
asked to use the Public Place Manager to update the status of public gathering places. 

1. Sign in to your ArcGIS organization and browse to the Public Place Manager app. 

2. Open the item page and click View Application. 

3. In the left panel, click the Schools map. 

  Tip: 

  Each item listed allows you to manage facilities of that type. 

4. Click the School Name column filter. 

5. Type the school name in the School Name contains text box and press Enter. 

6. Highlight the first school in the data table. 

7. Click the Edit button  in the lower left panel. 

8. Click the Status drop-down arrow and choose Closed. 

9. In the Comment field, type School suspended until April 17. Please see our website for 
more information and updates. 

10. Click Save. 

11. Repeat this process for school districts, government facilities, community places, medical 
facilities, and so on. 

 

Review school closings 

Now, you will assume the role of a resident in the same community. You are asked to start 
social distancing by the public health officer and want to see if your child’s school is impacted. 

1. Sign in to your ArcGIS organization and browse to the School Closings app. 

  Tip: 

  You can use the Community Closings app to review impacts COVID-19 is having on 
other public places in the community. 
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2. Open the item page and click View Application. 

3. In the Locate School Closing widget, enter the name of a school in the search box. 

4. Select the school from the list and review the overview. 

  Tip: 

  The overview displays the school, status (for example, Open, Impacted, Closed), and 
any additional instructions for the community. 

 

Administer meal programs 
As COVID-19 spreads, many organizations are being required to close schools and other sites 
that typically serve food to children, young adults, seniors, and families. Schools, childcare 
facilities, and other nonprofit agencies are balancing their role of helping to prevent disease 
transmission with ensuring access to food for children who rely on the federal nutrition safety 
net. As a result, organizations are looking for alternative ways to distribute meals to those in 
need. 

 

Add meal site 

You will start by assuming the role of a school district staff member or emergency response 
mapping technician. You are asked to use the Meal Sites Manager to add a new meal site that 
was recently opened in your community. 

1. Sign in to your ArcGIS organization and browse to the Meal Sites Manager app. 

2. Open the item page and click View Application. 

3. In the Edit Meal Sites widget, click the Edit Meal Sites template. 

4. Click the map to place the location of a meal site. 

  Tip: 

  If you have a list of meal sites in a spreadsheet already (for example, 
FacilitySources.csv), you can use the Load Meal Sites widget to load the entire list of 
meal sites. 

5. Enter details about the meal site: 

– Name of Facility 

– Full Address 

– Municipality 

– Groups Served 

– Meals Served 

– Language Services 

– Phone 

– Operational Hours 

– Website 

6. Click Save, and then click Close. 
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7. Repeat this process for each meal site. 

8. Click the Update Meal Sites widget and click the Freehand Polygon Tool and draw a 
shape around one or more meal sites.. 

9. Update the status and any other characteristics and click Save. 

 

Locate meal site 

Next, you will assume the role of a resident in the same community. You have children that 
typically receive a morning meal in the local school lunch program and want to locate the 
nearest meal site. 

1. Sign in to your ArcGIS organization and browse to the Meal Sites Locator app. 

2. Open the item page and click View Application. 

3. In the Locate Meal Sites widget, enter your address in the search box or click a location 
directly on the map. 

4. Optionally, click and slide the search buffer by distance to see a larger list of potential meal 
sites. 

5. Click the Select filters to apply drop-down arrow and choose a meal or group served. 

6. Click the Select filters to apply drop-down arrow and select the closest meal site from the 
list and review the instructions provided. 

7. Click the Directions tab to view driving directions to the meal site from your defined 
location. 

 

Tabulate meals served 

Now, you will assume the role of a school district staff member or volunteer in the same 
community. You have been assigned to a meal site in the community and need to tabulate the 
number of meals served on a given day. 

1. Sign in to your ArcGIS organization and browse to the Meal Site Report form. 

2. Open the item page and click Open in Survey123 > Open in browser. 

3. Click the Site drop-down arrow and choose the appropriate meal site. 

4. Enter the number of meals served and click Submit. 

5. Repeat this process each day. 

 

Monitor meal program 

Now, you will assume the role of a school district superintendent in the same community. You 
are asked to monitor the status of your meal sites and number of meals distributed in your 
program. You will view the overall status of your meal program and then review specific trends. 

1. Sign in to your ArcGIS organization and browse to the Meal Sites Dashboard app. 

  The Meal Sites Dashboard opens with an overview of the current status. 

  The overview displays key metrics. This information gives the superintendent a quick 
overview of the number meal sites open, meals served, and the trends for the week. 

2. In the filter panel, click Meal Sites and choose an individual meal site to get more detailed 
metrics. 

3. Review the list of meal sites and click an individual site in the list to see more detail. 
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4. Review the chart to see how many meals were served each day of the previous week and 
total meals served yesterday. 

5. Click a filter in the left panel of the dashboard to refine the results in the dashboard. 

  Tip: 

  You can filter by Groups Served, Meals Provided, Status, Date, and other key metrics to 
get a better understanding of meals distributed. 

 

Generate meal site reports 

In some cases, you may need to generate a report that summarizes the number of meals 
served at each site. Follow the steps below to generate a meal site report for interested 
stakeholders. 

1. Sign in to your ArcGIS Online organization. 

2. Click the app switcher and select ArcGIS Survey123. 

3. Browse to the Meal Site Report survey and open the data page. 

4. Generate a report using the Meal Site Report template that summarizes the total number of 
meals served at meal sites. 

Tip: 

You can customize the Meal Sites Report Template to meet your organization’s needs. 
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Coronavirus Site Safety 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. 

Mature phase 
Apr. 2022 – Mar. 2024 

Retired phase 
Apr. 2024 

 

Introduction to Coronavirus Site Safety 
Coronavirus Site Safety can be used to create coronavirus disease 2019 (COVID-19) health 
safety plans for their facilities, sites, and campuses and to monitor health safety plans as 
locations reopen. 

As employees return to work and locations reopen to the public, organizations are developing 
health safety plans to protect individuals in their facilities. The health safety plans mitigate 
workers' concerns, reduce risk and communicate actions taken to key stakeholders. Location-
enabled plans provide an efficient way to document and manage all aspects of a health safety 
plan (for example, temperature screening locations, handwashing or sanitizer stations, personal 
protective equipment (PPE) stations, and isolation areas) for a given facility. It improves an 
organization’s ability to effectively execute a plan, mitigate risk at each site, and exercise health 
safety due diligence for a location. Coronavirus Site Safety is typically implemented by 
organizations that want to take a proactive, data-driven approach to planning and managing the 
health and safety of employees, visitors and other stakeholders during the COVID-19 pandemic. 

The Coronavirus Site Safety solution delivers a set of capabilities that help you create a COVID-
19 health safety plan, estimate crowd capacities and monitor social distancing, track cleaning 
and disinfecting, monitor restocking of PPE stations, and report coronavirus-related problems 
and issues. 

 

Requirements 
Coronavirus Site Safety requires the following: 

• ArcGIS Online 

• ArcGIS AppStudio Player 

• ArcGIS Field Maps 

 

Information products 
Coronavirus Site Safety includes the following information products: 

Name Description 
Minimum user 
type 
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Coronavirus Site 
Safety Form 

A Survey123 form used internally by a health safety 
officer to define the health safety plan for a given site or 
location 

Editor 

Coronavirus Site 
Safety Manager 

A Crowdsource Manager app used by a health safety 
officer to manage the status of health safety plans 

Editor 

Coronavirus Site 
Safety Map Editor 

A Web AppBuilder app used by a health safety officer 
to locate health resources and create social distance 
capacity estimates required for a health safety plan 

Editor 

Coronavirus Site 
Safety Map Viewer 

A Web AppBuilder app used by stakeholders to review 
a health safety map for a given location 

Viewer 

(Not required 
for public 
access) 

Coronavirus Site 
Safety Issue 
Reporter 

A Survey123 form used by field staff to report social 
distancing concerns, potential cases, and other health 
safety issues 

Mobile Worker 

Crowd Counter App An AppStudio app used by staff to count people 
entering and exiting an area 

Mobile Worker 

Coronavirus Site 
Safety Dashboard 

An ArcGIS Dashboards app used by a health safety 
officer to monitor health safety plan operations at a 
given location 

Viewer 

Coronavirus Site 
Safety Mobile 
Dashboard 

An ArcGIS Dashboards app used by a health safety 
officer on their mobile device to monitor health safety 
plan operations at a given location 

Viewer 

Cleaning and 
Restocking Status 
Map 

A map used in ArcGIS Field Maps to manage the 
cleaning, disinfecting, and restocking of health safety 
resources 

Mobile Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.3 • A new version of the Coronavirus Site Safety Form that resolves an input mask 
issue with the Contact Phone field. 

1.2 • A new version of the Crowd Counter App that resolves an issue where the app 
would not load in the AppStudio Player 

1.1 • A new Coronavirus Site Safety Issue Reporter that resolves an issue where the 
form could not be opened in the ArcGIS Survey123 app. 

• A new Coronavirus Site Safety Manager map and app that resolves an issue 
where site plan updates were missing the associated plan identifier. 
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• A new Coronavirus Site Safety Map Editor app that resolves an issue where site 
plan updates were missing the associated plan identifier. 

1.0 • First release of Coronavirus Site Safety 
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Configure Coronavirus Site Safety 
You can use the ArcGIS Solutions app to deploy the Coronavirus Site Safety solution in your 
ArcGIS organization. After deploying the solution to your ArcGIS organization, configure it to 
meet specific needs in your organization and load your data if needed. 

 

Define cleaning interval 
Implementing coronavirus disease 2019 (COVID-19) health safety policies for your organization 
requires cleaning or disinfecting high-risk locations at a regular interval. The cleaning, 
disinfecting, or restocking interval varies according to your organization, the volume of people, 
or the risk level of the site. Intervals can be set in any increment from hourly to weekly or 
monthly. 

The Coronavirus Site Safety Dashboard solution helps organizations track the cleaning status of 
high-risk locations to ensure compliance with organizational policies and local regulation. Using 
the Cleaning and Disinfecting Status map in ArcGIS Field Maps, janitorial staff can report each 
time they clean, disinfect, or restock a given location. 

 

Update map 

Using the Coronavirus Site Safety Dashboard, an organizational health safety officer can 
identify any locations that are overdue for cleaning based on the interval determined by their 
organizational policy. This information helps the health safety officer identify locations that are 
noncompliant with the organizational policy and immediately respond with dispatch of janitorial 
staff. 

The Coronavirus Site Safety Dashboard can be configured to meet specific needs in your 
organization. Modify the default cleaning interval (1 hour) to the interval required by your 
organization. 

To configure the map, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Coronavirus Site Safety Dashboard 
map. 

2. Open the map in Map Viewer Classic. 

3. Browse to Health Points Status_currentjoin and click the Filter button. 

4. Click the Edit tab to view the filter: StatusDate not in the last 1 hours. 

5. Modify the filter to reflect the appropriate interval for your organization. 

6. Click Apply Filter and save your map. 

 

Configure dashboard 

Once the map has been configured to filter on a new interval, the title of the cleaning and 
restocking list element in the Coronavirus Site Safety Dashboard and Coronavirus Site Safety 
Mobile Dashboard needs to be updated to reflect the interval you defined. 

To configure the dashboard label to reflect the changes you made to the map, complete the 
steps below: 

1. Sign in to your ArcGIS organization and browse to the Coronavirus Site Safety Dashboard. 
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2. On the dashboard item page, click Edit Dashboard. 

3. Hover over the upper left corner of the Overdue Locations (>60Min.) Cleaning 
|Disinfection | Re-stock list element and click Configure. 

4. Click the General tab. 

5. Click Edit to modify the Title value, remove the default time interval (for example, >60Min), 
and update the title to reflect the new cleaning interval. 

6. Click Done. 

7. Click Save to save the dashboard. 

8. Ensure you repeat steps 2 through 7 for the Coronavirus Site Safety Mobile Dashboard 
once you have completed the steps for the Coronavirus Site Safety Dashboard. 

 

Add building floor information 
For many sites, health and safety plans include interior floors and exterior spaces. ArcGIS 
Indoors is a complete indoor mapping system that can help you incorporate interior floors and 
floor awareness, and the ability to filter by indoor web layers by floor, into the Coronavirus Site 
Safety solution. The following apps support floor awareness: 

• Coronavirus Site Safety Map Editor 

• Coronavirus Site Safety Map Viewer 

• Coronavirus Site Safety Dashboard 

• Coronavirus Site Safety Mobile Dashboard 

To complete this workflow, you must have your local ArcGIS Indoors geodatabase published as 
web layers into your ArcGIS organization. 

 

Configure maps for ArcGIS Indoors 

To configure the Coronavirus Site Safety solution maps to use ArcGIS Indoors web layers, you'll 
need to review the Level Name field values defined in your ArcGIS Indoors web layers and 
ensure the Floor Number field values your health safety officer is using when creating the health 
safety plan are the same as the values in the ArcGIS Indoors layers. 

Using consistent values between Level Name field values and Floor Number field values 
ensures that the correct building floor information and related health safety plan information are 
displayed on the map and apps. 

Once you have ensured consistency between your layers, add your ArcGIS Indoors web layers 
to the Coronavirus Site Safety Map Editor map, Coronavirus Site Safety Map Viewer map, and 
Coronavirus Site Safety Dashboard map. 

 

Configure web mapping apps 

1. Sign in to your ArcGIS organization and browse to the Coronavirus Site Safety Map Editor 
item page. 

2. On the item page, click Edit Application. 

3. Click Widget and click the edit button on the Filter Safety Plan and Floor widget. 

4. In the Filter Set Name: Floor Number filter group, click Add Layer. 
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5. In the newly added row, in the Layer column, choose an ArcGIS Indoors web layer, and in 
the Field column, choose Level Name. 

6. Repeat step 5 for all the remaining ArcGIS Indoors web layers. 

7. In the Use Value column, choose the ArcGIS Indoors Levels web layer. 

8. Click OK and click Save. 

Repeat the process for the Coronavirus Site Safety Map Viewer app. 

 

Configure dashboards 

To configure the Coronavirus Site Safety Dashboard and CCoronavirus Site Safety Mobile 
Dashboard to use ArcGIS Indoors web layers, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Coronavirus Site Safety Dashboard. 

2. On the dashboard item page, click Edit Dashboard. 

3. Hover over the upper left corner of a Floor Number selector and click Configure. 

4. In the Selector section, under Selector Options, click Change and choose your ArcGIS 
Indoors Levels web layer. 

5. In the Catogory Field parameter, choose Name. 

6. Click Action, click Add Target and choose an ArcGIS Indoors web layer, and then choose 
LEVEL_NAME for the Target Field. 

7. Repeat step 6 for all the remaining ArcGIS Indoors web layers. 

8. Click Done and click Save to save the dashboard. 

Note: 

Repeat the process for the Coronavirus Site Safety Mobile Dashboard. 

 

Extend health planning resources 
The Coronavirus Site Safety solution includes dashboards that can be used to monitor health 
safety plan operations. 

On occasion, you may need to configure the dashboard to meet specific needs in your 
organization. Each solution generally includes one or more feature layers, maps, and apps that 
can be configured to meet your needs. Review this solution with stakeholders in your 
organization before defining the specific configurations you will make. 

 

Update feature layer views 

The Coronavirus Site Safety solution includes a series of feature layer join views that are used 
to display information in the Coronavirus Site Safety Dashboard and Coronavirus Site Safety 
Mobile Dashboard. Join views are created using the Join Features analysis tool by joining two 
sources together based on a matching field. The benefit of the join view is that it remains up to 
date as the source data changes. However, when new fields are added to the source layers, the 
join views must be re-created with the same name and URL for the dashboards to continue 
working properly. 
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To add a field to a layer and the update the join views, complete the following steps: 

1. Add a new field to a layer (for example, the Health Points layer in the HealthSafetyPlanning 
hosted feature layer). 

2. Browse to the join view in your contents (for example, Health Points Status_join). 

3. On the item Overview page, scroll to the URL section. Click the Copy button. 

4. Paste the copied URL into Microsoft Notepad or another text editor for reference. 

  Note: 

  The feature layer name will be used below when re-creating the join. The name can be 
found after services in the URL structure and may also contain a unique GUID, for 
example, Health_Points_Status_joina45f71a48587425c9b90ee5527cd26d1. 

5. Delete the existing join view (for example, Health Points Status_join). 

6. Add the source hosted feature layer to a new web map (for example, 
HealthSafetyPlanning). 

7. Click Analysis > Summarize Data > Join Features. 

8. Configure the join using the following table: 

Name of join Target layer 

Layer to 
join to the 
target 
layer Fields to match 

Join 
operation 

Define which 
record is kept 

Health Points 
Status_join 

Health Points 
(HealthSafetyPla
nning) 

Status GlobalID = 
Health_Points_Glo
balID 

Join one 
to many 

 

Health Points 
Status_curren
tjoin 

Health Points 
(HealthSafetyPla
nning) 

Status GlobalID = 
Health_Points_Glo
balID 

Join one 
to one 

Order by 
created_date/Ne
west 

Crowd Area 
CrowdCounts
_join 

Crowd Areas CrowdCo
unt 

areaname = 
areaname 

Join one 
to 
manytran
spo 

 

  Note: 

Ensure each new join view uses the names defined in the table. If you use the same 
names, the layers in the map and the existing dashboard widgets do not need to be 
reconfigured. If your join view contained a unique GUID, the new join view will need to be 
named with the unique GUID. 

9. If necessary, uncheck Use current map extent and check Create results as hosted 
feature layer view. 

10. Update the web map and app configurations for Coronavirus Site Safety Dashboard and 
Coronavirus Site Safety Mobile Dashboard to account for the new fields you added to the 
layers. 
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Use Coronavirus Site Safety 
The Coronavirus Site Safety solution delivers a set of capabilities that help you create a 
coronavirus disease 2019 (COVID-19) health safety plan, estimate crowd capacities and 
monitor social distancing, track cleaning and disinfecting, monitor restocking of personal 
protective equipment (PPE) stations, and report coronavirus-related problems and issues. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Manage a site 
Creating and implementing health and safety plans for sites, facilities, campuses, or locations is 
an important part of keeping communities and individuals safer, as schools, colleges, 
businesses, and facilities operate during the COVID-19 pandemic. 

Coronavirus Site Safetyoffers a comprehensive system to manage all sites in one central 
location. Each site or facility can progress through the site safety planning process, site 
planning, and operations independently, so you have the flexibility to implement appropriate 
health safety measures. 

In this workflow, you'll learn how to initiate and manage a site safety plan. 

 

Create a site safety plan 

You will start by assuming the role of a health safety officer who needs to initiate the site safety 
planning process. Using the Coronavirus Site Safety Form, you will document the site where a 
health safety plan will be created. 

1. Sign in, to your ArcGIS organization and browse to the Coronavirus Site Safety Form. 

2. Open the item page and navigate to the Coronavirus Site Safety Form. 

3. In the Coronavirus Site Safety Form, fill in the following details on the first page: 

  Parameter 
  Value 

  Enter Plan Name   Type plan name 

  Description   Type description 

  Start Date   Enter the date and time the plan will become active. 

  Contact Name   Type your name. 

  Contact Phone   Type your phone number. 

  Contact Email   Type your email address. 
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  Describe location   Type description 

  Additional Documents   Attach a diagram to describe the setup of a site. 

  Please locate the property   Type location information 

4. At the bottom of the page, click Submit. 

 

Manage and review site safety plans 

Now, you will continue the role of a health safety officer using the Coronavirus Site Safety 
Manager to update the status of a site safety plan for a location. 

1. In your ArcGIS organization and browse to the Coronavirus Site Safety Manager app. 

2. Open the item page and navigate to the Coronavirus Site Safety Manager app. 

3. Choose the Coronavirus Site Safety Manager map. 

4. In the Coronavirus Site Safety Manager table, select the plan you created in the 
Coronavirus Site Safety survey, or another plan. 

5. On the Info tab, click the edit button and edit the status. 

  As a health safety officer, you can update and monitor the status of an event throughout 
the planning process and identify when site safety maps have been created. 

6. For Status, choose Active, and click Save. 

 

Prepare site safety plans 
To protect the people who work in, shop in, study in, and use their facilities, organizations are 
preparing comprehensive site health safety plans that include prevention, mitigation, and 
response capabilities. A site health safety plan, and the health safety officer who manages it, 
represents the front line of pandemic defense for any organization, and an essential component 
of a safe back-to-work strategy. 

Health safety officers need to place preventative health resources, mitigate risk via socially 
distanced crowd management, identify high-touch surfaces in need of frequent cleaning, and 
prepare response plans for screening locations and the isolation of potential cases. 

The Coronavirus Site Safety Plan Map Editor can be used to locate health resources and create 
social distance capacity estimates required for a health safety plan. The social distance capacity 
estimates for areas or lines are based on U.S. Fire Administration guidelines. 

In this workflow, you'll learn how to locate and develop a site safety plan map. 

 

Develop a health and safety plan 

You will start by assuming the role of a health safety officer who needs to create a site safety 
plan map. You are asked to use the Coronavirus Site Safety Manager app to locate a site safety 
plan location and then the Coronavirus Site Safety Map Editor to create the health and safety 
plan map for your location. 
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1. In your ArcGIS organization and browse to the Coronavirus Site Safety Manager app. 

2. Open the item page and navigate to the Coronavirus Site Safety Manager app. 

3. Choose the Coronavirus Site Safety Manager map. 

4. Select the site you created in the Coronavirus Site Safety Form survey, or another site. 

5. On the Info tab, click Edit Site Plan. 

  The Coronavirus Site Safety Plan Map Editor app opens and zooms to the event. It also 
filters all related information, so you will see temporary features for your site plan and floor 
number, if applicable. 

6. Click the Create Site Safety Plan widget, search for PPE Station, and enter details of the 
health asset. For Floor Number, type 1. 

7. Place a PPE station on the map and enter details for the health and safety asset. 

8. Search for a handwashing station, place it on the map, and enter details for the health and 
safety asset. 

9. Search for a high-touch location, place it on the map, and enter details for the health and 
safety asset. 

10. Repeat step 5 for each health and safety asset, route, and area you would like to add to 
your site plan map. 

11. Click Save. 

12. Select Social Distancing Crowd Areas from the drop-down list at the top of the Create 
Site Safety Plan widget. 

13. Draw an area on the map and double-click to complete the sketch. 

14. For Area name, type Waiting Area. 

  Note: 

  The Area name field must be unique 

15. Draw an area on the map and double-click to complete the sketch. 

  Note: 

  The area on the map is labeled with the number of people that can safely enter an area 
of this size based on U.S. Fire Administration guidelines. Adjust the maximum capacity 
or area size if necessary. 

16. For Description, type Crowd Area for Waiting Area. 

17. Click Save. 

18. After completing your Site Safety map, click the Site Safety Report button, draw an area 
on the map, and click Report. 

19. Click the Print button and save a hard copy of your site plan map and summary of your 
health assets. 

20. Close the Coronavirus Site Safety Map Editor. 

 

Share site safety plans 
Employees, students, customers, and other people returning to a facility may be concerned 
about large crowds or other conditions that increase the likelihood of being exposed to the 
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coronavirus. To ease those concerns, health safety officers need to communicate key aspects 
of their site health safety plans to their stakeholders, such as the locations of entry health 
screenings, hand sanitizer stations, or personal protective equipment (PPE) stations. 

The Coronavirus Site Safety Map Viewer can be used by stakeholders to review a health safety 
map for a location. In this workflow, you'll learn how to share and view a health and safety plan. 

 

Share a health and safety plan 

You will start by assuming the role of a health safety officer who needs to share a site safety 
plan. You are asked to use the Coronavirus Site Safety Manager app to locate a site safety plan 
location and then use the Coronavirus Site Safety Map Viewer to share the health and safety 
plan map for your location. 

1. In your ArcGIS organization and browse to the Coronavirus Site Safety Manager app. 

2. Open the item page and navigate to the Coronavirus Site Safety Manager app. 

3. Choose the Coronavirus Site Safety Manager map. 

4. Select the site you created in the Coronavirus Site Safety Form survey, or select another 
site. 

5. On the Info tab, click Share Site Plan Viewer. 

  The Coronavirus Site Safety Map Viewer app opens and zooms to the site plan. It also 
filters all related information, so you will only see features for your site plan and floor 
number, if applicable. 

6. Copy the hyperlink, and share it with site staff, cleaning staff, and other interested 
stakeholders. 

 

View a health and safety plan 

Now, you will assume the role of site staff who need to view the health and safety plan for a 
location. You are asked to use the Coronavirus Site Safety Map Viewer app to explore the 
health and safety plan. 

1. In your ArcGIS organization and browse to the Coronavirus Site Safety Map Viewer app. 

2. Open the item page and navigate to the Coronavirus Site Safety Map Viewer app. 

3. In Filter Safety Plan and Floor, choose Floor Number, choose 1, and click Apply. 

  The first floor is displayed. 

4. Explore the health and safety map by zooming into the crowd areas and click the health 
points, lines and areas to see more information about each one. 

5. Click the Filter Resources button, enable Filter by Point Type, and choose 
Handwashing Station. 

  Only handwashing stations appear on the map. 

6. Optionally, click the Print button, choose a layout and format, and click Print to create a 
hard copy of the plan map. 

7. Close the Coronavirus Site Safety Map Viewer. 
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Conduct health and safety operations 
The Coronavirus Site Safety solution provides a complete set of capabilities that improve the 
efficiency and effectiveness of health safety officers, cleaning staff, and site staff working at a 
location during the COVID-19 pandemic by enabling staff with tools to capture information from 
the field to share with health officers in real time. 

In this workflow, you'll learn how to use a collection of maps and apps to support health safety 
officers, cleaning staff, and site staff to visualize, monitor, and communicate real-time status 
during operational hours. 

 

Report site safety issues from the field 

When health safety issues occur at a site, staff need to be able to report the issues they 
observe in the field to the health safety officer for immediate response. 

You will assume the role of a site employee that needs to report a face mask compliance 
problem you are observing. You are asked to use the Coronavirus Site Safety Issue Reporter to 
report the health safety concern. 

1. In your ArcGIS organization and browse to the Coronavirus Site Safety Issue Reporter app. 

2. Open the item page and navigate to the Coronavirus Site Safety Issue Reporter app. 

3. In the Coronavirus Site Safety Issue Reporter, fill in the following details: 

  Type   Type issue description 

  Priority Level   Type 2 

  Narrative   Type narrative 

  Location   Choose a location on the map. 

  Location Description   Type location description. 

  Floor   Type floor level 

4. Optionally, add an image or picture of the issue you are reporting. 

5. Click Submit. 

 

Download and configure Crowd Counter App 

The Crowd Counter App can be used by staff to count people entering and exiting an area. The 
app uses ArcGIS AppStudio Player on a mobile device to deliver a custom project that 
combines an ArcGIS QuickCapture project and an ArcGIS Dashboards (Crowd Counter 
Dashboard) into a single experience to support the crowd counting workflow. 
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If you have already set up the Crowd Counter App on your mobile device, proceed to the Track 
crowd capacity section below. If this is the first time you are using the Crowd Counter App on 
your mobile device, complete the following steps: 

1. Download ArcGIS AppStudio Player onto your mobile device. 

2. Open the app on your mobile device, and sign in to your ArcGIS organization. 

3. Click the Shared button and click the Crowd Counter App button to download the app. 

4. Click the Crowd Counter App button.  

  An ArcGIS QuickCapture screen prompts you to sign in to your ArcGIS organization again. 

5. Click the add button and choose Browse Projects, and then click Crowd Counter App to 
download the project. 

6. When the download is complete, choose Crowd Counter Dashboard, and when prompted, 
sign in to your ArcGIS organization and choose Keep me signed in. 

Note: 

The first time you set up your mobile device with the Crowd Counter App, you are prompted 
to sign in two separate times. This is expected. After the initial setup, you are only asked to 
sign in once, after you see the ArcGIS QuickCapture screen. 

 

Track crowd capacity 

You will assume the role of site staff. You are asked to use the Crowd Counter App to count 
people entering and exiting the area to ensure the number of people admitted does not exceed 
the maximum capacity allowed for a unique area. 

1. Open and sign in to the Crowd Counter App using the ArcGIS AppStudio Player app on 
your mobile device, if it isn't already open from the previous workflow. 

2. Click the edit button to edit the area name and enter the exact area name of the location 
you are tracking crowd capacity for (use Waiting Area if you completed the Prepare site 
safety plans workflow). 

  Note: 

  The area name you type must match exactly with the area name specified in the health 
safety plan map. If you are unsure of the exact name, click the Map tab to see a map of 
your site containing labels with the exact name of each crowd area. 

3. Click Done. 

4. Choose Enter for each person entering the area and choose Exit for each person exiting 
the area. 

5. Monitor the gauge on the Occupancy tab to understand the current capacity (middle 
number) relative to the maximum capacity (last number). 
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  Tip: 

  The gauge displays different colors as capacity changes. The color green indicates 
capacity, orange indicates maximum capacity is near, and red indicates maximum 
capacity. 

6. Continue to allow people to enter and exit the area based on the current capacity. 

Note: 

If the gauge does not display the correct results, click the refresh button in the upper right 
hand corner of the app, click the edit button to edit the area name, and click Done. 

Tip: 

When the Crowd Counter App is used to count high numbers of people, consider deleting 
or archiving entry and exit records from the Crowd Count layer to ensure better 
performance of the app. 

 

Track cleaning and stocking status 

You will now assume the role of janitorial staff. You are asked to use the ArcGIS Field Maps 
mobile app to update the status of locations after you clean, disinfect, or restock them with PPE. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open the app on your mobile device and sign in to your ArcGIS organization. 

3. Choose Cleaning and Restocking Map. 

4. Choose a station for PPE Station, choose Cleaning and Restocking Status in the pop 
up, and click the Add button. 

  Note: 

  The space under the Add button displays all historical status records for a location, so as 
a station is restocked with PPE, a user can review this list to see when it was restocked 
and how much PPE it was restocked with. 

5. Choose status, choose Re-stocked, and add the number of boxes stocked of each PPE 
type. 

6. Choose Submit. 

 

Monitor site safety operations 

Health safety officers need real-time information on the location issue reports, status of cleaning 
and restocking, and crowd capacity information to conduct health and safety operations of sites. 
The Coronavirus Site Safety Dashboard can be used in the command center on the day of the 
event. 
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You will assume the role of a health safety officer. You are asked to use the Coronavirus Site 
Safety Dashboard to monitor and manage health safety issue reports, site capacity, and 
cleaning and restocking status. 

1. In your ArcGIS organization and browse to the Coronavirus Site Safety Dashboard app. 

2. Open the item page and navigate to the Coronavirus Site Safety Dashboard app. 

3. At the top of the dashboard, use Select Site Safety Location and choose a site.  

  The dashboard information updates to reflect only what is visible on the map. 

4. View the number of open issue reports in the Issue Reports section.  

5. Click the Open Reports tab at the bottom of the dashboard to see open issues in priority 
order based on site safety issues reported by staff using the Coronavirus Site Safety Issue 
Reporter. 

  Note: 

  Learn how to update the status of issue reports using the Manage issue status workflow 
in the section below. 

6. Click the Report Log tab at the bottom of the dashboard to see the last 50 issue reports, 
regardless of status, listed in order of importance.  

  This allows you to compare issue reports, reopen closed issues, and identify any emerging 
patterns. 

7. In the Capacity Monitoring section, you will see the real-time total capacity by 
percentage, as well as total capacity and maximum capacity by count across your site 
based on information from staff tracking crowd capacity using the Crowd Counter App. 

8. On the Area Capacities tab at the bottom of the dashboard, click Waiting Area or another 
area in the list.  

  The map zooms to the area and a pop-up appears with information about the area. The 
Capacity Monitoring section at the top of dashboard updates to reflect the capacity 
information for the area. 

9. Click the Live Count tab at the bottom of the dashboard to see the real-time list of entries 
and exits from the selected area in the Area Capacities list. 

  Note: 

  If an individual area is not selected in the Area Capacities list, you see the total entries 
and exits from all areas in the Live Count list. 

10. Click the Status List tab on the bottom of the dashboard to see real-time cleaning and 
restocking status for PPE stations, high-touch locations, and other health assets. 

11. Click the Status History tab on the bottom of the dashboard to see historical cleaning and 
restocking status for PPE stations, high-touch locations, and other health assets. 

12. Close the app. 

 

Manage issue status 

Health safety officers need real-time information on reported health safety issues as well as the 
ability to update status, assignments, and other details of an issue. 
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You will assume the role of a health safety officer. You are asked to use the Coronavirus Site 
Safety Dashboard to locate an issue report at a site and then use the Coronavirus Site Safety 
Manager to update the status of the report. 

1. In your ArcGIS organization and browse to the Coronavirus Site Safety Dashboard app. 

2. Open the item page and navigate to the Coronavirus Site Safety Dashboard app. 

3. At the top of the dashboard, use Select Site Safety Location and choose a site.  

  The dashboard information updates to reflect only what is visible on the map. 

4. Click the Open Reports tab at the bottom of the dashboard to see open issues in priority 
order, based on site safety issues reported by staff using the Coronavirus Site Safety Issue 
app. 

5. Click the Update Status button. 

  The Coronavirus Site Safety Manager app opens. 

6. Click the Coronavirus Issue Report Status map. 

7. In the Coronavirus Issue Reports table, select the issue you want to update. 

8. On the Info tab, click the edit button and edit the status. 

  As a health safety officer, you can update and monitor the status of an issue at any time. 

9. For Report Status, choose Closed, and click Save. 

10. Close the app. 
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Coronavirus Small Business Recovery 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. 

Mature phase 
Nov. 2022 – Oct. 2024 

Retired phase 
Nov. 2024 

 

Introduction to Coronavirus Small Business 
Recovery 
Coronavirus Small Business Recovery can be used to promote small businesses operating 
during the coronavirus disease 2019 (COVID-19) pandemic and understand the impact of the 
pandemic on small businesses in their community. 

Small businesses are an integral part of the economy. Unfortunately, the pandemic has 
negatively impacted many businesses and some will not recover. Thankfully, there are 
programs that attempt to provide direct relief to struggling businesses but keeping up with new 
programs and regulations can be challenging. Helping small business recover requires a robust 
and transparent public education campaign that engages local businesses and provides the 
assistance they need (for example, grants, loans, employment advertisements, etc.). 
Coronavirus Small Business Recovery is typically implemented by economic development 
departments and other local government agencies that want to engage small businesses and 
help them recover from the impacts of the COVID-19 pandemic. 

The Coronavirus Small Business Recovery solution delivers a set of capabilities that help you 
engage local business owners, measure the impact of the pandemic on small businesses, 
report potential health order violations and their resolution, and promote small business 
recovery. 

 

Requirements 
Coronavirus Small Business Recovery requires the following: 

• ArcGIS Online 

• ArcGIS Hub Premium 

• Survey123 Connect 

 

Information products 
Coronavirus Small Business Recovery includes the following information products: 

Item Description 
Minimum 
user type 
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Business Listing An ArcGIS Survey123 form used by business owners to 
share business information, including operating hours, 
services provided, job opportunities, and any special offers 

Community 
Account 

Business Listing 
Manager 

A Crowdsource Polling app used by business owners to 
update business information on a regular basis 

Community 
Account 

Business 
Program 
Manager 

A Crowdsource Manager app used by economic 
development staff to manage businesses in the small 
business recovery program 

Editor 

Health Violation 
Dashboard 

An ArcGIS Dashboards app used by health department 
staff to monitor health order violation reports 

Viewer 

Health Violation 
Manager 

A Crowdsource Manager app used by health department 
staff to manage health order violation reports 

Editor 

Health Violation 
Reporter 

An ArcGIS Survey123 form used by the general public to 
report health order violations 

Not Required 

Small Business 
Locator 

A Nearby app used by the general public to find local 
businesses and review current operating hours or job 
opportunities 

Not Required 

Small Business 
Impact 
Dashboard 

An Crowdsource Manager app used by economic 
development staff to monitor business impact and track key 
metrics of the small business recovery program 

Viewer 

Small Business 
Impact Survey 

An ArcGIS Survey123 form used by business owners to 
record how their business has been affected by the COVID-
19 pandemic 

Community 
Account 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • The first release of Business Listing, Business Listing, Business Program 
Manager 

• Small Business Locator has been updated to use the Nearby configurable web 
app 

• Business designation fields smallbusiness, womanowned, veteranowned, and 
bipocowned have been added to the BusinessListing layer 

• Multiple fields have been added to the BusinessListing layer to support 
expanded services and operating hours functionality in web map pop-ups 

• Demographics fields have been added to the BusinessImpactSurvey layer 

• Small Business Listing, Small Business Listing Manager and Small Business 
Program Manager have been removed 

1.0 • First release of Coronavirus Small Business Recovery 
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Configure Coronavirus Small Business Recovery 
In this topic, you will learn how to configure the Coronavirus Small Business Recovery solution 
to meet specific needs in your organization. 

 

Load data 
Coronavirus Small Business Recovery can be used by economic development agencies to 
connect with and promote local businesses. The solution is designed to allow business owners 
to be able to list and update their own business details. If needed, existing business listings can 
be bulk loaded and maintained by economic development staff. 

To load your business listing locations into the BusinessListing layer from a spreadsheet, 
complete the following steps: 

1. Sign in to your ArcGIS organization . 

  Note: 

  If you have an existing spreadsheet of business locations you can skip to step 6. 

2. Browse to the BusinessListingLocations CSV item. 

3. On the item details page, click Download 

4. Once downloaded, open the BusinessListingLocations.csv and enter in your business 
location information. Ensure the name of spreadsheet is BusinessListingLocations and do 
not change any field names. Save your work. 

5. In your ArcGIS organization, browse to the BusinessListing hosted feature layer item 
details page. 

6. On the item details page, click Update Data – Append Data to Layer. 

7. Under Filename choose your .csv file. 

8. Click Upload and Continue. 

9. Uncheck Update existing features. 

10. Click Show field matching. Confirm that all fields listed in the Fields column have a 
corresponding field listed in the Match Field column. If no field is listed in the Match Field 
column, click the dropdown box for that field, and select the field name from 
the spreadsheet which reflects the value shown in the Fields column. 

11. Map the Latitude field to y column and the Longitude field to the x column. 

12. Click Apply Updates. 

 

Populate operational hours 
This solution leverages the Opening Hours Specification to display operating hours for a place 
or service. When you populate the data fully, Arcade expressions interpret the data and display 
the operating hours in a human-readable format in the map pop-up. Understanding the data 
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specification and options in the Arcade expressions will help you populate your data and display 
it in the maps and apps provided with the ArcGIS Solution. 

 

Operating Hours Specification 

The Operating Hours Specification allows you to store a combination of operating hours in a 
single field but relies on a series of data standards to render the information correctly. To ensure 
operating hours are displayed correctly, follow the standards below: 

• Enter all times using a 24-hour clock without a leading 0—for example, Tu (7:00-19:00). 

• Use a two-letter abbreviation for each day, with the first letter capitalized—for example, Mo, 
Tu, We, Th, Fr, Sa, Su. 

• When a location is open 24 hours a day, use 24 Hours—for example, Mo (24 Hours). 

• When a location is closed on a specific day, use Closed—for example, Sa-Sun (Closed). 

• Enclose all times and closed statuses in parentheses—for example, Tu (7:00-19:00); We-
Mo (Closed). 

• Separate days and ranges with a semicolon to denote the two (or more) groups—for 
example, Th-Fr (7:00-19:00); Sa (24 Hours). 

Using the standards above, a diverse set of operating hours can be populated for your places 
and services. Some common examples include the following: 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. seven days a week, populate the 
operating hours field with the following: Mo-Su (9:00-17:00). 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. during the week and closed on 
weekends, populate the operating hours field with the following: Mo-Fr (9:00-17:00); Sa-Su 
(Closed). 

• To specify the place is open one day (Tuesday) a week, populate the operating hours field 
with the following: Tu (7:00-19:00); We-Mo (Closed). 

• To specify the place has operating hours that vary by day, populate the operating hours 
field with the following: Mo-Tu (9:00-17:00); We (Closed); Th-Fr (7:00-19:00); Sa (24 
Hours); Su (Closed). 

Operating hours data can be populated all at once for many places and services using Calculate 
field values or uniquely entered for each place or service using an application provided with the 
solution. 

 

Arcade expressions 

The Arcade expressions include several settings that allow you configure the look and feel of 
the operating hours when they are displayed in the web map pop-up. The expressions work with 
the operating hours data and web map pop-up configurations to display current operating hours 
in your map and app. 

This solution uses three Arcade expressions: Hours, Days, and Open/Closed. To modify one of 
these expressions, complete the following steps: 

1.  Verify that you are signed in to your ArcGIS organization and browse to the Coronavirus 
Small Business Recovery map. 

2. Open the item page and click Open in Map Viewer Classic. 

3. Click More Options and click Configure Pop-up on the business listing layer. 
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4. Under Attribute Expressions, double-click the Arcade expression you want to modify. 

  Each Arcade expression has a set of variables that can be configured according to your 
organization’s needs. Review the expression notes and modify the variables as needed. 
Do not change anything else in the expressions. 

5. Click OK. 

 

Configure the Small Business Locator app 
The Small Business Locator app provides a way to promote businesses and employment 
opportunities. This app has some common configuration options you may want to extend. It can 
be extended to allow directions from your current location or symbolized to promote specific 
business types or designations. 

The app can be configured to provide directions to the nearest location. To configure the locator 
app in the Small Business Locator solution, complete the following steps: 

1. Sign in to your ArcGIS Online organization, if necessary, and browse to the locator app. 

2. Open the item details page and click Configure App. 

  Close the Welcome to the App Setup Page splash page, if necessary. 

3. In the left side panel, click Interactivity. 

4. If you are in Full Setup mode, click Results and click the Show directions toggle button. 

5. If you are in Express Setup mode, click the Show directions toggle button. 

6. If you are in Full Setup mode, click About and click the Legend and Open legend when 
app loads toggle buttons. 

7. Click Publish. 

8. Click Confirm. 

  The Authorize premium content window will appear indicating the number of credits 
consumed. 

9. Click Authorize. 

10. Click Launch. 

 

Configure Business Program Manager 
The Business Program Manager app can be used to manage businesses that enroll in the 
Coronavirus Small Business Recovery or Business Inclusion programs. 

The Business Program Manager web map pop-up includes a series of buttons that can be used 
to send Small Business Impact Survey or Business Inclusion Surveyto program participants. 
Review the pop-up configuration and adjust as necessary to fit the needs of your business 
program. 

 

Send Business Inclusion survey 

If the Business Program Manager app is deployed with the Coronavirus Small Business 
Recovery solution, the Send Small Business Impact Survey button will be configured for you 
when you deploy the solution. If you already deployed the Business Inclusion solution, you can 
add the Business Inclusion Survey to the Business Program Manager app configuration. 
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To configure the Send Business Inclusion Survey button, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and have deployed the Business 
Inclusion solution. 

2. Navigate to the Business Inclusion Survey form in your contents. 

3. Copy the item ID. 

  Note: 

  The item ID can be found in the item’s URL immediately following ?id=. If you double-
click the ID in the URL, it will highlight just the ID. 

4. Navigate to the Business Program Manager web map item details page. 

5. Click the Open in Map Viewer down arrow, then Add to new map. 

6. Click the More Options ellipses on the Local Businesses layer, then click Configure Pop-
up. 

7. Under Attribute Expressions, scroll to Business Inclusion Survey Email expression. Click 
on the expression and click Configure Expression. 

8. Replace the item ID on line 3 with the copied ID from step 3. Click OK. 

9. Click OK. Save the map. 

 

Remove Business Inclusion Survey button 

To remove the Send Business Inclusion Survey button complete the following steps: 

To remove the Send Business Inclusion Survey button, complete the following steps: 

1. Navigate to the Business Program Manager web map in your contents. 

2. Click the Open in Map Viewer down arrow, then Add to new map. 

3. Click the More Options ellipses on the Local Businesses layer, then click Configure Pop-
up. 

4. Click Configure, highlight and delete the text for the Send Business Inclusion Survey 
button. Click OK. 

5. Click OK. Save the map. 

 

Modify surveys 
The Coronavirus Small Business Recovery solution includes a series of surveys (Business 
Listing, Small Business Impact Survey, Health Violation Reporter) that can be used to promote, 
provide business impact feedback, and submit health violation reports. 

Review the preconfigured questions and adjust as necessary to fit the needs of your business 
program. 

 

Add additional fields 

All surveys leverage feature layer views created from the BusinessListing, 
BusinessImpactSurvey, and HealthViolations feature layers. Organizations may want to modify 
the Business Listing, Small Business Impact Survey, and Health Violation Reporter surveys by 
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first adding new fields to the feature layers then configuring the surveys to utilize the newly 
created fields. When doing so, the new fields must be exposed in the appropriate feature layer 
views. 

To add one, or more, fields to a layer and update the feature layer views, complete the following 
steps: 

1. Add a new field to a layer in the BusinessListing, BusinessImpactSurvey, or 
HealthViolations hosted feature layer. 

2. Navigate to the feature layer view in your contents. 

3. Click the Open in Map Viewer down arrow, then Add to new map. 

4. Click the More Options ellipses on the appropriate layer or table, then click Set View 
Definition. 

5. Click Define Fields. 

6. Scroll to the newly created field, check the box, and click Apply. 

  The new field is added to the feature layer view’s definition. 

 

Modify surveys 

To modify a survey in the Coronavirus Small Business Recovery solution, complete the 
following steps: 

1. Install Survey123 Connect. 

2. Start Survey123 Connect and sign in to your ArcGIS organization. 

3. Click on Business Listing to download the survey. 

  Note: 

  The Business Listing form is an example. The steps below are similar for the Business 
Inclusion Survey. 

4. In the Download window, click Download and click OK. 

5. Click on Business Listing again to open the survey. 

6. On the side toolbar, click the XLSForm button. 

7. Revise the survey to reflect your needs. 

8. Click the settings tab, in the submission_url column enter the BusinessListing_listing 
hosted feature layer view item URL. 

  Note: 

  To create this URL, concatenate the Item ID with the portal Content Root. The Item ID 
can be found at the end of the URL immediately following ?id=. For an ArcGIS Online 
item, the URL looks like: 
https://www.arcgis.com/sharing/rest/content/items/21a6c530b31a4523bdff7gg94c9c5d9a
. 

9. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

10. In Survey123 Connect, click Publish in the left pane to publish your changes. 
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Activate the ArcGIS Hub initiative 
The Coronavirus Recovery ArcGIS Hub initiative can be used to promote coronavirus recovery 
programs developed for your community. The initiative template includes a responsive and 
accessible website that can be enhanced with several coronavirus solutions (for example, 
Wellness Checks, Testing Sites, and Small Business Recovery). The ArcGIS Solutions are 
designed to educate the public, engage volunteers, and help small business owners. 

Note: 

The Coronavirus Recovery ArcGIS Hub Initiative template is only available in ArcGIS Hub 
Premium. 

Activate the initiative 

To enable the Coronavirus Recovery ArcGIS Hub initiative, complete the steps below: 

1. Sign in to your ArcGIS Online organization, click the app switcher, and select ArcGIS Hub. 

2. In the Initiatives panel, click New and click Browse Templates. 

3. Locate Coronavirus Recovery in the gallery and click Activate Initiative. 

4. After the activation completes, follow the instructions provided on the How to use this 
template hub page. 

 

Share ArcGIS Solutions 

When you activate the Coronavirus Recovery ArcGIS Hub initiative, it creates a site, pages, and 
two groups (Core Team and Followers) in your ArcGIS organization. Several maps and apps 
included with Coronavirus Small Business Recovery must be shared with business owners 
before inventorying small businesses and assessing the impact. Sharing the appropriate maps 
and apps with the Followers group created with the initiative will allow small business owners to 
access them after creating a community identity. 

To share the Coronavirus Small Business Recovery maps and apps, follow the steps below: 

1. In your ArcGIS Online organization content, search for the Business Listing form. 

2. Click the Check Box next to the Business Listing form and click Share.  

3. Click Edit group sharing and select the Coronavirus Recovery Followers group. 

4. Click OK and click Save. 

5. Repeat the process for the following items: 

  Item   Name 
  Sharing 

  Apps   Business Listing 
Manager 

  Group: Coronavirus Recovery 
Followers 

  Maps   Business Listing 
Manager 

  Group: Coronavirus Recovery 
Followers 
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  Feature Layer 
(hosted, view) 

  BusinessListing_listing   Group: Coronavirus Recovery 
Followers 

6. Share the Small Business Locator app and BusinessListing_public feature layer view with 
everyone. 

7. Share the Small Business Impact Survey and the BusinessImpactSurvey_survey feature 
layer view with everyone. 

8. Share the Health Violation Reporter and the HealthViolations_reporter feature layer view 
with everyone. 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


 

Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal Page 107 

Use Coronavirus Small Business Recovery 
The Coronavirus Small Business Recovery solution delivers a set of capabilities that help you 
engage local business owners, measure the impact of the pandemic on small businesses, 
report potential health order violations and their resolution, and promote small business 
recovery. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Manage business listings 
Providing accurate business listing information to the public as small businesses reopen during 
the COVID-19 pandemic can be an effective way to support the small business community. The 
Business Listing form allows small businesses to provide business listing details such as hours 
of operation, services, social media profiles, and employment opportunities. Business listing 
information is made available to the public in the Small Business Locator. 

In this workflow, you will learn how to create a business listing, manage your business listing, 
and share economic impact information with economic development staff. 

 

Submit a business listing 

You will begin by assuming the role of a small business owner in a community. You want to 
share information about your business with economic development staff so they will promote 
your business during the COVID-19 pandemic. 

1. In a browser, from the Coronavirus Small Business Recovery solution, view the 
Coronavirus Recovery ArcGIS Hub site, and then at the top of the page, click the Small 
Business Recovery tab. 

  Note: 

  For more information, see Activate the ArcGIS Hub initiative. 

2. Scroll to the Join Small Business Program section, and then click Join Program.  

3. In the dialog box, click Create a Hub Community account. 

4. Complete the Hub community account form, and then click Next.  

  An activation email is sent to the email address you used when setting up the account. 

5. Open your email client and locate the email from the ArcGIS Hub community, and then 
click the link in the email to activate your account.  

6. Complete the form, and then click the Create Account button. 

7. Return to the Coronavirus Recovery ArcGIS Hub site and, if necessary, click the Small 
Business Recovery tab to return to the page. 
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  Note: 

  Scroll to the Join the Program section and, if necessary, click Join Program. 

8. Scroll to the Share Your Small Business Information section, and then under List Your 
Business, click List Business. 

9. Sign in with your ArcGIS Hub community account credentials. 

10. Complete the Business Listing form, and then click Submit. 

 

Update a business listing 

Business listing details may change over time as hours of operation expand or employment 
opportunities become available. The Business Listing Manager app can be used by small 
business owners to update business listing details. 

As a business owner, you want to share new information about your small business and several 
recent job openings you have. 

1. In a browser, from the Coronavirus Small Business Recovery solution, view the 
Coronavirus Recovery ArcGIS Hub site, and then at the top of the page, click the Small 
Business Recovery tab. 

  Note: 

  For more information, see Activate the ArcGIS Hub initiative. 

2. Scroll to the Share Your Business Information section, and then under Manage 
Business Listing, click Manage listing. 

3.  If necessary, sign in with your ArcGIS Hub community account. 

4. In the panel on the right, select your business; alternatively, click your business on the 
map. 

5. Review the current business listing details. 

  Note: 

  Small business owners can only see and edit their business listing. Small business 
owners can also review comments made by the administering agency in the Agency 
Comments section. 

6. Click the Small Business Listing link to open the Business Listing form. 

7. In the form, update listing details, and then click Submit. 

 

Provide economic impact information 

Small business owners can use the Small Business Impact Survey to provide information to the 
economic development agency and help them understand small business needs and concerns 
during the COVID-19 pandemic. 
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1. In a browser, from the Coronavirus Small Business Recovery solution, view the 
Coronavirus Recovery ArcGIS Hub site, and then at the top of the page, click the Small 
Business Recovery tab. 

  Note: 

  For more information, see Activate the ArcGIS Hub initiative. 

2. Scroll to and click Take Survey. 

3. Complete the Small Business Impact Survey, and then click Submit. 

Note: 

The Small Business Impact Survey can also be sent directly to a small business owner 
participating in the recovery program by using the Business Program Manager. 

 

Administer a small business program 
As small business owners submit and update business listing details, economic development 
staff may want to review business listings before promoting a business more broadly. 

In this workflow, you will learn how to view small business listings provided by business owners, 
manage a business’s visibility in the Small Business Locator, and send the Small Business 
Impact Survey. 

 

Remove a business listing 

You will start by assuming the role of an economic development manager in a local community. 
You want to review business listing details and remove a small business from the Small 
Business Locator. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Small Business Recovery solution. 

2. View the Business Program Manager app. 

  Businesses are listed in the table at the top. You can sort and filter the table in various 
ways by clicking column header filters or arrows. 

3. Click a business in the table or on the map. 

  The business's details open at the lower left. 

4. Review the details. 

5. In the report details, click the Edit Record button . 

6. To remove a small business from the Small Business Locator, for Visible to Public, 
choose No. 

7. Optionally, in the Agency Comments section, add comments to the listing. 

  Comments are visible to the small business owner when using the Business Listing 
Manager 

8. Click Save. 
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Send a Small Business Impact Survey 

The Small Business Impact Survey can be used to gather information from small business 
owners about how their business has been affected by the COVID-19 pandemic and learn what 
support businesses need to continue to operate and thrive. 

You will continue assuming the role of an economic development manager. You are asked to 
use the Business Program Manager to collect feedback from small businesses. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Small Business Recovery solution. 

2. View the Business Program Manager app. 

3. Click a business in the table or on the map. 

  The business's details open at the lower left. 

4. Review the details. 

5. At the bottom of the details, click Send Small Business Impact Survey.  

  Your email client opens with a formatted email message that includes a link to the Small 
Business Impact Survey to send to the small business owner. 

6.  Modify the email message as necessary. 

Note: 

The link provided in the email message completes several of the fields in the Small 
Business Impact Survey, such as contact details, location, and business type for the small 
business owner. 

 

Monitor small business impact 

As the small business community provides information using the Small Business Impact Survey, 
the Small Business Impact Dashboard can be used by economic development managers to 
understand the impact of the COVID-19 pandemic. 

As an economic development manager, you are asked to use the Small Business Impact 
Dashboard to understand the impact of the pandemic on the small business community, align 
resources with needs, and craft programs to support small businesses. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Small Business Recovery solution. 

2. View the Small Business Impact Dashboard app. 

  The Small Business Impact Dashboard opens with the Overview tab active. The Overview 
tab displays infographics of key survey response questions such as special (business) 
designations and laid off or furloughed staff. 

3. At the lower left, click the Survey Responses tab.  

  The Survey Responses tab allows an economic development manager to monitor survey 
responses along several categories. The page displays survey responses summarized by 
categories such as operating status, business type, and concerns. 

4. On the right, under Business Impact Surveys, click a survey response. 
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5. Click a chart element. 

  Charts on the Survey Responses tab are linked. When a category is selected in one 
chart, related details are filtered and updated in other charts, which enables an economic 
development manager to find trends that need attention. 

6. On the left of the app, click the arrow to display the filter panel.  

  Tip: 

  To pin the filter panel to the dashboard, click the pin in the upper-right corner. 

7. Use filters to refine the results.  

 

Locate small businesses 
Providing accurate business listing information to the public as small businesses reopen during 
the COVID-19 pandemic can be an effective way to support the small business community. 
Small Business Locator can be used by the public to find small businesses and listing details 
such as hours of operation, services, social media profiles, and employment opportunities. 

In this workflow, you will learn how to locate a small business in your community and potential 
job opportunities. 

 

Locate a small business 

You will assume the role of a resident in a local community. You want to support small 
businesses in your community during the COVID-19 pandemic and need to locate a small 
business that is open for business. 

1. In a browser, from the Coronavirus Small Business Recovery solution, view the 
Coronavirus Recovery ArcGIS Hub site, and then at the top of the page, click the Small 
Business Recovery tab. 

  Note: 

  For more information, see Activate the ArcGIS Hub initiative. 

2. Scroll to the Helping Small Businesses section, and then under Support Local 
Businesses, click Locate a business. 

3. In the Small Business Locator app, search for your address; alternatively, click a location 
directly on the map. 

4. Optionally, adjust the buffer slider to see a larger list of potential businesses. 

5. Review business details. 

6. Click the Directions tab to view driving directions to the business from your defined 
location. 
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Report health violations 
As businesses begin to open, there may be a need for the public to report unsafe business 
practices and potential health violations to an administering agency. 

In this workflow, you will learn how to report a potential health violation in your community. 

 

Report a health violation 

You will assume the role of a resident in a local community. You have noticed a potential 
violation in a local park and want to report it to the local health department. 

1. In a browser, from the Coronavirus Small Business Recovery solution, view the 
Coronavirus Recovery ArcGIS Hub site, and then at the top of the page, click the Small 
Business Recovery tab. 

  Note: 

  For more information, see Activate the ArcGIS Hub initiative. 

2. Scroll to If you see a potential health violation in our community, report it and click 
Report it. 

3. Complete the Health Violation Reporter, and then click Submit. 

 

Manage and monitor health violations 
As businesses begin to open, there may be a need for the public to report unsafe business 
practices and potential health violations to an administering agency. Health officers may then 
investigate the reports and track their resolution. 

In this workflow, you will learn how to manage reported potential violations and visualize 
violation trends over time. 

 

Manage health violations 

You will assume the role of a health officer reviewing and managing potential violations reported 
by the public. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Small Business Recovery solution. 

2. View the Health Violation Manager app. 

  All reports are listed in the table at the top. The table can be sorted and filtered in various 
ways. 

3. In the table, use the column header filters and arrows to filter results. 

4. Select a health violation report in the table or on the map. 

  The details appear at the lower left. 

5. Review the health violation report details. 

6. In the report details, click the Edit Record button . 
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7. For Status, choose a value from the drop-down menu. 

8. Use the Assigned To, Resolved On, and Resolution fields to manage the health violation 
report through its life cycle. 

9. Optionally, in the Agency Comments field, add comments to the health violation report in 
the field. 

10. Click Save. 

 

Monitor health violations 

You will continue assuming the role of a health officer. You have been asked to monitor health 
violation reports and ensure these reports are being resolved in a timely manner. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Small Business Recovery solution. 

2. View the Health Violation Dashboard. 

  The Health Violation Dashboard opens with the Overview tab active. The Overview tab 
displays key metrics around reported health violation reports. This information gives 
management a quick overview of the number of reported health violations submitted by the 
public. 

3. At the lower left, click the Violation Reports tab.  

  The Violation Reports tab allows a health officer to monitor how their department is doing 
when it comes to resolving health violation reports. The page displays violations 
summarized by status, day submitted, and recurring problems. 

4.  On the right, under Health Violation Reports, click a violation report. 

  The map zooms to the business, and a pop-up shows business details. 

5. Click a chart element. 

  Charts on the Violation Reports tab are linked. When a category is selected in one chart, 
related details are filtered and updated in other charts, which enables a health officer to 
identify issues and areas that need attention. 

6. On the left of the app, click the arrow to display the filter panel.  

  Tip: 

  To pin the filter panel to the dashboard, click the pin in the upper-right corner. 

7. Use filters to refine the results.  
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Coronavirus Testing Sites 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. 

Mature phase 
Nov. 2022 – Oct. 2024 

Retired phase 
Nov. 2024 

 

Introduction to Coronavirus Testing Sites 
Coronavirus Testing Sites can be used to identify at-risk populations and develop coronavirus 
disease 2019 (COVID-19) testing site plans. 

Preventing the spread of infection is one of the most effective ways to stop the pandemic and 
reopen communities. Widespread testing helps residents determine if they have been infected 
and could spread coronavirus to others. Furthermore, testing matters more in communities 
affected the most. Communities of color and socioeconomically vulnerable communities are 
disproportionately burdened by the pandemic and the impact is acute. Understanding population 
demands and where racial and socioeconomic vulnerabilities exist helps communities locate 
ideal testing sites. Coronavirus Testing Sites is typically implemented by health and human 
services or public safety agencies that want to optimize the location of coronavirus disease 
2019 (COVID-19) testing sites, maximize limited testing resources and ensure communities 
affected the most have access to coronavirus testing. 

The Coronavirus Testing Sites solution delivers a set of capabilities that help you identify at-risk 
populations, locate optimal testing sites, manage testing site status, and share testing site 
information with the public. 

 

Requirements 
Coronavirus Testing Sites requires the following: 

• ArcGIS Online 

• ArcGIS Pro 2.9 (Advanced) 

– ArcGIS Geostatistical Analyst extension 

 

Information products 
Coronavirus Testing Sites includes the following information products: 

Item Description 
Minimum user 
type 

Testing Sites 
Locator 

An ArcGIS Web AppBuilder app used by the public to 
locate the nearest coronavirus testing location 

Viewer 
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Testing Sites 
Manager 

A Crowdsource Manager app used by health and human 
services staff to inventory coronavirus testing locations 

Editor 

Testing Site 
Allocation 

An ArcGIS Pro project used by health and human services 
analysts to identify at-risk populations and locate optimal 
testing sites 

GIS Professional 
Advanced 

 

Release notes 
The following are the release notes: 

Version Description 

1.2 • An update to the Testing Site Allocation ArcGIS Pro project to resolve a bug in 
the Create Ranked Surface tool. 

1.1 • Resolved an issue in the Solve Location Allocation with Risk model that 
prevented it from running properly. 

1.0 • First release of Coronavirus Testing Sites. 
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Use Coronavirus Testing Sites 
The Coronavirus Testing Sites solution delivers a set of capabilities that help you identify at-risk 
populations, locate optimal testing sites, manage testing site status, and share testing site 
information with the public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Identify at-risk populations 
At-risk populations can be quickly modeled using the Testing Site Allocation project. By default, 
the risk model helps you identify racial and socioeconomic vulnerability. 

Organizations can select specific demographic variables that align with risk factors you are 
concerned about in your community. The variables will help you create a risk map and allocate 
testing sites to these areas of need. 

You will start by assuming the role of an emergency response GIS analyst. You are asked to 
use the Testing Site Allocation project to create a community risk surface. 

1. Start ArcGIS Pro and open the Testing Site Allocation project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Testing Site Allocation 
task. 

4. In the Task pane, click the Testing Site Allocation task group to expand the collection of 
tasks. 

5. Follow the steps in each task. 

 

Locate the best testing sites 
The best testing sites can be quickly located with the Testing Site Allocation project. Use the 
previously defined risk map, population demand, and a list of candidate sites to locate the best 
testing sites in your community. 

You will start by assuming the role of an emergency response GIS analyst. You are asked to 
use the Testing Site Allocation project to select the best testing sites from a list of candidate 
sites that meet needs defined in the risk map and other population demand. 

1. Start ArcGIS Pro and open the Testing Site Allocation project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Testing Site Allocation 
task. 

4. In the Task pane, click the Testing Site Allocation task group to expand the collection of 
tasks. 

5. Open the Identify candidate sites task and follow the steps provided. 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


 

Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal Page 117 

  Note: 

  The GISCorps COVID-19 Testing Sites feature service is a freely available source of 
nationwide existing testing sites that can be used in this task. 

6. Next, open the Identify best testing sites task and follow the steps provided. 

 

Inventory testing sites 
Laboratory tests can identify the virus that causes COVID-19 in respiratory specimens. As a 
result, health and human services officials are establishing testing sites to track the spread of 
disease and ensure proper treatment and isolation for those infected. 

Coronavirus testing sites can be added to your inventory and shared with the public. The 
Testing Sites Locator app can be used to share status information with the public. 

In this workflow, you'll learn how to add a new coronavirus testing site in your community and 
share this information with the public. 

 

Add a testing site 

You will start by assuming the role of an emergency response mapping technician. You are 
asked to use the Testing Sites Manager to add a new test site that was recently opened in your 
community. 

1. Sign in to your ArcGIS organization, search for Testing Sites Manager, and open the app. 

2. Click Edit Testing Sites and place the location of a testing site on the map. 

  Tip: 

  If you already have a list of testing sites in a spreadsheet, you can use the Load Testing 
Sites widget to load the entire list of testing sites. 

3. Enter details about the testing site: 

  Parameter 
  Value 

  Name of Facility   Type South Stadium Parking Lot 

  Full Address   Type 123 Main Street 

  Phone   Type 555-555-5555 

  Website   Type https://website.com 

  Operational Hours   Type 8am - 5pm 
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  Comments   Type Appointment required 

  Instructions   Type Multiple lines available with drive-through access 

  Status   Select Open 

4. Click Save and click Clear. 

5. Click an existing testing site to update the operational hours, status, and any other 
characteristics, and click Save. 

 

Locate a testing site 

Now, you will assume the role of a resident in the same community. You have coronavirus 
symptoms and want to locate the nearest testing site. 

1. In a browser, go to the Testing Sites Locator app. 

2. Type your address in the search box or click a location directly on the map. 

3. Optionally, adjust the buffer slider to see a larger list of potential testing sites. 

4. Select the closest testing site from the list and review the instructions provided. 

5. Click the Directions tab to view driving directions to the testing site from your defined 
location. 
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Coronavirus Vaccine Distribution Dashboard 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated.  

Mature phase 
Mar. 2023 – Feb. 2025 

Retired phase 
Feb. 2025 

 

Introduction to Coronavirus Vaccine Distribution 
Dashboard 
Coronavirus Vaccine Distribution Dashboard can be used to tabulate, visualize, and monitor key 
vaccine distribution metrics and trends that support a phased coronavirus disease 2019 
(COVID-19) vaccination plan. 

As communities begin to distribute vaccines, maintaining situational awareness is essential. 
Understanding how vaccine distribution and coverage metrics vary among target populations, 
and from one geography to another, helps decision makers develop strategic vaccine 
distribution plans. Coronavirus Vaccine Distribution Dashboard is typically implemented by 
health and human services agencies that want to visualize key vaccine distribution metrics over 
time and use the metrics to inform public education campaigns, make vaccine distribution 
decisions, adapt recommendations made to reach target populations, and ensure a successful 
vaccination program. 

The Coronavirus Vaccine Distribution Dashboard solution delivers a set of capabilities that help 
you to tabulate vaccine distribution metrics, monitor key trends and performance targets for 
defined geographies, and communicate progress to interested stakeholders. 

 

Requirements 
Coronavirus Vaccine Distribution Dashboard requires the following: 

• ArcGIS Online 

• ArcGIS Survey123 Connect 

 

Information products 
Coronavirus Vaccine Distribution Dashboard includes the following information products: 

Item Description Minimum user type 

Vaccine 
Distribution 
Dashboard 

A responsive ArcGIS Experience Builder app used by 
health and human services staff to visualize and 
monitor key vaccine distribution metrics and trends 
that support a phased vaccination plan 

Viewer (required for 
health and human 
services personnel 
only) 
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Vaccine 
Distribution 
Reporter 

An ArcGIS Dashboards app used by health and 
human services staff to tabulate vaccine distribution 
metrics 

Editor 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new Vaccine Distribution Reporter that resolves an issue where the location 
selector fails to load in the new ArcGIS Dashboards app. 

1.0 • First release of Coronavirus Vaccine Distribution Dashboard 
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Configure Coronavirus Vaccine Distribution 
Dashboard 
Learn how to configure the Coronavirus Vaccine Distribution Dashboard solution to meet 
specific needs in your organization. 

 

Load vaccine distribution reporting areas 
The Coronavirus Vaccine Distribution Dashboard solution helps public health agencies visualize 
and share vaccine distribution metrics for a given set of reporting areas. The reporting areas 
can be a county, ZIP Code, state, municipality, or any other geographic area you are using to 
tabulate metrics. Once you identify the specific reporting area or areas you want to use, you can 
use the Vaccine Distribution Reporter to tabulate coronavirus disease 2019 (COVID-19) 
distribution metrics for the specific reporting area. 

The Reporting Areas layer includes several important fields. The Name field stores the names 
of the reporting area and is used in the Reporting Area Category Selector in the Vaccine 
Distribution Reporter app. Use the Aggregate Area field to report distribution metrics by 
differing jurisdictions. For example, a county may want to share distribution metrics tabulated by 
the entire county as well as broken down by ZIP Code or municipality. In that case, the county 
has a value of Yes for the Aggregate Area field. The Points of Distribution (POD) field is used 
to store the number of locations where the vaccine can be accessed per reporting area. This 
metric is shown on the Vaccine Distribution Dashboard. 

Reporting Areas also contains several population fields such as Total population and Healthcare 
workers population. These fields are used in the Vaccine Distribution Reporter app to calculate 
vaccine coverage rates. Populating each population field ensures vaccine coverage rates are 
calculated accurately in the Vaccine Distribution Reporter app and visualized properly in the 
Vaccine Distribution Dashboard. 

To learn about enriching your data with information, for example, demographic data, see About 
Data Enrichment. 

 

Load data from a shapefile or file geodatabase 

To load reporting areas from a shapefile or file geodatabase, complete the following steps: 

1. Create a .zip file of a shapefile or file geodatabase of your reporting areas. 

2. Sign in to your ArcGIS organization and browse to the VaccineDistribution feature layer. 

3. Open the item page and click Update Data > Append Data to layer. 

4. Click Choose File, browse to your .zip file, and click OK. 

5. Click the Contents drop-down arrow and choose the appropriate file type. 

6. Click Upload and Continue. 

7. Click the Choose the layer to update drop-down arrow and choose Reporting Areas. 

8. Uncheck Update existing features. 

9. Click Show field matching to map the fields. 

10. Click Apply Updates. 
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  Tip: 

  To make additional updates to a hosted feature layer, see Append data to layers. 

 

Load vaccine distribution metrics information 
Vaccine Distribution Dashboard can be used by public health agencies and other emergency 
response agencies to visualize and monitor COVID-19 vaccine distribution metrics. The solution 
includes a Vaccine Distribution Reporter app that you can use to enter updated vaccine 
distribution metrics at a regular interval. In some cases, you may find it easier to manage this 
information in a spreadsheet and load it into the solution as you receive new information. 

To load your vaccine distribution information from a spreadsheet, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
VaccineDistributionSource item. 

2. Open the item page and click Download. 

3. Edit the .csv file and provide your vaccine distribution metrics information. 

4. In your ArcGIS organization, browse to the VaccineDistribution feature layer. 

5. Open the item page and click Update Data > Append Data to layer . 

6. Click Choose File, browse to your .csv file, and click OK. 

7. Click Upload and Continue. 

8. Click the Choose the layer to update drop-down arrow and choose Metrics. 

9. Uncheck Update existing features. 

10. Click Apply Updates. 

  Tip: 

  To make additional updates to a hosted feature layer, see Append data to layers. 

 

Extend the Vaccine Distribution Reporter app 
The Vaccine Distribution Dashboard solution includes the Vaccine Distribution Reporter app that 
you can use to tabulate vaccine distribution information. 

Review the preconfigured questions and adjust as necessary to remain in compliance with your 
organizational policies. In addition, ensure that you secure the app and underlying layers and 
only share the content with appropriate members of your organization. 

 

Update feature layer views 

The Coronavirus Vaccine Distribution Dashboard solution includes a series of views created 
from the VaccineDistribution feature layer provided with the solution. Organizations may want to 
modify the Vaccine Distribution Reporter app by first adding new fields to the feature layer and 
then configuring the Vaccine Distribution Form to use the newly created fields. When doing so, 
you must expose the new fields in the appropriate views. Additionally, the 
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VaccineDistribution_current view is created by joining two sources together, and you must re-
create it with the same name and URL after a new field is added. 

Organizations may want to modify the Vaccine Distribution Form by adding new survey 
questions. When adding new questions, begin with the Update feature layer views steps below. 
For changes such as removing questions or formatting the survey, proceed to the Modify 
response surveys section. 

To add one or more fields to a layer and expose the field to feature layer views, complete the 
following steps: 

1. Verify that you are signed in to your ArcGIS organization. 

2. Add a new field to the Reporting Areas or Metrics layer in the VaccineDistribution hosted 
feature layer. 

3. Browse to the VaccineDistribution_public or VaccineDistribution_reporter views in your 
contents. 

4. Open the item page and click the Visualization tab. 

5. Click More Options and click Set View Definition > Define Fields. 

6. Check the check box next to the new field or fields. 

7. Click Apply. 

  The new field is added to the view’s definition. 

To update a join view, complete the following steps: 

1. Browse to the VaccineDistribution_current join view. 

2. Open the item page and scroll to the URL section. Click the Copy button. 

3. Paste the copied URL into Microsoft Notepad or another text editor for reference.  

  Note: 

  The feature layer name will be used below when re-creating the join. You can find the 
name after services in the URL structure. It may also contain a unique GUID—for 
example, VaccineDistribution_current_a45f71a48587425c9b90ee5527cd26d1. 

4. Browse to the existing VaccineDistribution_current join view. 

5. Open the item page and click the Settings tab. 

6. Click the Delete Item button and click Delete. 

7. Browse to the VaccineDistribution feature layer. 

8. Open the item page and click Open in Map Viewer Classic. 

9. Click the Analysis button and click Summarize Data > Join Features. 

10. When populating the Join Features tool, do the following: 

a. Click the Choose target layer drop-down arrow and choose VaccineDistribution. 

b. Click the Choose layer to join to the target layer drop-down arrow and choose 
VaccineDistribution-Metrics. 

c. Click Choose the fields to match as the type of join. 

d. Click the Target field drop down arrow and choose name, and click the Join field 
drop-down arrow and choose name. 

e. Click the Choose join operation drop-down arrow and choose Join one on one. 
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f. Under the Define which record is kept drop-down arrow, click Order by, click the 
Field drop-down arrow and choose Date reported, and click the Sort by drop-
down arrow and choose Newest. 

  Note: 

  Ensure the new join view uses the names defined in the table above. If you use 
the same name, the layers in the map and the existing dashboard elements do 
not have to be reconfigured. If your join view contained a unique GUID, you must 
name the new join view with the unique GUID. 

g. In the Result layer name text box, enter VaccineDistribution_current. 

h. Uncheck Use current map extent, if checked. 

i. Check Create results as hosted feature layer view check box. 

11. Update the Vaccine Distribution Desktop and Mobile Dashboards account for the new 
fields you added to the layers. 

 

Modify response surveys 

To modify the Vaccine Distribution Form survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Vaccine Distribution Form to download the survey. 

4. Click Vaccine Distribution Form again to open the survey. 

5. In the Download window, click Download and click OK. 

6. On the side toolbar, click the Open XLSForm Spreadsheet button. 

7. Revise the survey to reflect your needs. 

8. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

9. In ArcGIS Survey123 Connect, click Publish on the side tool to publish your changes. 

 

Configure vaccination goals 
The Vaccine Distribution Dashboard vaccination coverage charts contain preconfigured goals to 
visualize progress toward vaccination goals. Organizations may want to modify the goals to 
better reflect their community’s vaccination goals. 

To modify the vaccination goal, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Vaccine 
Distribution Desktop Dashboard or Vaccine Distribution Mobile Dashboard item. 

  The following steps can be used to configure vaccination goals in both the desktop and 
mobile dashboards. 

2. Open the item page and click Edit Dashboard. 

3. Hover over the upper left corner of the Vaccine Coverage by Total Population serial 
chart element and click Configure. 

4. Click the Guides tab. 
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  The chart contains a preconfigured goal of 67%. 

5. Using a decimal value, change the Value to your community’s vaccination goal. For 
example, a goal of 70% would be .7. 

6. Change the Label to reflect the updated goal and click Done. 

7. Repeat steps 3 through 6 to modify the goal for the Full Series Coverage Priority 
Population, Full Series Coverage Age, Full Series Coverage Race & Ethnicity, and Full 
Series Coverage Gender serial chart elements. 

8. Click the Save button to save the dashboard. 

 

Add vaccination coverage categories 
The Vaccine Distribution Dashboard solution helps public health agencies and interested 
stakeholders visualize full series vaccination coverage by priority population, age, race & 
ethnicity, and gender. Agencies may want to modify or extend the values within those 
categories. For example, data may be reported using different age ranges than those 
preconfigured. The VaccineDistribution hosted feature layer contains several custom fields that 
provide configuration flexibility. 

The Reporting Areas layer contains two Custom priority population fields, Custom gender 
population, Custom age range population, and Custom race population fields. The Metrics layer 
contains two associated Custom priority population fields, Custom gender population, Custom 
age range population, and Custom race population fields. Additionally, the Metrics layer 
contains two Custom priority vaccinated coverage fields, Custom gender vaccination coverage, 
Custom age range vaccination coverage, and Custom race vaccination coverage fields that can 
be used to store coverage rates for additional categories. 

To utilize a custom field, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
VaccineDistribution hosted feature layer. 

2. Open the item page and click the Data tab. If necessary, choose Reporting Areas from 
the Layer drop-down arrow. 

3. Click the Fields button. 

4. Locate and click the Custom priority population field. 

  In the following steps, the priority1pop and associated fields are used as an example. The 
same process can be followed to use any of the included custom fields. 

5. Click Edit to replace Custom priority population’s alias with an alias of your choosing. For 
example, First Responder population. 

6. Click Save. 

7. Click the Layer drop-down arrow and choose Metrics. 

  Locate the associated fields, in this case, priority1 and priority1coverage. 

8. Click each field and modify the alias. For example, priority1 would be First Responders 
vaccinated and priority1coverage would be First Responders (this alias will be used below 
in the Vaccine Distribution Dashboard serial chart). 

  In this example, be sure to populate the priority1pop field in the Reporting Areas layer. 
These fields are used in the Vaccine Distribution Reporter app to calculate vaccine 
coverage rates. Populating each population field ensures vaccine coverage rates are 
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calculated accurately in the Vaccine Distribution Reporter app and visualized properly in 
the Vaccine Distribution Dashboard. 

9. Repeat steps 5 and 6 for each set of custom fields you want to use in the Vaccine 
Distribution Dashboard. 

To modify the Vaccine Distribution Reporter app to use the custom fields configured above, 
complete the following steps: 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Vaccine Distribution Form to open the survey. 

3. On the side toolbar, click Open XLSForm Spreadsheet. 

4. In the name column, locate the priority1 field. In the type column, click the drop-down arrow 
to change the type from hidden to integer. 

5. Update the label to use the field alias defined in the section above. 

6. Repeat step 5 for each custom field you want to use in the Vaccine Distribution Dashboard. 

7. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

8. In ArcGIS Survey123 Connect, click Publish on the side toolbar to publish your changes. 

To modify the Vaccine Distribution Dashboard to use the custom fields configured above, 
complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Vaccine 
Distribution Desktop Dashboard or Vaccine Distribution Mobile item. 

  The following steps can be used to configure both the Desktop and Mobile dashboards. 

2. Open the item page and click Edit Dashboard. 

3. Hover over the upper left corner of the Full Series Coverage by Priority Population 
serial chart element and click the Configure button. 

4. If necessary, click the Data tab. 

5. Click the +Series button, and click the Series 6 Field drop-down arrow and choose the 
First Responders decimal field configured above. 

6. Click the Series tab. Modify the newly created series to match the existing series and 
according to your needs. 

7. Click Done. 

8. Repeat steps 3 through 7 for additional custom fields configured above to use them in the 
Full Series Coverage by Priority Population, Full Series Coverage by Age, Full Series 
Coverage by Race & Ethnicity, and Full Series Coverage by Gender serial charts. 

9. Click the Save button to save the dashboard. 
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Use Coronavirus Vaccine Distribution 
Dashboard 
The Coronavirus Vaccine Distribution Dashboard solution delivers a set of capabilities that help 
you to tabulate vaccine distribution metrics, monitor key trends and performance targets for 
defined geographies, and communicate progress to interested stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Tabulate vaccine distribution metrics 
The Coronavirus Vaccine Distribution Dashboard solution helps health and human services 
agencies visualize key vaccine distribution metrics over time. The dashboard displays the most 
recent reported totals of doses obtained and administered to the public. It also displays the 
coverage, or percentage of the population that has been vaccinated, broken down by priority 
populations, age, race, and gender over time. 

You will start by assuming the role of an employee in a health and human services agency who 
has been tasked with reporting the latest vaccine distribution metrics each week. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Vaccine Distribution Dashboard solution. 

2. View the Vaccine Distribution Reporter app. 

3. Click the Reporting Area drop-down menu in the upper right and choose the appropriate 
reporting area. 

  Reporting areas can be a county, public health region, ZIP Code, state, municipality, or any 
other geographic area you are using to tabulate results. 

4. Provide the cumulative total of vaccine doses that have been obtained and administered to 
the public. 

5. Provide the total number of people who have received a partial and full series vaccination. 

  As some vaccines require multiple doses, a partial series vaccination would include people 
who have, for example, received the first dose of a two-dose series. 

6. If available, provide the total number of people who have received a full series vaccination 
by priority populations, gender, age range, and race and ethnicity. 

  The coverage or percent of the population that has been vaccinated will be calculated for 
you if you updated the corresponding population field in the Reporting Areas layer. See 
Configure Coronavirus Vaccine Distribution Dashboard for more information on populating 
your reporting areas. 

7. Click Submit. 

8. Repeat this process for each additional reporting area. 
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Monitor vaccine distribution performance 
Now, you will assume the role of a public health officer or executive in the same government 
agency. You are asked to monitor the current status of vaccine distribution in the community 
and are looking to see how the vaccine is being distributed across demographic segments of 
the population. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Vaccine Distribution Dashboard solution. 

2. View the Vaccine Distribution Dashboard app. 

  The dashboard displays the most recent count of doses obtained and administered and 
partial and full series vaccination coverage for the selected reporting area. It also contains 
several time series charts that display vaccination coverage over time for different 
demographic segments. 

3. In the filter on the top of the dashboard, click another reporting area to view the vaccine 
distribution metrics for a different geography. 

4. Click the Learn More tab in the Map panel to read the descriptions of the different metrics, 
how they are calculated, and to view when the metrics were last updated. 

5. Click the Priority Population, Age, Race & Ethnicity, and Gender tabs to view full series 
vaccination coverage over time for each demographic segment. 
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Coronavirus Vaccine Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. The capabilities have been replaced with Immunization Outreach. 

 

Mature phase 
Mar. 2023 – Feb. 2025 

Retired phase 
Mar. 2025 

 

Introduction to Coronavirus Vaccine Outreach 
Coronavirus Vaccine Outreach can be used to communicate vaccination plans, increase public 
confidence in coronavirus disease 2019 (COVID-19) vaccinations, and ensure the public knows 
when, and where, they can be vaccinated. 

Public opinion is mixed on the safety and efficacy of any vaccine, and misinformation has a 
direct impact on vaccine coverage. Achieving high vaccination rates requires a robust and 
transparent public education campaign that provides accurate vaccine information, progress on 
the distribution plan, and guidance needed to access a vaccination. A key aspect of any 
campaign is a web destination that helps the public access this important information, ask 
questions, and request assistance. Coronavirus Vaccine Outreach is typically implemented by 
health and human services agencies that want to take a transparent and equitable approach, 
clearly communicate vaccination plans, and increase public confidence. 

The Coronavirus Vaccine Outreach solution delivers a set of capabilities that help you to launch 
a vaccine distribution web destination, provide the public critical information that helps them 
understand when, and where, they can be vaccinated, and engage medical volunteers that may 
be needed to support widespread administration of the vaccine. 

Requirements 
Coronavirus Vaccine Outreach requires the following: 

• ArcGIS Online 

• ArcGIS Survey123 Connect 

Information products 
Coronavirus Vaccine Outreach includes the following information products: 

Item Description 
Minimum 
user type 

Coronavirus 
Vaccine 
Distribution 

An ArcGIS Hub site used by public health agencies to 
communicate vaccination plans, increase public confidence in 
COVID-19 vaccinations, and ensure the public knows when, 
and where, they can be vaccinated. 

Not 
required 

Vaccine 
Eligibility Survey 

An ArcGIS Survey123 form used by the public to determine 
whether they are eligible for the vaccine. 

Not 
required 
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Vaccine Locator A Nearby app used by the public to locate vaccine providers 
and points of distribution. 

Not 
required 

Vaccine Provider 
Wait Times 

An ArcGIS Web AppBuilder app used by participating 
providers to report wait times. 

Editor 

My Vaccine 
Experience 

An ArcGIS Survey123 form used by the public to share their 
experiences with the vaccine and promote this experience in 
the I Got Vaccinated app. 

Not 
required 

I Got Vaccinated An Attachment Viewer app used by the public to review 
individual experiences with the vaccine. 

Not 
required 

Vaccine 
Distribution 
Volunteers 

An ArcGIS Survey123 form used by the public to volunteer to 
help with COVID-19 vaccine distribution. 

Not 
required 

Vaccine 
Outreach 
Manager 

A Crowdsource Manager app used by health and human 
services staff to manage volunteers, I Got Vaccinated 
contributions, and vaccine points of distribution. 

Editor 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Coronavirus Vaccine Outreach 
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Configure Coronavirus Vaccine Outreach 
Learn how to configure the Coronavirus Vaccine Outreach solution to meet specific needs in 
your organization and load your data if needed. 

 

Load data 
Coronavirus Vaccine Outreach can be used by health agencies to share vaccine provider 
locations, details, and wait times at mass vaccination sites if collected. 

To load your vaccine provider locations into the VaccineProviders layer from a spreadsheet, 
complete the following steps: 

1. Sign in to your ArcGIS organization. 

  Note: 

  If you have an existing spreadsheet of provider locations you can skip to step 6. 

2. Browse to the VaccineProviderLocations CSV item. 

3. Open the item page and click Download. 

4. Once downloaded, open the VaccineProviderLocations.csv file and enter your vaccine 
location information. 

  Caution: 

  Do not change the field names or file name. 

5. Save and close the file. 

6. In your ArcGIS organization, browse to the VaccineProviders hosted feature layer. 

7. Open the item page and click  Update Data > Append Data to Layer. 

8. Click Choose File, browse to your spreadsheet, and click OK. 

9. Click Upload and Continue. 

10. Uncheck Update existing features. 

11. Click Show field matching. 

  Confirm all fields listed in the Fields column have a corresponding field listed in the Match 
Field column. If no fields are listed in the Match Field column, click the drop-down arrow for 
that field, and choose the field name from the spreadsheet that reflects the value shown in 
the Fields column. 

12. Match the Latitude field to the y match field and the Longitude field to the x match field. 

13. Click Apply Updates. 

 

Populate operational hours 
This solution leverages the Opening Hours Specification to display operating hours for a place 
or service. When you populate the data fully, Arcade expressions interpret the data and display 
the operating hours in a human-readable format in the map pop-up. Understanding the data 
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specification and options in the Arcade expressions will help you populate your data and display 
it in the maps and apps provided with the ArcGIS Solution. 

 

Operating Hours Specification 

The Operating Hours Specification allows you to store a combination of operating hours in a 
single field but relies on a series of data standards to render the information correctly. To ensure 
operating hours are displayed correctly, follow the standards below: 

• Enter all times using a 24-hour clock without a leading 0—for example, Tu (7:00-19:00). 

• Use a two-letter abbreviation for each day, with the first letter capitalized—for example, Mo, 
Tu, We, Th, Fr, Sa, Su. 

• When a location is open 24 hours a day, use 24 Hours—for example, Mo (24 Hours). 

• When a location is closed on a specific day, use Closed—for example, Sa-Sun (Closed). 

• Enclose all times and closed statuses in parentheses—for example, Tu (7:00-19:00); We-
Mo (Closed). 

• Separate days and ranges with a semicolon to denote the two (or more) groups—for 
example, Th-Fr (7:00-19:00); Sa (24 Hours). 

Using the standards above, a diverse set of operating hours can be populated for your places 
and services. Some common examples include the following: 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. seven days a week, populate the 
operating hours field with the following: Mo-Su (9:00-17:00). 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. during the week and closed on 
weekends, populate the operating hours field with the following: Mo-Fr (9:00-17:00); Sa-Su 
(Closed). 

• To specify the place is open one day (Tuesday) a week, populate the operating hours field 
with the following: Tu (7:00-19:00); We-Mo (Closed). 

• To specify the place has operating hours that vary by day, populate the operating hours 
field with the following: Mo-Tu (9:00-17:00); We (Closed); Th-Fr (7:00-19:00); Sa (24 
Hours); Su (Closed). 

Operating hours data can be populated all at once for many places and services using Calculate 
field values or uniquely entered for each place or service using an application provided with the 
solution. 

 

Arcade expressions 

The Arcade expressions include several settings that allow you configure the look and feel of 
the operating hours when they are displayed in the web map pop-up. The expressions work with 
the operating hours data and web map pop-up configurations to display current operating hours 
in your map and app. 

This solution uses three Arcade expressions: Hours, Days, and Open/Closed. To modify one of 
these expressions, complete the following steps: 

1.  Verify that you are signed in to your ArcGIS organization and browse to the Vaccine 
Locator map. 

2. Open the item page and click Open in Map Viewer Classic. 

3. Click More Options and click Configure Pop-up on the vaccine provider layer. 
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4. Under Attribute Expressions, double-click the Arcade expression you want to modify. 

  Each Arcade expression has a set of variables that can be configured according to your 
organization’s needs. Review the expression notes and modify the variables as needed. 
Do not change anything else in the expressions. 

5. Click OK. 

Configure Vaccine Locator 
The Vaccine Locator app can be used by the public to locate vaccine providers and points of 
distribution. This app has some common configuration options you may want to extend. The app 
can be extended to allow to directions from your current location or change the appearance of 
operating hours or current wait times. 

Configure directions and legend 

Vaccine Locator can be configured to provide directions to the nearest vaccine location. To 
configure the locator app, complete the following steps: 

1. Verify that you are signed in to your ArcGIS Online organization, and browse to the 
Vaccine Locator app. 

2. From the item page, click Configure. 

  Close the Welcome to the App Setup Page splash page, if necessary. 

3. Click Nearby > Options and turn on the Show directions toggle button. 

4. Check the box next to the Vaccine Providers layer. 

5. Click About and turn on the Legend and Open legend when app loads toggle buttons. 

6. Click Publish. 

7. Click Confirm. 

  The Authorize premium content window appears with information related to 
authorization. 

8. Click Authorize. 

9. Click Launch. 

Symbolize wait times 

Staff can use the Vaccine Provider Wait Times at mass vaccination sites to report current wait 
times. By default, wait times will be displayed in the pop-up for each vaccine provider. You may 
want also want the vaccine locator map to reflect current wait times so users can quickly refer to 
it when making a decision which site to visit. Before updating the symbology on the map, ensure 
the vaccine provider Current Wait Times field has been populated. 

To configure the symbology on the Vaccine Locator map, complete the following steps: 

1. Verify that you are signed in to your ArcGIS Online organization, and browse to the 
Vaccine Locator map. 

2. Open the item page and click Open in Map Viewer Classic. 

3. Click the Content tab. 

4. Hover over the Vaccine Providers layer and click Change Style. 

5. Click the Choose an attribute to show drop-down arrow and choose New Expression at 
the bottom of the drop-down menu. 

6. Click Edit at the top of the window and change the name from Custom to Wait Times and 
click Save. 
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7. Copy the following code and paste it in the Expression editor window: 

  var waittext; 
var wait = $feature.waittime; 
if (wait == null) 
 {waittext = "No wait times reported";} 
else if (wait <=19)  
 {waittext = "Less than 20 minutes";}  
else if (wait <=40)  
 {waittext = "Between 20 and 40 minutes";} 
else if (wait <=60) 
 {waittext = "Between 40 minutes and 1 hour";} 
else {waittext = "Longer than 1 hour";} 
return waittext 

8. Click OK. 

9. Optionally, change the symbology based on the wait times you see. 

10. Click Done. 

11. Click Save. 

The new symbols in the Vaccine Locator map will automatically appear based on the wait time. 
Optionally, you can label current wait times for each feature. 

Modify surveys 
The Coronavirus Vaccine Outreach solution includes a series of surveys that can be used to 
share vaccine eligibility guidelines, capture vaccination experiences, and enlist volunteers. 
However, organizations may want to alter these surveys to align with their vaccine distribution 
program. Review the preconfigured questions in each survey and align with your program as 
necessary. 

To configure the Coronavirus Vaccine Outreach surveys, complete the following steps: 

Configure Vaccine Eligibility Survey and My Vaccine Experience 

Modify the Vaccine Locator hyperlink in the Vaccine Eligibility Survey and the I Got Vaccinated 
hyperlink in the My Vaccine Experience survey to reference apps deployed with the Coronavirus 
Vaccine Outreach solution. Follow the steps below to update as plans develop and availability 
expands. 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS Online organization. 

3. Click Vaccine Eligibility Survey or My Vaccine Experience to download the survey. 

4. In the Download window, click Download and click OK. 

5. Click Vaccine Eligibility Survey or My Vaccine Experience again to open the survey. 

6. On the side toolbar, click the Open XLSForm spreadsheet button. 

7. In the Microsoft Excel spreadsheet, click the survey tab. 

8. For Vaccine Eligibility Survey, in the label column, in the eligibility note question, replace 
the # in the href tag <a href="#"> with the Vaccine Locator app URL. 

9. For My Vaccine Experience, in the hint column, in the sharestoryq question, enter the I Got 
Vaccinated app URL between the quotation marks in the href tag <a href="">. 
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10. Click the Settings tab, in the submission_url column, enter the VaccineEligibility_public or 
VaccineExperienceSurvey_survey hosted feature layer item URL to the corresponding 
survey. 

  Note: 

  To create this URL, concatenate the Item ID with the portal Content Root. The Item ID 
can be found at the end of the URL immediately following ?id=. For an ArcGIS Online 
item, the URL looks like the following: 
https://www.arcgis.com/sharing/rest/content/items/21a6c530b31a4523bdff7gg94c9c5d9a
. 

11. Save and close the Microsoft Excel spreadsheet. 

12. In ArcGIS Survey123 Connect, click Publish on the side toolbar to publish your changes. 

Add fields 

The Coronavirus Vaccine Outreach solution includes a series of views created from the 
VaccineDistributionVolunteers, VaccineEligibility, and VaccineExperienceSurvey feature layers 
provided with the solution. Organizations may want to modify the Vaccine Eligibility Survey, 
Vaccine Distribution Volunteers, and My Vaccine Experience apps by first adding new fields to 
the feature layer and then configuring the surveys to use the newly created fields. When doing 
so, you must expose the new fields in the appropriate views. 

To add one or more fields to a layer and expose the field to feature layer views, complete the 
following steps: 

1. Verify that you are signed in to your ArcGIS Online organization. 

2. Add a new field to any of the following feature layers: VaccineDistributionVolunteers, 
VaccineEligibility, or VaccineExperienceSurvey  

3. Browse to one of the feature layer views: VaccineDistributionVolunteers_public, 
VaccineEligibility_public, or VaccineExperienceSurvey_public. 

4. Open the item page and click the Visualization tab. 

5. Click More Options and click Set View Definition > Define Fields. 

6. Check the check box next to the new field or fields. 

7. Click Apply. 

  The new field is added to the view’s definition. 

Modify surveys 

To modify a Coronavirus Vaccine Outreach survey, complete the following steps: 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS Online organization. 

2. Click a survey and if prompted, download the survey. 

  Note: 

  If you have not downloaded the chosen survey, you will be prompted to click Download 
in the Download window, then click OK. You will also need to click the survey again to 
open it. 

3. On the side toolbar, click the Open XLSForm spreadsheet button. 
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4. Edit the survey to reflect your needs. 

5. Click the settings tab, and in the submission_url column, enter a hosted feature layer item 
URL. 

  Note: 

  To create this URL, concatenate the Item ID with the portal Content Root. The Item ID 
can be found at the end of the URL immediately following ?id=. For an ArcGIS Online 
item, the URL looks like the following: 
https://www.arcgis.com/sharing/rest/content/items/21a6c530b31a4523bdff7gg94c9c5d9a
. 

6. Save and close the Microsoft Excel spreadsheet. 

7. In ArcGIS Survey123 Connect, click Publish on the side toolbar to publish your changes. 

Configure the Coronavirus Vaccine Distribution site 
The Coronavirus Vaccine Distribution solution includes the Coronavirus Vaccine Distribution 
ArcGIS Hub site. This site can be configured with your organization's branding and used to 
share vaccine distribution information with the public. 

Update with organizational information 

After deploying the Coronavirus Vaccine Distribution solution, the Coronavirus Vaccine 
Distribution site layout only requires a few updates to fit your local context. 

To update the site with your organizational information, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Coronavirus 
Vaccine Distribution site. 

2. From the item page, click Configure. 

3. Scroll to any sections that you want to update, hover over the card, and click the edit pencil 

 that appears in the horizontal toolbar, and then edit the content with information 
specific to your organization.  

4.  In the side panel, click Footer. 

  A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

5. Click the HTML text box. 

  The HTML window appears. 

6. Make the necessary changes and click Apply. 

7. Click Save. 

8. Click the Save drop-down arrow and click Publish Draft. 

Add the Coronavirus Vaccine Distribution Dashboard app 

The Coronavirus Vaccine Distribution site includes a section that can be used to share key 
vaccine distribution metrics by linking to an existing dashboard if you have one. You can share a 
link to an existing dashboard or, if you do not have an existing dashboard, you can deploy the 
Coronavirus Vaccine Distribution Dashboard solution and use this solution to communicate 
vaccine distribution metrics and progress made. 

To share vaccine distribution metrics, complete the following steps: 
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1. Verify that you are signed in to your ArcGIS organization and browse to the Coronavirus 
Vaccine Distribution site. 

2. From the item page, click Configure. 

3. Scroll to the How Are We Doing? section, hover over the application card, and click the 

edit pencil .  

4. In the side panel, click Select Application. 

5. Browse to your dashboard, select it, and click Save. 

  Tip: 

  The Coronavirus Vaccine Distribution Dashboard solution includes desktop and mobile 
versions of a dashboard that can be used to share vaccine distribution metrics. To 
deploy this solution, go to Coronavirus Vaccine Distribution Dashboard and click Deploy 
the solution. 

6. Click the Save drop-down arrow and click Publish Draft. 

Share items with the public 

Several layer views, maps, and apps included in the Coronavirus Vaccine Outreach solution 
must be shared with everyone so they can be accessed by the public on the Coronavirus 
Vaccine Distribution site. The solution includes several feature layer views to prevent sensitive 
or incorrect data from being shared accidentally. 

To share items with the public, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Coronavirus 
Vaccine Outreach folder. 

2. Next to each of the following items, check the check box: 

  Name 
  Item type 

  Vaccine Locator   Web Map 

  VaccineProviders_public   Feature layer (hosted, view) 

  Vaccine Eligibility Survey   Form 

  VaccineEligibility_public   Feature layer (hosted) 

  My Vaccine Experience   Form 

  VaccinationExperienceSurvey_survey   Feature layer (hosted) 

  I Got Vaccinated   Web Mapping Application 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://doc.arcgis.com/en/arcgis-solutions/latest/reference/introduction-to-coronavirus-vaccine-distribution-dashboard.htm


 

Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal Page 138 

  I Got Vaccinated   Web Map 

  VaccinationExperienceSurvey_public   Feature layer (hosted, view) 

  Vaccine Distribution Volunteers   Form 

  VaccineDistributionVolunteers_public   Feature layer (hosted) 

  Coronavirus Vaccine Distribution   Hub Site Application 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 
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Use Coronavirus Vaccine Outreach 
The Coronavirus Vaccine Outreach solution delivers a set of capabilities that help you to launch 
a vaccine distribution web destination, provide the public critical information that helps them 
understand when, and where, they can be vaccinated, and engage medical volunteers that may 
be needed to support widespread administration of the vaccine. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

Review vaccine plans and progress 
Achieving high vaccination rates requires a robust and transparent public education campaign 
that provides accurate vaccine information, progress on the distribution plan, and guidance 
needed to access a vaccination. A key aspect of any campaign is a web destination that helps 
the public access this important information, ask questions, and request assistance. 

In this workflow, you will assume the role of a resident or member of the public. You are 
interested in the vaccine distribution plan adopted by your community and progress made 
vaccinating the public. 

1. In a browser, from the Coronavirus Vaccine Outreach solution, view the Coronavirus 
Vaccine Distribution site. 

  The site describes your community's vaccine distribution plan and provides information to 
assure the public that each COVID-19 vaccine is safe. 

2. Review the information on the site. 

3. Scroll to the Vaccine Safety Is a Top Priority section, and then click Learn more to 
access additional vaccine safety information. 

  This information is provided to build confidence in the vaccine approval process. 

4. Review key vaccine performance metrics, if provided. 

Explore vaccination stories 

The coronavirus vaccine is the best way to protect yourself and your loved ones from getting 
sick with coronavirus disease 2019 (COVID-19). Some people may be concerned about getting 
vaccinated for a variety of reasons, and seeing individual stories from people that received the 
COVID-19 vaccine may encourage widespread adoption of the vaccine. The I Got Vaccinated 
app is used to review individual experiences with the vaccine. 

1. Scroll to the We Are in This Together section and review the I Got Vaccinated story. 

2. Click Learn more. 

  The I Got Vaccinated app opens to an overview that describes the app's purpose. 

3. Click Explore COVID-19 Vaccination Stories. 

  The I Got Vaccinated app includes a collection of stories shared by individuals who have 
received the COVID-19 vaccine. 

4. On the left, click a picture to view a story shared by a community member. 
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Determine vaccine eligibility 
Initial doses of the vaccine are limited and used to protect priority populations. As doses 
become more available, additional members of the population will be eligible for the vaccine. 
The Vaccine Eligibility Survey form is used to determine if you are eligible for a COVID-19 
vaccination today. 

1. In a browser, from the Coronavirus Vaccine Outreach solution, view the Coronavirus 
Vaccine Distribution site. 

2. Scroll to the We Are in This Together section and review the Am I Eligible story. 

3. Click Learn more. 

  The Vaccine Eligibility Survey form opens. 

4.  Complete the survey to determine if you are currently eligible for the vaccine. 

5. If you are eligible, click the hyperlink to open the Vaccine Locator app and find a vaccine 
provider. 

6. If you are not eligible for a vaccine, complete the rest of the survey and provide an email 
address where you can be notified when the vaccine becomes more widely available. 

7. Click Submit. 

Locate COVID-19 vaccine availability 
A growing network of established health care providers can administer the vaccine when 
supplies increase and you are ready to be vaccinated. The Vaccine Locator app is used to 
locate vaccine providers and points of distribution. 

1. In a browser, from the Coronavirus Vaccine Outreach solution, view the Coronavirus 
Vaccine Distribution site. 

2. Scroll to the Ready to be Vaccinated section and review the Locate Vaccine Providers 
story. 

3. Click Locate provider. 

  The Vaccine Locator app opens and shows every vaccine provider in the community. 

4. Search for an address or place or click the map to set your location. 

  The results highlight vaccine providers near the location you entered and within your 
search distance. 

5. In the left panel, click a result. 

  Additional details about the provider appear along with a date that highlights when provider 
information was last updated. 

  Note: 

  If you do not see any results, search for a new location or drag the slider to increase the 
search distance. 

Share your vaccination experience 
Understanding public perception with the COVID-19 vaccine helps shape public education 
campaigns and leverage individual experiences to build public confidence. The My Vaccine 
Experience form is used to collect experiences with the vaccine and promote these experiences 
in the I Got Vaccinated app. 
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1. In a browser, from the Coronavirus Vaccine Outreach solution, view the Coronavirus 
Vaccine Distribution site. 

2. Scroll to the Share Your Experience section. 

3. Click Share your experience. 

4.  Complete the survey, and then click Submit. 

  Note: 

  After your submitted survey is reviewed by health and human services staff, your 
experience will be shared in the I Got Vaccinated app. 

Volunteer to help 
As an engaged resident in the community, you want volunteer to help with widespread 
distribution of the COVID-19 vaccine. You will complete the Vaccine Distribution Volunteers 
form to provide your experience, skills, and availability so that you can connect with COVID-19 
vaccine distribution volunteer opportunities in your community. 

1. In a browser, from the Coronavirus Vaccine Outreach solution, view the Coronavirus 
Vaccine Distribution site. 

2. Scroll to the Volunteer to Help section. 

3. Click Volunteer now. 

4. Complete the Vaccine Distribution Volunteers form, and then click Submit. 

Manage outreach activities 
The information shared with the public on the Coronavirus Vaccine Outreach site is dynamic 
and will change as you carry out your vaccine distribution plans. Ensuring that the information is 
current and accurate builds public confidence and may increase vaccine uptake. 

In this workflow, you are a staff member in the health and human services agency. You have 
been asked to manage the feedback you are getting on the Coronavirus Vaccine Outreach site 
and ensure content presented in the Coronavirus Vaccine Outreach apps is current. 

Approve vaccination stories 

In this workflow, you will assume the role of a health and human services employee responsible 
for reviewing vaccination experience stories. As the public shares their experiences with the 
vaccine, you will review their contributions to the I Got Vaccinated app before promoting the 
stories more broadly. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Vaccine Outreach solution. 

2. View the Vaccine Outreach Manager app. 

3. In the left panel, click I Got Vaccinated Contributions to open the map. 

  Contributions are listed in the table at the top. 

4. Select a contribution in the table or map. 

  Contribution details open at the lower left. 

5. On the Info tab, review the details. 

6. Click the Edit record button . 
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7. Click the Status drop-down arrow and choose a status. 

8. Click Save. 

Contact volunteers 

As volunteers offer to help with widespread distribution of the vaccine, health and human 
services staff must contact the volunteers to ensure they have the skills required to help with 
vaccine distribution. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Vaccine Outreach solution. 

2. View the Vaccine Outreach Manager app. 

3. In the left panel, click Vaccine Distribution Volunteers to open the map. 

  Volunteers are listed in the table at the top. 

4. Select a volunteer in the table or map. 

  Volunteer details open at the lower left. 

5. Review the details that the volunteer provided on the volunteer form. 

6. Click the Edit record button . 

7. Click the Status drop-down arrow and choose a status. 

8. Optionally, for Internal Comments, add comments to the volunteer registration form. 

9. Click Save. 

10. At the bottom of the details, click Send Volunteer Email.  

  Your email client opens to an email addressed to the specific volunteer. You can format the 
email message and attach any additional information that you want to share with the 
volunteer. 

Update vaccine providers 

The need to vaccinate large quantities of people will cause providers to alter the hours and flex 
services that are provided to meet community needs. Sharing current provider and point of 
distribution information builds public trust and mitigates frustration for those that choose to be 
vaccinated. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Vaccine Outreach solution. 

2. View the Vaccine Outreach Manager app. 

3. In the left panel, click Vaccine Points of Distribution to open the map. 

  Points of distribution are listed in the table at the top. 

4. Select a vaccine provider or point of distribution in the table or map. 

  Points of distribution details open at the lower left. 

5. Review current provider information. 

6. Click the Edit record button . 

7. Update the Operational Hours or Notes parameters to reflect the most current information 
that will show in the Vaccine Locator app. 

8. Click Save. 

9. Optionally, at the bottom of the details, click Share Wait Time App. 
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  Your email client opens with a formatted email message address to the point of contact at 
the vaccine provider or point of distribution. 

10. Review the formatted email and send it to your email address. 

Examine vaccine experience surveys 

Responses to the vaccine experience survey and overall sentiment from a collection of 
responses inform public education and vaccine distribution plans. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Coronavirus 
Vaccine Outreach solution. 

2. Open the My Vaccine Experience form item page. 

3. Click Open in Survey123 and choose Manage in Survey123 website. 

4. At the upper right, click the Analyze tab. 

5. Scroll to examine the various survey questions. 

  Note: 

  The results are represented differently depending on the data collected in the survey. 

6. At the upper left, click Filter. 

7.  Scroll through the charts that visualize the questions and their answers. 

8. At the upper right, click the Data tab. 

9. Select a record in the table. 

  A panel appears with the survey questions and answers. 

  Tip: 

  If necessary, export the data or create a report. 

Collect vaccination wait times 
As vaccine supplies increase and efforts are made to increase the number of people who are 
vaccinated, health and human services agencies may choose to set up drive-through or 
curbside vaccination clinics. These clinics are designed to handle large volumes of people and 
quickly vaccinate members of public. Demand for vaccination may cause large crowds to 
gather, and communicating wait times to the public will mitigate frustration for those who choose 
to be vaccinated at the clinic. As you collect wait times at a point of distribution, they can be 
shared with the public in the Vaccine Locator app. 

In this workflow, you are a staff member in the health and human services agency or a volunteer 
assigned to a vaccine clinic. You have been tasked with reporting wait times at a regular interval 
throughout the day. 

1. Open the email that you sent to yourself previously. 

2. Click the hyperlink to open the Vaccine Provider Wait Times app and sign in to your 
ArcGIS organization, if necessary. 

  The app zooms to your vaccine clinic or point of distribution. 

3. Select the clinic or point of distribution on the map. 

4. In the Record Wait Time panel, for Current Wait Time, type the appropriate value. 
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5. Click Save. 

  The wait time that you entered is displayed in the Vaccine Locator app when a member of 
the public selects the clinic or point of distribution. 

6. Repeat these steps at regular intervals. 
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Coronavirus Wellness Checks 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. The capabilities have been replaced with Immunization Outreach. 

Mature phase 
Apr. 2022 – Mar. 2024 

Retired phase 
Apr. 2024 

 

Introduction to Coronavirus Wellness Checks 
Coronavirus Wellness Checks can be used to check on the wellness of vulnerable individuals 
with an organized set of volunteers from their community. 

Physical distancing recommendations are meant to protect everyone from COVID-19, especially 
older adults. But the resulting isolation can have devastating health effects on homebound 
individuals. Historically, wellness checks were used to deliver meals, but many agencies are 
leveraging wellness checks during the pandemic to provide personal assistance to homebound 
individuals. Having an effective way to engage volunteers and extend the health and human 
services workforce during this time of need is critical. Using location to assign volunteers to 
homebound individuals builds a sense of community and improves the efficiency of your 
wellness program. Coronavirus Wellness Checks is typically implemented by health and human 
services agencies that want to leverage community volunteers to ensure homebound, or 
vulnerable individuals, are in good health. 

The Coronavirus Wellness Checks solution delivers a set of capabilities that help you register 
homebound individuals, organize community volunteers, assign those volunteers to wellness 
checks, and monitor the wellness check program. 

 

Requirements 
Coronavirus Wellness Checks requires the following: 

• ArcGIS Online 

• ArcGIS Hub Premium 

 

Information products 
Coronavirus Wellness Checks includes the following information products: 

Item Description 
Minimum 
user type 

Wellness Check 
Volunteers 

An ArcGIS Survey123 survey form used by the general 
public to volunteer for the wellness check program 

Community 
account 

Wellness Check 
Registry 

An ArcGIS Survey123 form used by homebound 
individuals to enroll in the wellness check program 

Not required 
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Wellness Check 
Volunteer Manager 

An Crowdsource Manager app used by emergency 
response and public health staff to manage volunteers 
and wellness check requests by homebound individuals 

Editor 

Wellness Check and 
Volunteer 
Assignments 

An ArcGIS Workforce Classic project used by 
emergency response and public health staff to assign 
volunteers to homebound individuals 

Editor 

Wellness Check 
Report 

An ArcGIS Survey123 form used by volunteers to report 
the overall well-being of homebound individuals 

Community 
account 

Wellness Check 
Dashboard 

An ArcGIS Dashboards app used by emergency 
response and public health staff to monitor the wellness 
check program and outcomes from wellness checks 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Coronavirus Wellness Checks 
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Configure Coronavirus Wellness Checks 
Coronavirus Wellness Checks solution can be deployed in your ArcGIS Online organization. 
After deploying the solution to your ArcGIS Online organization, configure it to meet specific 
needs in your organization and load your data if needed. 

 

Promote the coronavirus wellness program 
The Coronavirus Recovery ArcGIS Hub initiative can be used to promote coronavirus recovery 
programs developed for your community. The initiative template includes a responsive and 
accessible website that can be enhanced with several coronavirus solutions (for example, 
Coronavirus Wellness Checks, Testing Sites, Small Business Recovery). ArcGIS Solutions are 
designed to educate the public, engage volunteers, and help small business owners. 

Note: 

The Coronavirus Recovery template is only available in ArcGIS Hub Premium. 

 

Activate the ArcGIS Hub initiative 

To enable the Coronavirus Recovery ArcGIS Hub initiative, complete the steps below: 

1. Sign in to your ArcGIS Online organization, click the app switcher, and select ArcGIS Hub. 

2. In the Initiatives panel, click New and click Browse Templates. 

3. Locate Coronavirus Recovery in the gallery and click Activate Initiative. 

4. After the activation completes, follow the instructions provided on the How to use this 
template hub page. 

 

Share ArcGIS Solutions 

When you activate the Coronavirus Recovery ArcGIS Hub initiative, it creates a site, pages, and 
two groups (Core Team and Followers) in your ArcGIS organization. Several maps and apps 
included in the Coronavirus Wellness Checks must be shared with volunteers before conducting 
wellness checks. Sharing the appropriate maps and apps with the Followers group created with 
the initiative allows volunteers to access them after creating a community identity. 

To share the Coronavirus Wellness Checks maps and apps, follow the steps below: 

1. In your ArcGIS Online organization content, search for the Wellness Check and Volunteer 
Assignments ArcGIS Workforce project. 

2. Check the check box and click Share. Click Edit Group sharing and select Coronavirus 
Recovery Followers Group. 

3. Click OK and click Save. 

4. Repeat the process for the following items: 

  Item   Name 
  Sharing 
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  Web Map   WellnessChecks_workers   Group: Coronavirus 
Recovery Followers 

  Form   Wellness Check Report   Group: Coronavirus 
Recovery Followers 

  Form   Wellness Check Volunteers   Group: Coronavirus 
Recovery Followers 

  Feature Layer 
(hosted) 

  Assignments   Group: Coronavirus 
Recovery Followers 

  Feature Layer 
(hosted) 

  Location   Group: Coronavirus 
Recovery Followers 

  Feature Layer 
(hosted, view) 

  WellnessChecks_report   Group: Coronavirus 
Recovery Followers 

  Feature Layer 
(hosted, view) 

  Workers_report   Group: Coronavirus 
Recovery Followers 

  Feature Layer 
(hosted) 

  Workers   Group: Coronavirus 
Recovery Followers 

  Hub Site 
Application 

  Coronavirus Recovery ArcGIS 
Hub 

  Group: Coronavirus 
Recovery Followers 

  Hub Initiative   Coronavirus Recovery ArcGIS 
Hub 

  Group: Coronavirus 
Recovery Followers 

5. Share the Wellness Check Registry and the Assignments_report feature layer view with 
everyone. 
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Use Coronavirus Wellness Checks 
Coronavirus Wellness Checks delivers a set of capabilities that help you register homebound 
individuals, organize community volunteers, assign those volunteers to wellness checks, and 
monitor the wellness check program. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Volunteer for a wellness check program 
During the coronavirus disease 2019 (COVID-19) pandemic, communities are turning to 
volunteers and asking them to check the wellness of vulnerable individuals though out their 
community. These wellness checks are an effective way to engage volunteers and extend the 
public health and safety workforce in this time of need. 

In this workflow, you will learn how to volunteer for a local wellness check program. 

Note: 

To complete the following steps, you need to have ArcGIS Hub premium and deploy the 
Coronavirus Recovery ArcGIS Hub initiative. 

You will assume the role of a resident in the community. You have decided you would like to 
volunteer your time during the COVID-19 pandemic and are willing to check in on the wellness 
of homebound individuals in your neighborhood. 

1. In a browser, go the Coronavirus Recovery ArcGIS Hub site and browse to the Wellness 
Checks page. 

2. Click Join Community and create a community account. On the dialog box, click Create a 
Hub Community account. 

3. Complete the Hub Community account form and click Next.  

  An activation email is sent to the email address you used when setting up the account. 

4. Open your email client and complete the account activation by clicking the link in the email 
you received from the ArcGIS Hub community. Complete the form and click the Create 
Account button. 

5. Return to the Wellness Checks page on the Coronavirus Recovery ArcGIS Hub site. 

6. Click the Join Community button and ensure Leave Community appears. 

7. Click Volunteer Now and sign in with the account you created. 

8. Complete the Wellness Check Volunteers form and click Submit. 
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Register homebound individuals 
During the COVID-19 pandemic, many at-risk members of the community are homebound and 
feeling isolated. They may be anxious and uncertain about how they will get their medications, 
meals, and other necessary services. With a local wellness check program in place, homebound 
individuals can be registered, and regular check-ins can be scheduled to minimize the impact of 
the COVID-19 pandemic. 

In this workflow, you will learn how to register yourself or a family member for a wellness check. 

You will assume the role of a homebound individual or a resident in the community with a 
homebound family member. You would like to register yourself or your family member with the 
wellness check program so regular check-ins will be made during the COVID-19 pandemic. 

1. In a browser, go to the Coronavirus Recovery ArcGIS Hub site and click Request 
assistance. 

2. Complete the Wellness Check Registry form and click Submit. 

 

Manage volunteers and wellness checks 
Engaging volunteers is one strategy your public health and safety organizations may use to 
expand capacity during the COVID-19 pandemic. As volunteers join the wellness check 
program, background checks and other screening questions may be conducted before 
volunteers can participate fully. Organizations must manage the status of volunteers and be 
able to remove residents that have registered for the wellness check program if they leave the 
community for any reason. 

In this workflow, you will learn how to manage the status of volunteers and homebound 
individuals, assign a volunteer to a wellness check, and reassign wellness checks when 
necessary. 

 

Manage the status of homebound individuals 

You will start by assuming the role of a volunteer manager. You are asked to use the Wellness 
Check Volunteer Manager to update the status of homebound individuals and remove a 
homebound individual who no longer lives in the community. 

1. Sign in to your ArcGIS organization, search for Wellness Check Volunteer Manager, and 
open the app. 

2. Select Wellness Checks from the panel on the left. 

3. In the Name field, click the Filter button, type a name of a volunteer, and press Enter. 

4. Highlight the first volunteer in the table. 

5. Click the Edit Record button in the lower left panel. 

6. Click the Status drop-down menu and choose Cancelled, and click Save. 

 

Manage the status of volunteers 

You will continue assuming the role of a volunteer manager. You are asked to use the Wellness 
Check Volunteer Manager to update the status of volunteers in your community. 

1. Select Volunteers from the panel on the left. 
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2. In the Status field, click the Filter icon and choose Submitted - Not Yet Approved. 

3. Highlight the first volunteer in the table. 

4. Click the Edit Record button in the lower left panel. 

5. Click the Status drop-down menu and choose Active. 

6. Click Save. 

7. Click the Send Welcome Email button. 

  A standard email appears that includes links to the apps required to perform wellness 
checks. You can configure the email and include other content your organization deems 
necessary. 

8. Click Assign Volunteer. 

 

Assign wellness checks 

After updating the status of a volunteer, you are asked to assign a volunteer to a homebound 
individual in their neighborhood (near them). Using location to guide assignments helps 
volunteers establish a relationship with the homebound individual and makes it easier to deliver 
food and other essential needs when necessary. 

Note: 

The steps below assume you clicked Assign Volunteer and the Wellness Check and 
Volunteer Assignments ArcGIS Workforce project is open. 

1. Click Assignments. 

2.  In the Assignment Type drop-down list, click Wellness Check. 

  Note: 

  You can hover over the callout to see the name of the person requesting the wellness 
checks. 

3. Click the Assign drop-down menu and use the map to locate the nearest volunteer and 
assign the wellness check. 

4. In the lower left panel, click the Workers tab. 

  Note: 

  Before assigning volunteers, examine their workload. You may want to balance the 
wellness checks across many volunteers. 

5. Select a worker.  

  The volunteer receives a notification in the Workforce mobile app. 

   

Reassign wellness checks 

After a volunteer completes a wellness check, the Workforce assignment is completed. 
However, you will likely want to have the wellness checks at defined intervals (for example, 
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daily, weekly, or biweekly). Finally, you are asked to update the status of the wellness check 
assignment, so it is conducted at a later date. 

1. In your ArcGIS Online organization, search for Wellness Check Volunteer Manager, and 
open the app. 

2. Select Wellness Checks from the panel on the left. 

3. In the Status field, click the Filter button. 

4. Select Completed in the drop-down menu. 

5. Press the Ctrl key to select multiple records in the table. 

6. Click the Edit Record button in the lower left panel. 

7. Click the Status drop-down menu and choose Assigned. 

8. Click the Assigned Date drop-down menu and choose today's date. 

9. Click Save. 

 

Conduct a wellness check 
When a volunteer is accepted in the wellness check program, they receive a welcome email 
with links to a series of apps that will be used to conduct the wellness checks. Volunteers must 
install the apps on their mobile device before starting a wellness check. Once a wellness check 
is assigned to a volunteer, the volunteer receives a notification in the Workforce mobile app. 

In this workflow, you will assume the role of a volunteer. You are asked to conduct a wellness 
check and report the status of a homebound individual in your neighborhood. 

1. On your mobile device, open the ArcGIS Workforce app. 

2. Sign in with the community account you created when applying to volunteer. Open the 
Wellness Check and Volunteer Assignments project. 

3. Select a wellness check in the list. 

  You see a map with the location of the homebound individual. Under Notes, you see the 
name of the individual. 

4. Select Start at the bottom of the screen to start the wellness check. 

5. Select the box with an arrow and click Survey at Assignment. 

6. If necessary, sign in to Survey123 with a community account. You may be prompted to 
download the Wellness Check Report survey. 

  At the top is the name of the homebound individual and their phone number. You can click 
the phone number to call the individual and conduct the wellness check. 

7. Click Yes in the Did you speak with the person field. 

  You can use the remaining questions as a basis to guide conversations during your 
wellness check. For instance, you should ask if the homebound individual is experiencing 
COVID-19 related symptoms. 

8. Complete the remainder of the form and submit it by clicking Send Now. 

9. Go back to ArcGIS Workforce. 

10. In the Notes section, click the edit button to the right. Under the name of the individual, you 
can enter a quick note and date that you conducted the wellness check. 

11. Click Finish at the bottom of the screen. 

12. Go back to your list, and repeat the process for any additional homebound individuals on 
your list. 
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Monitor the wellness check program 
Volunteers collecting wellness information can help loved ones in a timely fashion should 
anything go wrong. In addition, collecting multiple wellness checks within your community can 
also help you see overall indicators if there are symptoms or concerns that are arising over time. 

In this workflow, you will assume the role of a volunteer manager or public health official. You 
are asked to monitor the wellness check program, review key indicators, and get an 
understanding of the overall well-being of homebound individuals in the community. 

1. Sign in to your ArcGIS organization, search for Wellness Check Volunteer Dashboard, 
and open the app. 

  The Wellness Check Dashboard opens with an overview of the current status of 
volunteers, homebound individuals, and wellness checks. 

2. Click the tabs at the bottom of each indicator to review performance over time or see a list 
of specific wellness checks. 

3. Click a value in the list of uncompleted checks to see which homebound individuals have 
not received a wellness check since registering or being reassigned. 

  Note: 

  You can use the link in the pop-up to open ArcGIS Workforce and assign the wellness 
check to a new volunteer. 

4. Click a graph or donut chart to filter the wellness checks. This can be useful to filter 
COVID-19 related symptoms or individuals who have not received a wellness check over a 
period of time. 

5. At the top of the dashboard, select a name in the Individual list or the Volunteer list to see 
where each volunteer is conducting wellness checks. 
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Fusion Center 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated.  

Mature phase 
Jul. 2022 – Jun. 2024 

Retired phase 
Jul. 2024 

 

Introduction to Fusion Center 
Fusion Center can be used to conduct threat mitigation on incidents affecting organizational 
assets from multiple event feeds. 

Understanding risk is achieved by using different sources of information to validate threats to 
each asset. Organizations have operators responsible for using best practices to detect, 
analyze, and alert others of any incidents that may impact the client's people, products, 
property, or brand image. These may range from extreme weather conditions, political 
instability, crime, terror, to technical failures. When a threat has been detected, the process of 
threat mitigation begins, allowing the organizational leaders to understand the steps that need to 
be taken or have been taken to remove the detected threat. Fusion Center is typically 
implemented by organizations that want to manage threats impacting business operations. 

The Fusion Center solution delivers a set of capabilities to correlate information from multiple 
event layers and assess the impact to an organization's assets such as facilities, employee 
home locations, and travelers. 

 

Requirements 
Fusion Center requires the following: 

• ArcGIS Online 

• ArcGIS Pro 2.8 - 2.9 (Basic) 

 

Information products 
Fusion Center includes the following information products: 

Item Description 
Minimum user 
type 

Facility Manager An ArcGIS Web AppBuilder app used by 
organizations to manage their facilities 

Editor 

Incident Monitor 
Dashboard 

An ArcGIS Dashboards app used to visualize 
impacted facilities 

Editor 

Incident Manager A Crowdsource Manager app used to mitigate threats Editor 
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Logging Dashboard An ArcGIS Dashboards app used to display the status 
of the task running in Windows Task Scheduler 

Viewer 

Tactical Analysis An ArcGIS Web AppBuilder app used to create 
assessment reports based on impacted facilities 

Editor 

Fusion Center 
Desktop 

An ArcGIS Pro project package used to connect 
event layers to understand impacted facilities 

GIS Professional 
Basic 

FacilitySource An Excel document that can be used to load and 
validate an authoritative list of facilities into ArcGIS 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.5 • A new Logging Dashboard app to improve visualization of Profiling Tool 
performance over time. 

• An update to the Fusion Center Desktop ArcGIS Pro project to support event 
level logging in the Profiling Tool, to enhance event lookup performance and a 
resolution to an issue where the earthquake layer isn't being processed (BUG-
000140886). 

• A new Incident Monitor Dashboard app with minor functional enhancements. 

• Removed Multi Source Data Feeds Desktop, Factal Incidents Dashboard, and 
Dataminr Alerts Dashboard from the Fusion Center solution. 

1.4 • An update to the Multi Source Data Feeds Desktop project that resolves an issue 
where Twitter content does not display the source web address (BUG-
000139305). 

• An update to the Multi Source Data Feeds Desktop project that improves the 
configure base layers task. 

1.3 • An enhancement to the Tactical Analysis app to improve performance and report 
creation. 

• An enhancement to the Incident Manager app to support email updates, for a 
single event, impacting multiple facilities at one time. 

1.2 • An update to the ArcGIS Pro project, maps and apps to simplify the deployment 
of the Fusion Center solution. 

1.0 • First release of Fusion Center. 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


 

Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal Page 156 

Configure Fusion Center 
In this topic, you will learn how to configure the Fusion Center solution to meet specific needs in 
your organization. 

 

Review the Fusion Center project 
The Fusion Center solution includes an ArcGIS Pro project. The project is used to configure and 
deploy the Profiling Tool, a python script that can be scheduled to run at a routine interval to 
detect threats and hazards occurring within a specified distance of your organizational facilities. 
The script can be run on any computer with Windows Task Scheduler and ArcGIS Pro. The 
Profiling Tool script queries user-defined web layers containing event feed from the ArcGIS 
Living Atlas and, third party sources, creating alerts for any event occurring within a specified 
distance of your organization's facilities. 

Note: 

Fusion Center solution can leverage third party event feeds from the ArcGIS Marketplace or 
with third party API keys and the configuration of the Multi Source Data Feeds solution. To 
implement the Fusion Center solution with third party API keys the Multi Source Data Feeds 
solution must be implemented first. 

Caution: 

The Profiling Tool in the Fusion Center Desktop ArcGIS Pro project helps organizations get 
started with spatially enabling their threat awareness and mitigation efforts. The script runs 
every three minutes, supports up to 11 unique event feeds and is appropriate for 
organizations with up to 10,000 unique facilities. As the volume of threats, hazards, and 
monitored facilities increase, additional real-time computing capabilities may be necessary. 
To learn more about increasing your computing capability and performance contact your 
Esri representative. 

Before configuring the solution and using the workflows with your data, familiarize yourself with 
the contents of the Fusion Center Desktop project. To review the project, complete the following 
steps: 

1. Start ArcGIS Pro. 

  Note: 

  Ensure you are signed in to the user name where Fusion Center was deployed. 

2. In the lower left corner, click Open another project. 

3. In the left pane, under Portal, click My Content and browse to the folder where Fusion 
Center was deployed. Select Fusion Center Desktop and click OK to open. 

4. Click the View tab along the top of the ribbon. 

5. Click Tasks in the Windows group to open the Fusion Center tasks to configure, manage, 
and automate the setup and use of the Fusion Center Desktop solution. 
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Extract the environment 
The Fusion Center solution uses the Fusion Center Desktop package to set up and configure 
the solution. In this topic, you will extract the zip file into the folder location where the ArcGIS 
Pro package was placed. 

Note: 

The workflow assumes that you have the task pane open from the Review the Fusion 
Center project workflow list above. 

Note: 

The default location for the ArcGIS Pro package is 
%userprofile%\Documents\ArcGIS\Packages\ 

1.  Click step 1, Extract the Fusion Center Environment. 

  The group will expand in the task list. 

2. Click Extract the Fusion Center Solution Tools in the task list. 

3. Click Finish. 

  This will unzip the zip file, adding a new folder named Profiling, which will be located in the 
Fusion Center Desktop folder. You can explore in the Catalog Pane under Project > 
Folders. 

   

Create an ArcGIS profile 
The Fusion Center solution will need access to your ArcGIS credentials. To create your profile 
and store that profile in Windows Credentials Manager, complete the following steps: 

Note: 

The workflow assumes that you have the task pane open from the Review the Fusion 
Center project workflow list above. 

1. Click Create An ArcGIS Profile in the task list. 

  The group will expand in the task list. 

2. Click Create ArcGIS Credential Profile in the task list. 

3. Enter the URL of your ArcGIS organization. 

4. Enter the ArcGIS user name and password. 

5. Enter the profile name that will be used to store the credentials. 

6. Click Finish. 

  When you click finish, the tool will store the credentials in Windows Credential Manager 
and update the profile script configuration file. 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


 

Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal Page 158 

Configure event feeds 
In this workflow, you will define the event feeds that will be used by the Fusion Center solution 
to detect threats and hazards. The table below lists the event feed sources that can be 
configured to run in the Profiling Tool using the Fusion Center Desktop project. 

Event 
Feed 
Number Feed Name Description 

Default 
Feed 
Status 

Data 
Type 

Target 
Layer Note 

1 Dataminr Dataminr Pulse 
Real-Time 
Alerting layer 
from ArcGIS 
Marketplace or 
capabilities of 
Multi Source 
Data Feeds 
solution. 

disable Point Total 
Threats 

Requires item ID from a 
source web layer. The 
default field mapping is 
configured to work with 
the Dataminr Alerts 
layer from Multi Source 
Data Feeds solution. 
When using Dataminr 
Pulse Real-Time 
Alerting layer from 
ArcGIS Marketplace, 
you'll need to review 
your layer and adjust 
field mapping to reflect 
the correct field names. 

Note: 

Field names are 
subject to change 
by provider. 

2 Factal Breaking News 
Feature layer by 
Factal from 
ArcGIS 
Marketplace or 
capabilities of 
Multi Source 
Data Feeds 
solution. 

disable Point Total 
Threats 

Requires item ID from a 
source web layer. The 
default field mapping is 
configured to work with 
the Factal items layer 
from Multi Source Data 
Feeds solution. When 
using ArcGIS 
Marketplace Breaking 
News Feature layer, 
you'll need to review 
your layer and adjust 
field mapping to reflect 
the correct field names. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://www.esri.com/en-us/arcgis-marketplace/listing/products/d68a86703b6c4c32ac4671c197d6d641
https://www.esri.com/en-us/arcgis-marketplace/listing/products/d68a86703b6c4c32ac4671c197d6d641
https://doc.arcgis.com/en/arcgis-solutions/latest/reference/introduction-to-multi-source-data-feeds.htm
https://doc.arcgis.com/en/arcgis-solutions/latest/reference/introduction-to-multi-source-data-feeds.htm
https://doc.arcgis.com/en/arcgis-solutions/latest/reference/introduction-to-multi-source-data-feeds.htm
https://doc.arcgis.com/en/arcgis-solutions/latest/reference/introduction-to-multi-source-data-feeds.htm
https://www.esri.com/en-us/arcgis-marketplace/listing/products/d68a86703b6c4c32ac4671c197d6d641
https://www.esri.com/en-us/arcgis-marketplace/listing/products/d060f0909ef04a7aa3375c5527586d53
https://www.esri.com/en-us/arcgis-marketplace/listing/products/d060f0909ef04a7aa3375c5527586d53
https://doc.arcgis.com/en/arcgis-solutions/latest/reference/introduction-to-multi-source-data-feeds.htm
https://doc.arcgis.com/en/arcgis-solutions/latest/reference/introduction-to-multi-source-data-feeds.htm
https://doc.arcgis.com/en/arcgis-solutions/latest/reference/introduction-to-multi-source-data-feeds.htm
https://doc.arcgis.com/en/arcgis-solutions/latest/reference/introduction-to-multi-source-data-feeds.htm
https://www.esri.com/en-us/arcgis-marketplace/listing/products/d060f0909ef04a7aa3375c5527586d53
https://www.esri.com/en-us/arcgis-marketplace/listing/products/d060f0909ef04a7aa3375c5527586d53


 

Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal Page 159 

Note: 

Field names are 
subject to change 
by provider. 

3 Hyperion Geospark 
Analytics Event 
Model layer from 
ArcGIS 
Marketplace. 

disable Point Total 
Threats 

Requires item ID from a 
source web layer. The 
default field mapping is 
configured to work with 
the Geospark Analytics 
Event Model layer from 
ArcGIS Marketplace. 

Note: 

Field names are 
subject to change 
by provider. 

4 NWS-
Extreme 

Extreme weather 
alerts from 
United States 
National Weather 
Service via 
ArcGIS Living 
Atlas. 

enable Polygon Total 
Hazards 

Learn more about the 
feed. 

5 NWS-
Severe 

Severe weather 
alerts from 
United States 
National Weather 
Service via 
ArcGIS Living 
Atlas. 

disable Polygon Total 
Hazards 

Learn more about the 
feed. 

6 NWS-
Moderate 

Moderate 
weather alerts 
from United 
States National 
Weather Service 
via ArcGIS Living 
Atlas. 

disable Polygon Total 
Hazards 

Learn more about the 
feed. 

7 NWS-Minor Minor weather 
alerts from 
United States 
National Weather 
Service via 

disable Polygon Total 
Hazards 

Learn more about the 
feed. 
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ArcGIS Living 
Atlas. 

8 NWS-Other Other weather 
alerts from 
United States 
National Weather 
Service via 
ArcGIS Living 
Atlas. 

disable Polygon Total 
Hazards 

Learn more about the 
feed. 

9 Earthquake-
Shake 
Intensity 

Earthquake 
events over last 
30 days by 
shake intensity 
via ArcGIS Living 
Atlas. 

enable Polygon Total 
Hazards 

Learn more about the 
feed. 

10 Wildfire 
Incidents 

Current wildfire 
locations over 
the last 7 days 
provided by the 
Integrated 
Reporting of 
Wildland-Fire 
Information 
service via 
ArcGIS Living 
Atlas. 

enable Point Total 
Threats 

Learn more about the 
feed. 

11 Hurricane 
Forecast 
Track 

Hurricane tracks 
and positions 
provided by the 
National 
Hurricane Center 
via ArcGIS Living 
Atlas. 

enable Polygon Total 
Hazards 

Learn more about the 
feed. 

Complete the following steps to enable the event feeds you want to use and update the Profiling 
Tool script with item IDs of web layers sourced from your organization. If the field names of your 
layers do not match the default field name values provided, you will also need to update the field 
names to reflect the values in your layer. 

1. Click Configure the Event Feeds in the task list. 

  The group will expand in the task list. 

2. Click Setting Event Inputs for the Configuration File in the task list. 

3. Read the overview information and click Next Step.  

4. In the drop-down menu, click Select a Section to choose an event layer and set that event 
layer to enabled if you want to have it as an input. 

  Note: 
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  The configuration file has 11 event inputs with some enabled and some disabled. 
Choose each event number section and update information from each of these. 

5. If you are leveraging a 3rd party event feed such as Dataminr, Factal, or Geospark 
Analytics then you will need to choose event section 1, 2, or 3 to set feed status and item 
ID. 

  Note: 

  If you are accessing Dataminr or Factal event feeds via API keys with the Multi Source 
Data Feeds solution, and the solution was just deployed, this section should be 
configured with the proper Item ID. If you are using ArcGIS Marketplace to access 
Dataminr and Factal event feeds then you'll need to use the Item ID of the layer provided 
from the ArcGIS Marketplace. If you are using the Geospark Analytics Hyperion event 
feed then it is configured to use the ArcGIS Marketplace Item ID by default. 

 

Add additional event feeds 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the solution. 

To configure additional event feeds or configure a feed not listed in the default configuration 
complete the following steps: 

1. Close the Fusion Center Desktop project. 

2. Navigate to the location of the config.ini file of the Profiling tool script and open it in a text 
editor. 

  For example: %userprofile%\Documents\ArcGIS\Packages\Fusion Center 
Desktop<item_id>\Profiling\Profiling\config.ini 

3. Navigate to the bottom of the file, copy the configuration for Event 11 and paste it 
underneath. 

4. Update the configuration you copied by changing the name to Event 12 and modify the 
values to reflect the event feed you wish to add, including the item id of the layer to be 
used, the layer id of the service, and the field names in the layer that correspond to the 
required values for the Profiling Tool. 

5. Save the config.ini file. 

6. Open the Fusion Center Desktop project and resume at the Load Facility Data task group. 

 

Load data 
There are a few options when loading facility data, depending on the format of your facility data. 
To load facilities data, complete the following steps: 

1. Click Load Facility Data in the task list. 

  The group will expand in the task list. 

2. There are three choices that allow the loading of facility data. Choose how you would like 
to load data: 
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– Validate Data and Append to a feature service - Use this option if you want to 
validate your facility data before importing. This includes ensuring unique Facility 
IDs. 

– Append Data - Use this option if you have facility data in a feature class and an 
existing hosted feature layer. 

– Append Data through ArcGIS Online - Use this option if you want to use the Update 
Data option in ArcGIS Online. 

  Once the steps have been finished, the facilities will be loaded and you can move on to 
creating geofences. 

   

Create geofences 
Once you have facilities loaded into the facility data, you can create geofences around those 
locations. 

1. Click Creating Geofenced Boundaries in the task list. 

  The group will expand in the task list. 

2. Click Create Geofence Boundaries in the task list. 

3. Read the overview in the first step on how geofences are created. Then click Run.  

4. Click the folder icon on the first input to add the facilities layer as an input. 

  A window will appear to allow you to add content from your ArcGIS organization. 

5. Click My Content under the portal directory. 

6. Select the folder where Fusion Center was deployed. 

7. Select the Facilities  feature service and click Open. 

  This will navigate you to the layers part of the facilities layer. 

8. Select the Facilities layer and click Open.  

  Repeat steps 2 through 8 to add geofences to the Facility Geofence Boundary layer as 
the second input. 

9. Input a desired distance. 

10. Choose a unit of measure for the desired distance. 

 

Deploy the profiling tool 
This set of tasks will help deploy the profiling tool as a scheduled task that, at default, will run 
every three minutes. This tool will identify new incidents from event layers that intersect the 
geofence boundaries surrounding each facility. 

1. Click Deploying the Profile Tool in the task list. 

  The group will expand in the task list. 

2. Click Configuring Windows Task Scheduler in the task list. 

3. Read the overview information and click Next Step. 

4. Click Finish.  

  The profile tool has been deployed as a task in Windows Task Scheduler. 
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Maintaining Fusion Center 
Fusion Center requires maintenance activities in order to work correctly and ensure optimal 
performance over time. If maintenance is not performed, solution performance will be impacted. 
Maintenance activities include manual triage of incident status and deleting features from layers 
and tables. Learn how to perform maintenance in the following sections: 

 

Manual triage of incident status 

The Incident Manager app and Incident Monitor Dashboard display only incidents with an 
Incident Review Status value of Open or Under Review. If incidents are not regularly set to 
Closed or Out of Scope, the number of records displayed in these apps will continue to grow, 
impacting the performance of these applications and the system. As a best practice, the number 
of incidents with a status of Open or Under Review should not exceed 3000 at any given time. 
To change the status of incidents, use the Incident Manager, select the records of interest, 
select the pencil icon, and set the Incident Review Status value to Closed or Out of Scope. 
Learn more about how to use Fusion Center solution. 

Note: 

You will need to update status in both the Hazards and Threats sections of the Incident 
Manager app. How often you are required to manually triage incident status in the Incident 
Managerapp will depend on the number of daily threats and hazards you see in your 
organization. If you are seeing 3000 incidents in a day or more, you should be performing 
manual triage of those incidents a least once a day. 

Failure to perform manual triage on those incidents will mean that performance of the 
solution will decrease. 

 

Delete features from Total Threats, Total Hazards, and Total Incidents 

The two main solution layers, Total Threats, and Total Hazards, accumulate new records 
rapidly. Total Incidents is a standalone table that contains all records from both the Total 
Threats and Total Hazards layers. Once incidents have been reviewed by analysts and given a 
status of Closed or Out of Scope, they are no longer needed in the solution but continue to be 
stored in the layers (and the table) and analyzed by the Profiling Tool script when it runs. Over 
time, large volumes of these historical incidents increase the amount of time required to run the 
Profiling Tool script, which can lead to performance problems, script failures, or missed 
incidents. 

Caution: 

Conducting the following steps will permanently delete the closed and out of scope records 
from the total threats layer, total hazards layer, and total incidents table. Before using the 
following steps to delete records, your organization may require local copies of historical 
data. Learn more how to export data from hosted feature layers into a local file 
geodatabase to create a local copy of your data. If you choose to archive data, pause the 
profiling tool before conducting an export to ensure a complete copy of your data. 
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Failure to perform maintenance on Total Threats layer, Total Hazards layer and Total 
Incidents table will mean that performance of the profiling tool will decrease and eventually 
fail because of the way the tool is designed. 

To permanently delete historical incidents with a status of Closed or Out of Scope from the Total 
Threats layer, complete the following steps: 

1.  Navigate to Windows Task Scheduler and pause the Profiling Tool script. 

2.  Log in to your ArcGIS organization. 

3. Choose Content, and navigate to the Total Threats layer item. 

4. Choose Total Threats Layers section, click Total Threats. 

5. In URL section, click View.  

  The ArcGIS REST API service directory will open. 

6. In the ArcGIS REST API service directory, scroll down to Supported Operations, and click 
Delete Feature. 

  This option is only available if editing has been enabled for the feature service. 

7. In the Where parameter, type the following: 

  ObjectID>0 AND incident_review_status IN ('Closed','Out of Scope') 

  If there are no records in your layer with the incident review status field value of Closed or 
Out of Scope, type the following: 

  ObjectID>0 

8. Set the ASync parameter as TRUE. 

9. Click Delete Features button. 

  This process can take several minutes when many features are present. 

10. Repeat steps 2-9 for the Total Hazards layer. 

After you have deleted Closed or Out of Scope records from the Total Threats and Total 
Hazards layers, complete the following steps to delete Closed or Out of Scope records from the 
Total Incidents table: 

1. Click Content, and navigate to the Total Incidents table item. 

2. On the item page of the Total Incidents table, click Settings. 

3. In the Editing section, click on Enable editing, then click Save. 

4. Click Overview. 

5. In the Tables section, click Total Incidents. 

6. In the URL section, click View. 

  The ArcGIS REST API services directory will open. 

7. In the ArcGIS REST API service directory, scroll down to Supported Operations , and 
click Delete Feature. 

  This option is only available if editing has been enabled for the feature service. 

8. In the Where parameter, type the following: 

  ObjectID>0 AND incident_review_status IN ('Closed','Out of Scope'). 

  If there are no records in your layer with the incident review status field value of Closed or 
Out of Scope, type the following: 

  ObjectID>0 
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9. Set the ASync parameter as TRUE. 

10. Click Delete Features button. 

  This process can take several minutes or more when many features are present. 

11. Restart Profiling Tool script in Windows Task Scheduler. 

 

Identify the maintenance frequency 

Maintenance should be performed on the layers and table based on a variety of factors, 
including the number of records in your Facilities layer, the size of the geofence boundary you 
have configured in your Profiling Tool, and the number of unique event feeds configured in your 
Profiling Tool. These factors contribute the total number of features that will exist in your total 
hazard, total threat, and total incidents layers. A large number of features in these three layers 
will impact performance of the script over time. 

To determine how frequently to perform the maintenance given your unique configuration of the 
Profiling Tool script, consider the following: 

1. Navigate to the Logging Dashboard and monitor when the Profiling Tool script experiences 
consistently above average runtimes then choose one of the following approaches: 

– Identify how many days (or weeks) the script ran before experiencing above-
average runtimes. Perform future maintenance by deleting records from the Total 
Threats layer, Total Hazards layer and Total Incidents table according the day 
interval where the runtimes increased. 

– When above-average script run times are experienced, review the number of 
records in the Total Hazards layer, Total Threats layer, and the Total Incidents 
table. Perform future maintenance by deleting records when each layer reaches the 
record size observed when script times increased. 

 

Review Logging 
When the Profiling Tool runs, it generates a detailed message log about the processing of event 
feeds and corresponding threats and hazards. By default the Profiling Tool is scheduled to run 
every 3 minutes. If you experience problems with execution or performance of the Profiling Tool, 
the log can be used to troubleshoot causes of the problem behavior. The message log can be 
found at the following location: 

%userprofile%\Documents\ArcGIS\Packages\Fusion_Center_Desktop<item_id>\Profiling\Profili
ng\Logs 

The log captures the following types of messages which can be used to address issues with the 
event feed import process: 

Level 
Numeric 
Value Description 

ERROR 40 This level of logging provides information about events that prevented 
the script from executing successfully. 

WARNING 30 This level of logging provides information about events that were 
unexpected but did not stop the script from running. This is the default 
setting. 
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INFO 20 This level of logging provides additional information about successful 
execution of individual processing steps. 

DEBUG 10 This level of logging provides detailed information about the execution 
of individual processing steps that can be helpful in determining the 
causes of errors or unexpected results. 

Note: 

By default, the Profiling Tool is configured to report all events with a value of 30 and above. 
Additional logging can be configured for debugging purposes if required, but will result in 
longer runtimes for the Profiling Tool. To enable full debugging logging, go to the above 
location and edit the log_config file. Change the level parameter from 30 to 10. 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


 

Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal Page 167 

Use Fusion Center 
Fusion Center delivers a set of capabilities that allows an organization to mitigate threats to their 
organization. This is achieved by combining a variety of event layers into threat and hazard 
layers, to understand what facilities have been impacted. 

In this topic, you’ll learn how to use the Fusion Center solution by assuming the role of various 
users in the Global Security Operations Center (GSOC) and perform the following workflows. 

 

Assess the threat status 
You will assume the role of a security analyst responsible for assessing the incident impact on 
the organizational footprint. 

1. In a browser, open the Incident Monitor Dashboard. 

2. Click a facility from the Impacted Facilities list. 

  Note: 

  This will filter the list of incidents to the incidents that are affecting the selected facility. 

3. Click the Incident List tab in the lower left corner of the dashboard. 

  Note: 

  This list shows all the incidents that are affecting the facility that was selected in the 
Incident List, and the map shows only those incidents as well. 

4. Click the Incident Overview tab at the bottom of the dashboard. 

  Note: 

  The dashboard displays a complete breakdown of incidents by status Incident List, and 
the map shows only those incidents as well. 

 

Change the incident status 
When an incident has been identified as a threat to a facility, an analyst in the GSOC must 
gather information about the incident. This process is called threat mitigation. 

1. In a browser, open the Incident Monitor Dashboard. 

2. Click a facility from the Impacted Facilities list. 

  Note: 

  This will filter the list of incidents to the incidents that are affecting the selected facility. 

3. Click the Incident List tab in the lower left corner of the dashboard. 
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  Note: 

  This list shows all the incidents that are affecting the facility that was selected in the 
Incident List, and the map shows only those incidents as well. 

4. Click an incident in the Incident List to pan to the incident. 

  Note: 

  The pop-up for this incident will appear, providing more information about the incident. 

5. Click the Incident Source button in the pop-up to access the raw information from this 
event feed. 

  Note: 

  The button will open a new tab to help you understand all information about the incident. 
Close the tab when finished and return to the Incident Monitor Dashboard. 

6. Click the Triage Incident button in the incident pop-up. 

  Note: 

  The button will open the Incident Manager application in a new tab. The incident that was 
selected in the Incident Monitor Dashboard will be selected in the application. 

7. Click the edit button in the lower left quadrant to change the status of this incident to Under 
Review. 

8. Type any notes needed for others to understand the status in depth in the Notes section. 

9. Click the Save button. 

  Note: 

  This status change will persist in the ArcGIS system. 

 

Conduct Tactical Analysis 
Throughout the threat mitigation process, further analysis may be necessary to better 
understand the potential impact. The Tactical Analysis app can be used to glean further 
information by creating reports and visualize the extent of the incident to enhance decision 
support. 

In this workflow, you will learn how to access the Tactical Analysis app from Incident Manager 
and generate a set of reports that can be shared with key decision makers. 

 

Perform Tactical Analysis 

1. In a browser, open the Incident Manager application. 
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2. Select either Hazards or Threats to view active incidents. 

3. Click an incident in the incident table. 

4. Click the Perform Tactical Analysis button. 

  The Tactical Analysis app opens in a separate tab that filters all active impacts based on 
the facility from the selection in Incident Manager. The Impact Summary tool on the right 
displays details on the impacted facilities. 

5. Click on one of the impacted facilities in the list. 

6. In the pop-up, click Click here to send email to Facility Administrator to open your 
default email client. 

  This email will allow reports to be shared to the facility manager. 

7. Minimize the email client and use any of the tools included in the app to share reports with 
those in your organization. 

  The section below provides additional guidance on creating reports that can be shared with 
key stakeholders. 

   

Create Infographics and Reports 

The Business Analyst tool allows you to gain social, demographic, or economic context of the 
community surrounding a facility, threat, or hazard in order to enhance decision support in 
operational response. Selecting a feature from the map enables you to generate contextual 
reports or infographics for your location of interest. 

1. In the Impact Summary tool, select a feature from Impacted Facilities list to select the 
feature on the map. 

2. In the upper right corner, click the Business Analyst tool to open it. 

  When opened, the currently selected feature is set as the active feature for analysis. 

3. Select rings, drive time, or walk time and specify desired value to create an analysis area. 

  Note: 

  If a hazard is selected, you do not need to supply a value as it will use the area extent of 
the feature. 

4. Select a type of infographic or report and click the respective Run button to download a 
report for the analysis area. 

 

Create Impact Reports 

The Understand Impact tool allows you to view information and generate reports based on the 
impacted facilities, threats, and hazards layers. 

1. In the Impact Summary tool, select a feature from Impacted Facilities list to select the 
feature on the map. 

2. In the pop-up, click the more information button in the bottom right corner to see a list of 
feature actions, and choose Set Location. 

  The Understand Impact tool opens. By default, the tool draws a 5-mile buffer around your 
selected location. 
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  In an area along the bottom of the browser, displays a series of tabs displaying information 
about threats, hazards, and facilities within this area. 

3. Click the Create Report button to download the summarized information as a report. 

4. Click the Download button to download the information in a series of csv files. 

5. Click the Create Snapshot button to save the features within the buffer area as a series of 
standalone layers. 

 

Maintain facility information 
Facility Manager can be used by operators to maintain facility information, ad hoc areas of 
interest, and review or create geofences. 

 

Create facilities 

1. In a browser, open the Facility Manager app. 

2. In the upper right corner, click the Facility Editor tool to open it. 

3.  Click New Facility and click anywhere on the map to add a new facility feature. 

  A new window appears where you can fill in facility information. 

  Note: 

  At a minimum, a unique Facility ID and Facility Name are required. 

4. Click Save. 

 

Edit an existing facility 

1. In the upper right corner, click the Facility Editor tool to open it. 

2. Select a facility from the map. 

  A new window appears where you can fill facility information. 

3. Make the desired changes and click Save. 

 

Add a new facility geofence boundary 

1. In the upper right corner, click the Facility Editor tool to open it. 

2.  Click Facility Geofence Boundary and optionally select a drawing option from the drop-
down list. 

3. Draw a geofence around your facility of interest. 

  Note: 

  Only one geofence boundary can be drawn per facility. This boundary is used to identify 
whether a threat or hazard is within proximity. 

4. A new window appears with the attributes for the geofence feature automatically populated 
based on the facility it covers. 
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  Note: 

  If the geofence covers multiple facilities, you have the option to select which attributes to 
keep. 

  The geofence is linked to the facility based on the Facility ID. Ensure that the Facility ID 
field of the geofence is populated with the facility of interest. 

5. Click Save to apply. 

 

Edit an existing facility geofence boundary 

1. In the upper right corner, click the Facility Editor tool to open it. 

2. Select a geofence from the map. 

  A new window appears where you can update the geofence attributes. Ensure Edit 
Geometry is checked if you want to update the geometry. 

  Note: 

  To create a geofence from scratch, click Delete and follow the steps for adding a new 
facility geofence boundary. 

3. Make the desired changes and click Save. 
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Homelessness Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated.  

Mature phase 
Mar. 2024 – Jan. 2026 

Retired phase 
Mar. 2026 

 

Introduction to Homelessness Outreach 
Homelessness Outreach can be used to educate the public and help individuals experiencing 
homelessness find available resources. 

It allows you to manage homelessness information and services in the community for the 
general public and allows public health agencies to maintain that information. This collaborative 
approach helps ease the burden on communities that are dealing with increasing service 
demands, limited access to technology, and real-time data. Homelessness Outreach is typically 
implemented by health and human services agencies that want to take an active role in 
reducing homelessness. 

The Homelessness Outreach solution delivers a set of capabilities that help you inventory 
available homelessness services, communicate the severity of homelessness, and promote 
resources available to those in need. 

 

Requirements 
Homelessness Outreach requires the following: 

• ArcGIS Online 

 

Information products 
Homelessness Outreach includes the following information products: 

Name Description 
Minimum 
user type 

Reduce 
Homelessness 

An ArcGIS Hub site used by the general public to access 
information about homelessness in their community and 
where to find related services 

Not 
required 

Homelessness 
Outreach Volunteer 

An ArcGIS Survey123 form used by the general public to 
volunteer with assisting people experiencing 
homelessness in their community 

Not 
required 

Homelessness 
Resource Inventory 

An ArcGIS Web AppBuilder app used by homelessness 
program leads to inventory homelessness service 
providers in a community 

Editor 
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Homelessness 
Service Locator 

A Nearby app used by the general public to locate 
facilities in the community providing assistance to those 
individuals and families experiencing homelessness 

Not 
required 

  

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS solution n 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

2.1 (Mar 
2023) 

• A new Reduce Homelessness Hub site. 

• A new Homelessness Outreach Volunteer survey that uses a feature layer 
view to define access. 

2.0 (Apr 
2022) 

• Name changed from Homeless Outreach to Homelessness Outreach. 

• All layers, map, apps, and projects updated to use the term homelessness 
instead of homeless. 

1.1 (Feb 
2021) 

• An update to the Homelessness Resource Inventory app, map, and layer to 
support integration with the Community Health Outreach solution 

1.0 (Nov 
2020) 

• First release of Homeless Outreach 
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Configure Homelessness Outreach 
Learn how to configure the Homelessness Outreach solution to meet specific needs in your 
organization by leveraging other solutions. 

 

Reference point-in-time count data 
You can use the Reduce Homelessness hub site to give insight about homelessness in your 
community. A common dataset of interest is the Homeless Point-in-Time data conducted by 
volunteers during annual surveys. This dataset is included in the Homelessness Point-in-Time 
Counts solution. 

 

Deploy the Homelessness Point-in-Time Counts solution 

To deploy the Homelessness Point-in-Time Counts solution, complete the following steps: 

1. Sign in to your ArcGIS organization, click the app switcher, and select ArcGIS Solutions. 

2. Deploy the Homelessness Point-in-Time solution. 

3. Browse to the Homelessness Count public feature layer (hosted view) and share it with 
everyone. 

 

Reference Point-in-Time Count data in the Reduce Homelessness hub 
site 

1. Verify that you are signed in to your ArcGIS organization and browse to the Reduce 
Homelessness site. 

2. From the item page, click Configure. 

3. If necessary, click the Edit button  to open the site editor. 

4. Under How are we doing, click the gear box to edit the Sheltered Homeless indicator. 

5. Note: 

6. When you first deploy the solution, numbers are shown from sample data. The 
following steps describe how you can reference your own point-in-time count data. 

7. Click the edit button and browse to the Homelessness Count_public dataset you 
deployed from the Homelessness Point-in-Time count solution. 

8. Click Select. 

9. For Statistic Field, choose Sheltered. Ensure Count is listed under Statistic Type. 

10. Repeat the above steps for Un-Sheltered Homeless and Number of Children. 

11. Click Save. 

12. Under Save, click the drop-down menu and choose Publish Draft. 
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Configure Reduce Homelessness site 
The Homelessness Outreach solution includes the Reduce Homelessness ArcGIS Hub site. 
This site can be configured with your organization's branding and used to share information with 
the public. 

 

Update with organizational information 

After deploying the Homelessness Outreach solution, the Reduce Homelessness Hub site 
layout requires a few updates to fit your local community. 

To update the site with your organizational information, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Reduce 
Homelessness site. 

2. From the item page, click Configure. 

3. Scroll to any sections that you want to update, hover over the card, and click the edit 

pencil  that appears in the horizontal toolbar, and then edit the content with 
information specific to your organization.  

4. In the side panel, click Footer. 

5. A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

6. Click the HTML box. 

7. The HTML window appears. 

8. Make the necessary changes and click Apply. 

9. Click Save. 

10. Click the Save drop-down arrow and click Publish Draft. 

 

Share items with public 

Several layer views, maps, and apps included in the Homelessness Outreach solution must be 
shared with everyone so they can be accessed by the public on the Reduce Homelessness site. 

To share items with the public, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Homelessness Outreach folder. 

2. Next to each of the following items, check the check box: 

  Name 

  Item type 

  Homelessness Outreach 
Volunteer_public 

  Feature layer (hosted, view) 

  HomelessnessServices_public   Feature layer (hosted, view) 

  Homelessness Service Locator   Web Map 
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  Homelessness Outreach Volunteer   Web Map 

  Homelessness Outreach Volunteer   Form 

  Homelessness Service Locator   Instant App 

  Reduce Homelessness   Hub Site Application 

  Homelessness Outreach   Hub Initiative 

    

  Note: 

  You will only have a Hub Initiative item if your organization has ArcGIS Hub Premium. 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

5. The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

6. Click Update. 

 

Configure directions 
Optionally, you can configure Homelessness Outreach to provide directions to the nearest 
homelessness service location. 

Follow the steps below to connect to a routing service and configure the app to enable 
directions. 

1. Sign in to your ArcGIS organization and browse to the Homelessness Service Locator 
app. 

2. From the item page, click Configure. 

3. Close the Welcome to the App Setup Page splash page, if necessary. 

4. Click Nearby > Options and turn on the Show directions toggle button. 

5. Check the check box next to the Homelessness Services layer. 

6. Click Publish. 

7. Click Confirm. 

8. The Authorize premium content window appears with information related to 
authorization. 

9. Click Authorize. 

10. Click Launch. 
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Use Homelessness Outreach 
The Homelessness Outreach solution delivers a set of capabilities that help you inventory 
available homelessness services, communicate the severity of homelessness, and promote 
resources available to those in need. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Inventory homelessness resources 
Health and human services agencies can use the Homelessness Resource Inventory app to 
inventory homelessness, drug treatment, and other service providers in a community. Select a 
service provider project entered previously and refine the facility details. Locate a new service 
provider and add relevant facility details to help community members find an appropriate service 
provider. 

You'll assume the role of a homelessness program lead that wants to inventory homelessness, 
drug treatment, and other service providers in the community. The steps below describe how to 
enter information, but you can enter the information as you see fit to examine the different 
dependencies in questions. 

 

Add resources to the map 

To add resources to the map, complete the following steps: 

1. In a browser, go to the Homelessness Resource Inventory app. 

2. In the Resource Editor widget, in the Search Templates field, type Homeless. 

3. Click the Homelessness Services template, and then click the map to add a location to 
the map. 

4. A Homelessness Services form opens in the widget 

5. Complete the form with details about the new location. 

6. Scroll to the bottom of the form and click Save. 

 

Volunteer to assist with homelessness 
You'll assume the role of a member of the general public that wants to find information about 
homelessness in your community and volunteer to assist. 

1. In a browser, go to Reduce Homelessness Site app and review the sections. 

2. Scroll down and click the Volunteer now button. 

3. Fill in the survey with your information. 

The hosting organization can now compile this information and reach out to volunteers for the 
appropriate services. 
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Locate homelessness services 
Education and connecting people with resources are critical in helping those in need. The 
Homelessness Service Locator app can be used by the general public and engaged 
organizations to locate facilities providing homelessness services to individuals or families. 
Search for an address or click the map to locate a homelessness service provider near the 
location. 

 

Find a service 

You’ll assume the role of a member of the general public who wants to locate facilities providing 
assistance to individuals experiencing homelessness. 

1. In a browser, go to Reduce Homelessness Site app and review the sections. 

2. Scroll down to the Need Help section. 

3. Click the Homelessness Services Locator link. 

4. The Homelessness Service Locator shows all homelessness service facilities in the 
community. 

5. In the Find Address or place field, type an address or click a location on the map.  

6. The results appear and show several types of services. 

7. Click the Homelessness Resource result. 
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Homelessness Risk Reduction 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated.  

Mature phase 
Mar. 2024 – Jan. 2026 

Retired phase 
Mar. 2026 

 

Introduction to Homelessness Risk Reduction 
Homelessness Risk Reduction can be used to identify where regular reports of homelessness 
activity may originate and address regular reports of homelessness activity in a community. 

It provides the ability to leverage continual reports of individuals experiencing homelessness 
and encampments in the community and identify which areas are at risk for generating 
homelessness. This collaborative approach between the public and local government agencies 
help determine where resources can be deployed to assess the situation, offer services to 
persons experiencing homelessness, and determine if additional steps are required. 
Homelessness Risk Reduction is typically implemented by health and human services agencies 
that want to proactively address homelessness and connect individuals experiencing 
homelessness with available resources. 

The Homelessness Risk Reduction solution delivers a set of capabilities that help you 
understand where homelessness may originate in your community and actively monitor regular 
reports of homelessness so assistance can be offered to individuals in need. 

 

Requirements 
Homelessness Risk Reduction requires the following: 

• ArcGIS Online 

• ArcGIS Pro 2.9 or later (Advanced) 

– ArcGIS Geostatistical Analyst extension 

 

Information products 
Homelessness Risk Reduction includes the following information products: 

Item Description 
Minimum user 
type 

Homelessness 
Activity Reporter  

An ArcGIS Survey123 form used by public safety staff, or 
the public, to report the locations of individuals 
experiencing homelessness and encampments in the 
community 

Mobile Worker 
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Homelessness 
Activity Manager 

A Crowdsource Manager app used by homelessness 
program leads to manage reports of individuals 
experiencing homelessness and encampments in the 
community 

Editor 

Homelessness 
Activity Dashboard 

An ArcGIS Dashboards app used by health and human 
service agency and CoC directors to monitor reports of 
individuals experiencing homelessness and 
encampments in the community 

Viewer 

Homelessness 
Risk Reduction 

An ArcGIS Pro project used by GIS analysts to learn 
which areas in their community are at risk for generating 
homelessness and how to prioritize and site intervention 
programs 

GIS 
Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS solution item 
that organizes the key information products and summarizes all the ArcGIS items (applications, 
forms, projects, maps, feature layers, feature layer views, and so on) included with the solution. 
The ArcGIS solution item also illustrates any dependencies items have on each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.2 (Apr 
2022) 

• Name changed from Homeless Risk Reduction to Homelessness Risk 
Reduction. 

• All layers, map, apps, and projects have been updated to use the term 
homelessness instead of homeless. 

• A new version of the Homelessness Risk Reduction ArcGIS Pro project that 
leverages an updated Create Risk Surface tool. 

1.1 (Feb 
2021) 

• A new version of the Homeless risk Reduction ArcGIS Pro project that 
leverages the Enrich geoprocessing tool. 

1.0 (Nov 
2020) 

• First release of Homeless Risk Reduction 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


 

Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal Page 181 

Configure Homelessness Risk Reduction 
Homelessness Risk Reduction can be used to identify where regular reports of homelessness 
activity may originate and address regular reports of homelessness activity in a community. 

In this topic, you'll learn how to configure the Homelessness Risk Reduction solution to meet 
specific needs of your organization. 

 

Extend homelessness activity reporter survey 
The Homelessness Risk Reduction solution includes a Homelessness Activity Reporter  survey 
that can be used to record homelessness activity. However, you can extend this survey with 
your own questions or extend the domain to record additional types of activity observed. Review 
the preconfigured questions and adjust as necessary to remain in compliance with your 
organizational policies. In addition, ensure that you secure the survey and underlying layers and 
only share the content with appropriate members of your organization. 

 

Update feature layer views 

When adding new questions, begin with the steps listed below. For changes such as removing 
questions or formatting the survey, proceed to the Modify homelessness activity reporter form 
survey section. 

To add one or more fields to a layer and recreate the views, complete the following steps: 

1. Sign in to your ArcGIS Online organization and search for the Homelessness Activity 
Reporter  hosted feature layer. 

2. Add a new field or domains to the Homelessness Activity Reporter  hosted feature layer. 

 

Modify homelessness activity reporter form 

To modify the Homelessness Activity Reporter  survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS Online organization. 

3. Click Homelessness Activity Reporter  to download the survey. 

4. Click Homelessness Activity Reporter  again to open the survey. 

5. In the left pane, click Open XLSForm Spreadsheet. 

6. In the Microsoft Excel spreadsheet, click the choices tab.  

  This tab comprises all the selectable options for survey questions. 

7. Revise the survey to reflect your needs. 

8. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 
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Use Homelessness Risk Reduction 
The Homelessness Risk Reduction solution delivers a set of capabilities that help you 
understand where regular reports of homelessness activity may originate in your community and 
actively monitor regular reports of homelessness so assistance can be offered to individuals in 
need. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Report homelessness activity 
You will assume the role of public safety staff, or a member of the public, that wants to report 
homelessness activity observed in a community. 

Follow these steps to report homelessness activity. 

1. In a browser, go to the Homelessness Activity Reporter survey. 

2. In the Homelessness Activity Reporter , provide the following information: 

  Parameter 

  Value 

  Activity Observed   Individual 

  Details   Type Observed new individual in the 
park with a tent and dog. 

  Observed On   Select a date 

  Photo   Add a photo 

  Would you like to be contacted for 
more information? 

  Select Yes 

  Your Name   Type your name 

  Phone Number   Type your phone number 

  Email   Type your email address 
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  Observed at   Type location information of where you 
observed the activity. 

3. Click Submit. 

Note: 

While using the app in the field, you can use ArcGIS Survey123 mobile app to use your 
current location from your mobile device GPS. 

 

Manage homelessness reports 
Health and human services personnel, public safety, and nonprofit organizations can 
use Homelessness Activity Manager and Homelessness Activity Dashboard to monitor, verify, 
and assign homelessness reports to agencies responsible for resolving health and safety 
concerns or providing aid to individuals and families experiencing homelessness. 

You’ll assume the role of a homelessness program lead that wants to manage reports of 
homelessness in the community. 

1. In a browser, go to the Homelessness Activity Manager. 

  The Homelessness Activity Manager shows a list of all reports that were made. 

2. In the table, highlight the first record in the table. Verify this is the record you just submitted 
via the Homelessness Activity Reporter . 

3. On the dialog box, in the lower left, click the Edit record button. 

4. Change the Status to Submitted, if necessary. 

5. In the Assigned To field, select Health and Human Services. 

  Note: 

  In many cases, individual follow up may be needed to further document and add to 
ensure you are capturing an accurate representation of homelessness in your 
community. 

6. Scroll down, if necessary, and click Save. 

Note: 

If you want to automate this process more, you can automatically send emails to individuals 
that are assigned. Refer to the Survey 123 Webhooks document to learn more. 

 

Visualize homelessness 
You’ll assume the role of a health and human service agency, or CoC, director that wants to 
view the current state of homelessness activity in your community. 

1. In a browser, go to the Homelessness Activity Dashboard app. 
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2. On the left under Type, check Individual. Explore the various filtering capabilities. 

3. On the left under Date Observed, choose Last 7 days. 

  Note: 

  You see the report you submitted in the first workflow. 

4. Close the dashboard when you are done exploring the Homelessness Reports. 

 

Identify risk of homelessness 
Data analysts can use the Homelessness Risk Reduction ArcGIS Pro project to learn which 
areas in their community are at risk for generating homelessness and how to prioritize site 
intervention programs. It leverages authoritative data and uses indicators such as 
unemployment rate, rental prices, public assistance, health insurance coverage, minority 
population, and number of veterans to compute a vulnerability to homelessness layer. The 
resulting risk surface is then used to prioritize intervention program siting. The results of this tool 
can be used as a foundation for public education and awareness campaigns, operational 
improvements, and policy discussions across an entire community. 

 

Identify areas at risk 

You’ll assume the role of a GIS analyst in a health and human service agency that wants to 
evaluate where homelessness may originate in a community and use the results to guide policy 
discussions. 

1. Open the Homelessness Risk Reduction ArcGIS Pro project and sign in to your ArcGIS 
organization. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand Tasks and double-click the Homelessness Risk Reduction 
task. 

4. Open the Identify areas at risk of generating homelessness task. 

  This task contains steps to help you define the homelessness risk criteria. 

5. In the Add risk factor point data step, select the following information. 

– In the Target Features parameter, select Census Naperville. 

– In the Join Features parameter, select Assault. 

– In the Output Feature Class parameter, browse to Databases to open the 
HomelessnessRiskReduction.gdb and type JoinedAssaults for the feature 

class in the Name text box. 

6. Click Run 

7. Click Next Step. 

8. Click the Contents tab. 

9. Right-click the output layer from the Spatial Join tool and choose Attribute Table. 

10. Right-click Join_Count and choose Fields. 

11. Change Join_Count field name and field alias to AssaultCount. 

12. Delete the TARGET_FID field the tool created. 

13. On the Fields tab, in the Changes group, click Save. 
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14. Close the attribute table and fields table. 

15. Click the Tasks tab. 

16. Click Next Step to continue. 

17. In the Add key demographic data step, fill out the information below. 

– In the Input Features parameter, click the drop-down menu and choose 
JoinedAssaults. 

– In the Output Feature Class parameter, browse to Databases to open the 
HomelessRiskReduction.gdb and type EnrichedDemographicData for the 

feature class in the Name text box. 

18. Click Save. 

19. To add additional variables, click the Add button and browse to your variable of interest. 

20. Click OK. Repeat this step to add the remaining variables. 

21. Click the Remove variables button. 

22. Click Run. 

23. Click Next Step. 

24. In the Create homelessness risk surface step, fill out the information below. 

– In the Input Features parameter, click the drop-down menu and select 
EnrichedDemographicData or your own data set. 

– In the Output Feature Class parameter, browse to Databases to open 
HomelessnessRiskReduction.gdb and type HomelessnessRiskSurface for the 

feature class in the Name text box. 

25. Click Save. 

26. In Risk Factors (High Value), click the drop-down menu and choose all your high to low 
ranking variables. 

27. In Risk Factors (Low Value), click the drop-down menu and choose all your low to high 
ranking variables. 

28. Click Run. 

  Note: 

  The AssaultCount field was created in a previous step after performing the join. 

  Based upon the factors you specified, you will see a new Risk layer appear that ranks the 
polygons from high to low. You can run the previous task multiple times ranking values 
differently. In many cases you may want to provide more inputs for data you are tracking in 
addition to assaults, such as known individuals that your organization has perhaps been 
assisting, or areas of renting issues. 

29. Click the Prioritize prevention program locations task. 

30. In Program Design step, fill out the information below. 

– In the Input Features parameter, click the drop-down menu and choose 
HomelessnessRiskSurface. 

– In the Output Feature Class parameter, browse to Databases to open 
HomelessRiskReduction.gdb and type VulnerableSurvivorsPrograms for the 

feature class in the Name text box. 

31. Click Save. 

32. In the Contributing factors parameter, click the drop-down menu and choose 
AssaultCount and ACS HHs w/Public Assist Income:Percent. 
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33. Type Assist Vulnerable Survivors in the Program Name text box. 

34. Type a value in the Number of Results text box. 

35. Click Run. 

  Repeat the above for any other programs. Use the output from your previous run as the 
Input Features. 

36. Click Next Step. 

  The result is prioritized locations where a new program can be placed, such as a woman’s 
shelter. 

  Note: 

  The next step allows you to finalize the program rankings. You may have many specific 
programs you want to act upon. Prioritizing helps you better focus your efforts. 

37. Share the map as a web layer. 

  This allows others in your organization to see the prioritized risk factors. 
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Hospitalization and PPE Inventory 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated.  

Mature phase 
Jun. 2022 – May 2024 

Retired phase 
Jun. 2024 

 

Introduction to Hospitalization and PPE 
Inventory 
Hospitalization and PPE Inventory can be used to inventory hospital bed capacity and available 
personal protective equipment (PPE) such as ventilators, face masks, medical gowns, and 
gloves. 

Many hospitals have been overwhelmed by a surge in COVID-19 patients and are dealing with 
shortages of intensive care unit beds and limited bed availability is impacting the ability to 
separate COVID-19 patients from other patients. The surge in patients has also increased the 
use of personal protective equipment (PPE), taxed supplies and threatened to impact staff 
safety. Access to timely hospitalization information and PPE utilization can help mitigate 
equipment shortages and improve the quality of patient care. Hospitalization and PPE Inventory 
is typically implemented by emergency management and public safety agencies that want to 
take a data-driven approach and understand the current capacity of health resources in their 
community. 

The Hospitalization and PPE Inventory solution delivers a set of capabilities that help you solicit 
daily hospitalization and PPE reports and monitor the capacity of hospitals and PPE availability. 

 

Requirements 
Hospitalization and PPE Inventory requires the following: 

• ArcGIS Online 

 

Information products 
Hospitalization and PPE Inventory includes the following information products: 

Item Description 
Minimum 
user type 

Hospitalization and 
PPE Dashboard 

An ArcGIS Dashboards app used by emergency 
response staff to monitor hospitalization and personal 
protective equipment (PPE) inventories 

Viewer 
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Hospitalization and 
PPE Report 

An ArcGIS Survey123 form used by a hospital or acute 
care center to report hospitalization status and PPE 
inventory 

Mobile 
Worker 

  

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new Hospitalization and PPE Dashboard. 

1.0 • First release of Hospitalization and PPE Inventory 
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Configure Hospitalization and PPE Inventory 

Extend hospitalization and PPE survey 
The Hospitalization and PPE Inventory solution includes a survey, the Hospitalization and PPE 
Report, that can be used to understand the capacity of hospitals and status of their PPE 
inventory. 

Note: 

Many organizations may want to modify the survey, remove the hospitalization questions, 
and only inventory PPE available for essential personnel. If that is the case, you can hide 
the hospitalization questions in the survey and modify the Hospitalization and PPE 
Dashboard. 

Review the preconfigured questions and adjust as necessary to remain in compliance with your 
organizational policies and any applicable laws. In addition, ensure you secure the survey and 
underlying layers and only share the content with appropriate members of your organization. 

Organizations may want to modify the Hospitalization and PPE Report survey by adding new 
survey questions. When adding new questions, begin with the Update feature layer views 
section below. For changes such as removing questions or formatting the survey, proceed to 
the Modify Hospitalization and PPE survey section. 

 

Add new fields 

The Hospitalization and PPE Inventory solution includes a series of views created from the 
HospitalizationPPEs feature layer. Organizations may want to modify the Hospitalization and 
PPE Report survey by first adding new fields to the feature layers and then configuring the 
survey to utilize the newly created fields. 

To add one or more fields to a layer and re-create the views, complete the following steps: 

• Add a new field to a layer in the Facilities hosted feature layer. 

• Browse to the view in your contents. 

• Click the Open in Map View arrow and click Add to new map. 

• Click the More Options button on the appropriate layer or table, and click Set View 
Definition. Click Define Fields. 

• Scroll to the newly created field and check the box. Click Apply.  

  The new field is added to the view’s definition. 

   

Update feature layer views 

To update a join view, complete the following steps: 

• Browse to the join view in your contents (for example, HospitalizationPPEs_current). 

• On the item details page, scroll to the URL section. Click the Copy button. 

• Paste the copied URL into Microsoft Notepad or another text editor for reference. 
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  Note: 

The feature layer name will be used below when re-creating the join. The name can be found 
after services in the URL structure and may also contain a unique GUID, for example, 
HospitalizationPPEs_current_a45f71a48587425c9b90ee5527cd26d1. 

• Delete the existing join view (for example, HospitalizationPPEs_current). 

• Add the source hosted feature layer to a new web map (for example, HospitalizationPPEs). 

• Click AnalysisSummarize Data, Join Features. 

• Configure the join using the parameters listed below: 

a. Name of join—Choose HospitalizationPPEs_current. 

b. Target layer—Choose Facilities. 

c. Layer to join to the target layer—Choose Hospitalization and PPE Reports. 

d. Fields to match—Choose name = name. 

e. Join operation—Choose Join one to one. 

f. Define which record is kept—Choose Order by create_date/Newest. 

  Note: 

  Ensure each new join view uses the names listed above. If you use the same 
names, the layers in the map and the existing dashboard widgets do not need to 
be reconfigured. If your join view contained a unique GUID, the new join view 
needs to be named with the unique GUID. 

• If necessary, uncheck Use current map extent. Check Create results as hosted feature 
layer view. 

• Update the Hospitalization and PPE Dashboard to account for the new fields you added to 
the layers. 

 

Modify the Hospitalization and PPE survey 

To modify a Hospitalization and PPE Report survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Hospitalization and PPE Report to download the survey. 

4. Click Hospitalization and PPE Report again to open the survey. 

5. In the left pane, click Open XLSForm Spreadsheet. 

6. In the MicrosoftExcel spreadsheet, click the choices tab. This tab contains all the 
selectable options for survey questions. 

7. Revise the survey to reflect your facility management needs. 

8. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 

Note: 
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To view your changes in ArcGIS Survey123, on the Download Surveys page, click 
Download to download the updated survey. 
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Use Hospitalization and PPE Inventory 
The Hospitalization and PPE Inventory solution delivers a set of capabilities that help you solicit 
daily hospitalization and PPE reports and monitor the capacity of hospitals and PPE availability. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Monitor hospitalization and PPE capacity 
The Hospitalization and PPE Inventory solution includes a Hospitalization and PPE Report 
survey that collects hospitalization and personal protective equipment (PPE) information from 
hospitals and acute care centers. Organizations deploying Hospitalization and PPE Inventory 
should review the preconfigured questions and adjust as necessary to remain in compliance 
with organizational policies and applicable laws. In addition, ensure that you secure the survey 
and underlying layers and only share the content with appropriate members of your 
organization. 

 

Complete the Hospitalization and PPE Report 

You will start by assuming the role of an employee at a hospital. You are asked by local 
emergency response staff to use the Hospitalization and PPE Report to share hospitalization 
information and the status of your PPE inventory each morning. 

  

Monitor hospitalization and PPE capacity 

Now, you will assume the role of an incident commander in a local government. You are asked 
to monitor the capacity of local hospitals and their PPE. You are looking to see if hospitals in 
your community may be close to capacity or lacking the PPE required to protect health care 
workers. You will view the overall status of hospitals and then review specific locations. 

1. In a browser, go to the Hospitalization and PPE Dashboard. 

2. The Hospitalization and PPE Dashboard opens with an overview of the current status. The 
overview displays key metrics, giving management information about the number of 
hospitals reporting, overall bed capacity, ventilators, and occupancy rates. Any COVID-19 
hospitalizations are also shown. 

3. Review the list of hospitals and click an individual hospital in the list to see more detail. 

4. Click a filter in the top panel of the dashboard to refine the results in the dashboard. 

5. You can filter by area or by hospital. 

6. Click the Personal Protective Equipment tab to review the status of equipment. 

7. Review the list of hospitals again and click an individual hospital in the list to see exactly 
how many days left of supply the hospital has. 
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Market Development 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated.  

Mature phase 
Mar. 2023 – Feb. 2025 

Retired phase 
Mar. 2025 

 

Introduction to Market Development 
Market Development can be used to understand market characteristics and performance. 

Executives and retail analysts need to understand the performance of the market landscape 
based on location. Organizations strive to increase profits by using market indicators to drive the 
decisions on where to close locations and open new locations. Understanding market 
performance based on regional and market breakdown is critical in enhancing the business 
strategy for decision makers. Market Development is typically implemented by organizations 
that want to take a data-driven approach to understand market characteristics and the 
performance of their business. 

The Market Development solution delivers a set of capabilities that helps you visualize the 
overall market landscape and communicate key business metrics with decision makers. 

 

Requirements 
Market Development requires the following: 

• ArcGIS Online 

 

Information products 
Market Development includes the following information products: 

Item Description 
Minimum 
user type 

Market Explorer 
Dashboard 

An ArcGIS Dashboards app used by analysts to 
understand the overall performance of retail stores in an 
organization from various geographies 

Viewer 

Sales Performance 
Dashboard 

An ArcGIS Dashboards app used by analysts to 
understand the overall performance of each retail store in 
an organization 

Viewer 

AssetSource An Excel document that can be used to load and validate 
an authoritative list of assets into ArcGIS 

Not required 
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SalesdataSource A .csv file that can be used to load an authoritative 
dataset of sales data into ArcGIS 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.2 • General schema update to the joined layer view. 

1.0 • First release of Market Development 
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Configure Market Development 
In this topic, you will learn how to configure the Market Development solution to meet specific 
needs in your organization. 

 

Load data 
Information must be loaded before using the Market Explorer Dashboard and Sales 
Performance Dashboard. The AssetSource and SalesdataSource can be used to organize your 
business information before loading into ArcGIS the accompanying sales data in your 
organization. 

Note: 

Ensure you populate the Asset_ID column in the AssetSource with unique values. 

You may need to load existing assets or sales data from a spreadsheet. Review the maps or 
applications provided with the solution and determine what, if any, source data you would like to 
load. 

If you do not have an inventory of assets and sales data in ArcGIS, you may have them in a 
spreadsheet or another system you can export to a spreadsheet. If you don’t have a 
spreadsheet already, you can use the sample .csv files included with the solution (AssetSource, 
SalesdataSource) to inventory your assets and sales data. 

To load your assets or sales data from a spreadsheet, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the AssetSource item. 

2.  Open the items details page. 

3. Click Download. 

4. Edit the CSV file and populate your facility information in the document. 

  Note: 

  At a minimum, you must provide a unique Asset_ID and the latitude and longitude for 
each facility in the FacilitySource. If you don't have a unique ID, you can edit the CSV file 
in Excel and copy this formula into the first row of the facilityid column: 
=CONCATENATE("Asset-", TEXT(ROW(A1),"00000")). You can then drag the right 
corner of the cell to fill the formula down for all facilities, giving each a unique ID. 

5.  In your ArcGIS organization at the top of the site, click Content. 

6. Browse to the Assets feature layer. 

7. On the item details page, click Update Data and select Append Data to Layer. 

8. Under Filename, choose your .csv file. 

9. Click Upload and Continue. 

10. Uncheck Update existing features. 

11. Click Show field matching to map the fields. 

12. Click Apply Updates. 
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13. Repeat steps 1 through 12 by downloading the SalesdataSource CSV file and updating the 
Asset Sales Data table. 

To load your data for Region Overlay, Subregion Overlay, and Competitors from a shapefile or 
file geodatabase, complete the following steps: 

1. Create a .zip file of your shapefile or file geodatabase. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile or File Geodatabase. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 
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Use Market Development 
The Market Development solution delivers a set of capabilities that helps you visualize the 
overall market landscape and communicate key business metrics with decision makers. 

In this topic, you will learn how to use the Market Development solution and the set of 
capabilities and features that it provides. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Investigate market characteristics 
The Market Explorer Dashboard application includes your organization's assets overlaid with 
demographic information such as median disposable income, retail goods spending, and 
population growth. The application allows you to conduct a series of key exploratory functions 
that support the visualization of markets in and around your business by region, market, or 
store. 

Note: 

Assets may represent your retail establishments, businesses you sell into, or distributors. 

 

Visualize market characteristics 

In this workflow, you’ll assume the role of a business analyst who is assigned the task of 
exploring a particular market. You will assume that this is a market that your organization is 
considering extending operations within and examine the potential likelihood of growth, and 
communicate this with key leadership. 

1. In a browser, go to the Market Explorer Dashboard application. 

2. In the Select a Region drop-down list, select a region. 

  Filtering will zoom in to that specific region and automatically updates the set of metrics 
along the bottom of the application and the locations in the list on the right side. 

  Note: 

  The competitor indicator panel represents the number of features within the map view. 

3. In the Select a Sub-Region drop-down list, select a sub-region. 

4. In the upper right corner of the map are a set of map settings. Click the layer visibility 
button to reveal operational layers that can be switched on or off. 

5. Switch on the layer labeled USA Population growth. 

6. Zoom in to a particular market to start exploring in more detail. 

  Notice as you zoom in or pan around, the metrics along the bottom as well as the list on 
the right side update. This map-driven capability provides context into what is within your 
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view, in and around areas of interest. Also note how the USA population growth layer 
dynamically updates to more granular level of detail depending on the scale. 

  Note: 

  Holding the Shift key on your keyboard enables the area selection tool in the map. This 
will zoom in to the extent of the selected area. 

 

Explore the performance of your business 
The Sales Performance Dashboard contains your organization's assets, with panels that 
represent your business sales data broken down by category and sales for each store. The 
application is designed to digest key information about the financial performance of your 
organization’s assets. The functionality of the Sales Performance Dashboard is used to explore 
and visualize retail stores and sales information for each retail store and overall financial 
performance of your business by region, market, or store. The map-driven metrics provide an 
overview of key financial business metrics that provide insight into the market potential. 

Note: 

Assets may represent your retail establishments, businesses you sell into, or distributors. 

 

Understand store performance 

In this workflow, you’ll assume the role of a business analyst who is assigned the task of 
understanding the sales performance in a particular market. You will assume that this is a 
market that your organization is considering extending operations within and examine the 
potential likelihood of growth, and communicate this with key leadership. 

1. In a browser, go to the Sales Performance Dashboard 

2. In the Select a Region drop-down list, select a region. 

  Filtering to the Middle Atlantic will zoom in to that specific region and automatically updates 
the set of metrics and locations in the list along the left side of the application. 

3. In the Select a Sub-Region drop-down list, select a sub-region. 

4. Zoom in to a specific market to start exploring in more detail. 

  Notice as you zoom in or pan around, the metrics and the list along the left update. This 
map-driven capability provides context into what is within your view, in and around areas of 
interest. 

  Note: 

  Holding the Shift key on your keyboard enables the area selection tool in the map. This 
will zoom in to the extent of the selected area. 

5. In the Select a Category drop-down list, select a category. 

  Notice the metrics along the left are now only showing overall sales for that specific 
category, based on the assets within the map view. 
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6. Select an asset from the list. This will zoom to the selected feature and open the pop-up for 
additional sales. The metrics will also reflect the currently selected feature. 

7. Optionally, to filter the assets in the list to a specific area of interest, click the button in the 
upper left corner of the map to enable the layer selection mode. 

8. To change the selection method, click the drop-down arrow and click the lasso tool. 

9. Hold the left mouse button and dynamically draw around an area of features to be 
selected. 

  Notice that the metrics and the list along the left update based on the selected features. 
This selection-driven capability provides an additional level of focusing based on an area of 
interest. 

   

Add premium content 
Esri Demographics is a global collection of authoritative demographic data for over 170 
countries and regions, supplying context and adding insight to the maps and location-based 
analyses of organizations worldwide. 

Market Development is configured by default with a set of information-rich demographic layers 
that can be used to visually explore key market characteristics. 

In this workflow, you will assume the role of a business analyst who is tasked with adding new 
demographic content to help enhance the ability to make decisions with new context. 

1. In a browser, sign in to your ArcGIS organization and click the Content tab. 

2. On the left side, under Folders, click Market Development. 

3. Click Market Explorer (map) to open into the item description page, then click Open in 
Map Viewer Classic. 

4. Above the contents pane, click the Add button, then click Browse Living Atlas Layers. 

5. Under Search for Layers are a set of buttons to filter and sort layers by relevance. Click 
the filter button to show additional options. 

6. Under the Categories group are a set of themes that can be selected to filter from over 
4,500 layers of ArcGIS Living Atlas content. Select a theme to explore layers and select a 
layer to view more details. 

7. Once a layer has been identified, click Add to Map. 

8. Click the Save button along the upper middle of the map and click Save. 

9. If necessary, repeat steps 1 through 8 for Sales Performance (map). 
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Multi Source Data Feeds 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated.  

Mature phase 
Jul. 2022 – Jun. 2024 

Retired phase 
Jul. 2024 

 

Introduction to Multi Source Data Feeds 
Multi Source Data Feeds solution can be used to visualize global incidents in ArcGIS. 

Businesses need access to critical information with confidence, to enable organizational 
response to incidents at different levels and across different business units. This is needed to 
allow organizations to see beyond the horizon and react to real-time incidents across the globe. 
Round-the-clock access to incident data is at the cornerstone of this need. Multi Source Data 
Feeds is typically implemented by organizations that rely on event feeds to understand incidents 
across the globe. 

The Multi Source Data Feeds solution delivers a set of capabilities that provides awareness in 
near real time to incidents around the globe. This access is enabled by Esri business partners 
that curate event information into one location and allow consumption through the business 
partner APIs. 

 

Requirements 
Multi Source Data Feeds requires the following: 

• ArcGIS Online 

• ArcGIS Pro 2.8 - 2.9 (Basic) 

 

Information products 
Multi Source Data Feeds includes the following information products: 

Item Description 
Minimum user 
type 

Dataminr Alerts 
Dashboard 

An ArcGIS Dashboards app used to visualize and 
interact with incidents from Dataminr 

Viewer 

Factal Incidents 
Dashboard 

An ArcGIS Dashboards app used to visualize and 
interact with incidents from Factal 

Viewer 

Multi Source Data 
Feeds Desktop 

An ArcGIS Pro project package used to connect and 
ingest data feeds from a variety of data providers 

GIS Professional 
Basic 
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Release notes 
The following are the release notes: 

Version Description 

1.2 • An update to the Multi Source Data Feeds Desktop project that resolves an issue 
where Twitter content does not display the source web address (BUG-
000139305). 

• An update to the Multi Source Data Feeds Desktop project that improves the 
configure base layers task. 

1.1 • Shortened the field length for all fields to cut down on storage. 

• Added support to store credentials in Credential Manager. 

1.0 • First release of Multi Source Data Feeds 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


 

Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal Page 203 

Configure Multi Source Data Feeds 
In this topic, you will learn how to configure the Multi Source Data Feeds solution to meet 
specific needs in your organization. 

 

Review the Multi Source Data Feeds project 
The Multi Source Data Feeds solution includes an ArcGIS Pro project. Before configuring the 
solution and using the workflows with your data, familiarize yourself with the contents of the 
Multi Source Data Feeds Desktop project. 

To review, complete the following steps: 

1. Start ArcGIS Pro. 

  Note: 

  Ensure that you are signed in to the user name with which Multi Source Data Feeds was 
deployed. 

2. In the lower right corner, click Open another project. 

3. In the left pane under Portal, click My Content and browse to the folder where Multi 
Source Data Feeds was deployed. Select Multi Source Data Feeds Desktop and click OK 
to open. 

4. Click the View tab along the top of the ribbon. 

5. Click Tasks in the Windows group to open the Multi Source Data Feeds Tasks to 
configure, manage, and automate the data feeds. 
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Use Multi Source Data Feeds 
The Multi Source Data Feeds solution delivers a set of capabilities that provides awareness in 
near real time to incidents around the globe. This access is enabled by Esri business partners 
that curate event information into one location and allow consumption through the business 
partner APIs. 

Note: 

To view content from premium providers, API keys must be acquired from the data 
provider. 

In this topic, you will learn how to use the Multi Source Data Feeds solution and the set of 
capabilities and features that it provides. 

 

Explore the Dataminr dashboard 
1. In a browser, sign in to your ArcGIS organization and click the Content tab. 

2. On the left side, under Folders, click Multi Source Data Feeds. 

3. Click the Dataminr Alerts Dashboard to open into the item description page, then click 
View Dashboard. 

4. Zoom in to an area of interest in the United States. 

  Note: 

  Holding the Shift key on your keyboard enables the area selection tool in the map. This 
will zoom in to the extent of the selected area. 

  Notice as you zoom in or pan around, the set of metrics along the bottom of the application 
and the alerts in the list on the left side dynamically update. This map-driven capability 
provides context into what is within your view. 

5. Along the bottom of the map are a set of tabs; click Data Overview. 

  This tab contains a set of metrics to provide context into the magnitude of alerts over time 
and by category. The metrics are based on alerts within your view. 

6. Switch to the Map Overview tab and in the Publisher Category drop-down list, select a 
value. 

  Notice that with this filter enabled, the set of metrics along the bottom of the application, the 
alerts in the list on the left side, and the map automatically update. 

7. Click an incident in the list. This will zoom to the selected feature and open the pop-up with 
additional alert details. 

8. Scroll to the bottom of the pop-up and click the link to view more details on this alert in 
Dataminr by signing in to your Dataminr account. 

 

Explore the Factal dashboard 
1. In a browser, sign in to your ArcGIS organization and click the Content tab. 
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2. On the left side, under Folders, click Multi Source Data Feeds. 

3. Click the Factal Incidents Dashboard to open into the item description page, then click 
View Dashboard. 

4. In Filter Incidents by, click This Week. 

  Notice that with this filter enabled, the inset map and the set of metrics along the right side 
of the application, the locations in the list on the left side, and the map automatically 
update. 

5. Zoom in to an area of interest in the United States. 

  Note: 

  Holding the Shift key on your keyboard enables the area selection tool in the map. This 
will zoom in to the extent of the selected area. 

  Notice as you zoom in or pan around, the set of metrics along the right side of the 
application and the locations in the list on the left side dynamically update. This map-driven 
capability provides context into what is within your view. 

6. Along the bottom of the map are a set of tabs; click Data Overview. 

  This tab contains a set of metrics to provide context into the magnitude of incidents over 
time. The metrics are based on incidents within your view. 

7. Switch to the Map Overview tab and click on an incident in the list. This will zoom to the 
selected feature and open the pop-up with additional incident details. 

  Notice the inset map on the right side of the application zooms in and centers on the 
incident. This map provides regional context and awareness of where other incidents have 
appeared. 

8. Scroll to the bottom of the pop-up and click the link to view more details on this incident in 
Factal by signing in to your Factal account. 
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Neighborhood Early Warning 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. The capabilities have been replaced with Neighborhood Stabilization.  

Mature phase 
Nov. 2023 – Oct. 2025 

Retired phase 
Nov. 2025 

 

Introduction to Neighborhood Early Warning 
Neighborhood Early Warning can be used to identify neighborhoods trending in a positive or 
negative direction and ultimately measure the fragility of neighborhoods over time. 

It leverages authoritative data and key indicators (for example, blight violations, demolitions, 
crime, utility shutoffs, sales, rental units) to identify tipping neighborhoods. The resulting maps 
are a foundation for public education and awareness campaigns, operational improvements, 
and community-based policy discussions. Neighborhood Early Warning is typically implemented 
by planning departments, building officials, health and human services agencies, blight task 
forces, and other local government agencies that monitor neighborhood change over time, 
investing in stabilization programs and need to evaluate whether their investments are effective. 

The Neighborhood Early Warning solution delivers a set of capabilities that help you create a 
neighborhood change index, measure the fragility of neighborhoods over time and share the 
results with key stakeholders. 

 

Requirements 
Neighborhood Early Warning requires the following: 

• ArcGIS Online 

• ArcGIS Pro 2.6 -2.9 (Basic, Standard, or Advanced) 

 

Information products 
Neighborhood Early Warning includes the following information products: 

Item Description 
Minimum user 
type 

Neighborhood 
Early Warning 

An ArcGIS Pro project used by data analysts to identify 
neighborhoods trending in a positive or negative direction 
and ultimately measure the fragility of neighborhoods over 
time 

GIS 
Professional 
Basic 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
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with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Neighborhood Early Warning 
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Use Neighborhood Early Warning 
The Neighborhood Early Warning solution delivers a set of capabilities that help you create a 
neighborhood change index, measure the fragility of neighborhoods over time and share the 
results with key stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Identify neighborhood change 
The Neighborhood Early Warning project can be used to understand neighborhoods trending in 
a positive or negative direction and ultimately measure the fragility of neighborhoods over time. 

You will start by assuming the role of a data analyst in a neighborhood revitalization task force 
responsible for organizing key neighborhood indicators. You are asked to use the Neighborhood 
Stabilization project to identify neighborhoods trending in a positive or negative direction. 

1. From the Neighborhood Stabilization solution, click the Neighborhood Stabilization item 
under Solution Contents to open the item details of the desktop application template. 

2. Click Download and place the contents on your computer. 

3. Using Explorer, browse to the NeighborhoodEarlyWarning.zip folder and extract it. 

4. Open the Neighborhood Stabilization ArcGIS Pro project. 

5. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

6. In the Catalog pane, expand Maps and review the maps provided. 

  Note: 

  The map provided in this project is used by data analysts to identify neighborhoods 
trending in a positive or negative direction and ultimately measure their fragility over 
time. 

7. In the Catalog pane, expand the Tasks folder, and double-click the Neighborhood Early 
Warning task. 

8. In the Tasks pane, click the How to Use Neighborhood Early Warning task group to 
expand the collection of tasks. 

9. Follow the steps in each task. 
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Configure Neighborhood Stabilization 
Neighborhood Stabilization can be used to understand current property conditions, return 
blighted properties to productive use, and engage the public in neighborhood stabilization 
conversations. 

In this topic, you will learn how to configure the Neighborhood Stabilization solution to meet 
specific needs in your organization. 

 

Load data from a shapefile or file geodatabase 
Neighborhood Stabilization can be used to understand current property conditions, return 
blighted properties to productive use, and engage the public in neighborhood stabilization 
conversations. 

Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the layers provided with the solution before sharing the maps 
or applications. 

To load data from a shapefile or file geodatabase, complete the following steps: 

1. Create a .zip file of your shapefile or file geodatabase. 

2. Sign in to your ArcGIS organization and browse to the DemolitionSites feature layer. 

  Note: 

  Prior to loading data, ensure you populate the Status field in DemolitionSites with values 
represented in the layer: Planned Demolition, Contracted Demolition, or Completed 
Demolition. 

3. From the item page, click Update Data. 

4. Follow the steps in the Update layer wizard to load your data. 

5. Repeat these steps to load data into the MortgageCounselingFacilities feature layer. 

 

Configure property surveys 
Blighted and vacant structures can have a significant impact on property value and may have 
substantial remediation costs associated with them. Property Condition Survey can be used by 
local governments to publish street-level photo collections, conduct property surveys, and 
automate the classification of property condition using ML/AI. 

 

Publish a property survey app 

The Property Condition Survey app consumes the map you authored during the publish map 
step in the ArcGIS Pro project. 

To configure the Photo Survey app, complete the following steps: 

1. Using Windows Explorer, browse to the 
\Documents\ArcGIS\Packages\PropertyConditionSurvey\commondata\userdata\PhotoSurv
ey folder and unzip it. 
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2. Open the configuration.json file in Microsoft Notepad or another text editor. 

3. Enter the web map ID for your photo survey map, for example, "webmap": 
daa3eeae86954f4cba87c044466c4c2f. 

  Note: 

  The web map ID can be found at the end of the map URL in ArcGIS Online. For 
example, in 
http://myorganization.maps.arcgis.com/home/item.html?id=2ef11dad8ff04178b2b236e86
7e9c952, the web map ID is 2ef11dad8ff04178b2b236e867e9c952. 

4. Save and close the file. 

5. Copy the PhotoSurvey folder to your web server so it can be accessed as a website or 
virtual directory. In IIS, the default web server directory is <your 
directory>\Inetpub\wwwroot\. 

6. Browse to Start > Control Panel > Administrative Tools > Internet Information 
Services (IIS) Manage. 

7. Click <your server> > Sites > Default Web Sites. 

8. Right-click the web server directory folder for the app and choose Convert to Application. 

9. Choose the DefaultAppPool application pool. 

10. Click OK. 

11. Begin using Property Condition Survey by browsing to http://<your 
server>/PhotoSurvey/default.htm. 

 

Configure the property survey app 

Use the configuration.json file to configure the Photo Survey app to your organization's needs. 
Photo randomization, guest access, thumbnail image display, and Twitter credentials can all be 
configured by modifying the following parameters: 

Parameter Description 

randomizeSelection Controls how the Photo Survey app will display photos. 

• True for random photo display (default) 

• False for ordered photo display 

allowGuestSubmissions Specifies if the Photo Survey app will allow guest or anonymous 
survey submissions. 

• True to allow guests (anonymous) to submit survey submissions 

• False to disallow guests (anonymous) to submit survey 
submissions 

showGuest Specifies if the Photo Survey app will allow guest or anonymous 
access. 

• True to allow guest (anonymous) access 
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• False to disallow guest (anonymous) access 

thumbnailLimit Sets the maximum number of thumbnails displayed in the Photo 
Survey carousel. If the number of photos for a given property 
exceeds this number, the photo carousel will not be displayed in the 
app. 

includeOverviewMap Specifies if the Photo Survey app will include an overview map. 

• True to show overview map 

• False to remove overview map 

showSkip Specifies if the Photo Survey app will include a skip button. This 
requires all surveys to be submitted. 

• True to show skip button 

• False to remove skip button 

 

Configure survey questions 

There are several options available regarding the types of survey responses that can be 
displayed in the survey panel. Choose from the options below based on the structure of your 
data as well as the desired user experience. 

Once you have determined which response type to use, choose the appropriate options in the 
Survey Questions table. 

Field Description Required information 

Field name in 
Photo Points 

Field name in the Photo Points layer that the 
survey response will be stored in. 

Field name 

Question Type Survey question type. Choose from the drop-down 
list. 

Parent, Child 

Parent 
OBJECTID 

If the question should be dependent on the 
response to a parent question, add the parent 
ObjectID of this question. 

ObjectID 

Display 
Condition(s) 

Value required to display this question. Value 

Question Text Text displayed for each survey question. Text 

Question UI Type Available question types. Choose from the drop-
down list. 

Button, List, Drop-
down list, Text, 
Number 

Image URL To display images on the survey panel, add the 
image URL. 

URL 
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Image Position Position of image in the survey panel. Choose 
from the drop-down list. 

Before, After 

Required? If the question is required for the survey, choose 
from the drop-down list. 

Yes, No 

Question Order Order of the questions as they appear in the 
survey form. 

Numeric value 

 

Configure the Neighborhood Stabilization site 
The Neighborhood Stabilization solution includes the Neighborhood Stabilization ArcGIS Hub 
site. This site can be configured with your organization's branding and used to share information 
with the public. 

Update with organizational information 

After deploying the Neighborhood Stabilization solution, the Neighborhood Stabilization Hub site 
layout requires a few updates to fit your local context. 

To update the site with your organizational information, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Neighborhood Stabilization site. 

2. From the item page, click Configure. 

3. Scroll to any sections that you want to update, hover over the card, and click the edit pencil 

 that appears in the horizontal toolbar, and then edit the content with information 
specific to your organization.  

4.  In the side panel, click Footer. 

  A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

5. Click the HTML box. 

  The HTML window appears. 

6. Make the necessary changes and click Apply. 

7. Click Save. 

8. Click the Save drop-down arrow and click Publish Draft. 

 

Share items with the public 

Several layer views, maps, and apps included in the Neighborhood Stabilization solution must 
be shared with everyone so they can be accessed by the public on the Neighborhood 
Stabilization site. 

To share items with the public, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Neighborhood 
Stabilization folder. 

2. Next to each of the following items, check the check box: 

  Name 
  Item type 
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  MortgageCounselingFacilities_public   Feature layer (hosted, view) 

  DemolitionSites_public   Feature layer (hosted, view) 

  BlightProblems_dashboard   Feature layer (hosted, view) 

  Mortgage Counseling Locator   Web Map 

  Demolition Tracker   Web Map 

  Blight Dashbaord   Web Map 

  Mortgage Counseling Locator   Web Mapping Application 

  Demolition Tracker   Web Mapping Application 

  Tax Liability Calculator   Form 

  Blight Status Dashboard   Dashboard 

  Neighborhood Stabilization   Hub Site Application 

  Neighborhood Stabilization   Hub Initiative 

  Note: 

  You will only have a Hub Initiative item if your organization has ArcGIS Hub Premium. 

3. Click Share. 
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Park Infrastructure Management 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. The capabilities have been replaced with Parks and Grounds Management. 

Mature phase 
Jun. 2023 - May 2025 

Retired phase 
Jun. 2025 

 

Introduction to Park Infrastructure Management 
Park Infrastructure Management can be used to inventory park assets, understand asset 
condition, and communicate changing asset conditions that impact park services. 

Parks improve quality of life, protect natural resources, and enhance local economies. 
Unfortunately, park agencies are increasingly burdened with overuse and many times the first 
agency to receive funding cuts during an economic downturn. As a result, they are continuously 
balancing park asset maintenance needs with available funding. The first and most critical step 
park agencies must take to prioritize asset needs is to create a park asset inventory. Park 
Infrastructure Management is typically implemented by park agencies that want to understand 
what assets they have, plan improvements, and ensure guest safety. 

The Park Infrastructure Management solution delivers a set of capabilities that help you 
inventory park assets, understand asset condition, and communicate changing asset conditions 
that impact park services. 

 

Requirements 
Park Infrastructure Management requires the following: 

• ArcGIS Online 

• ArcGIS Workforce 

• ArcGIS Field Maps 

• ArcGIS Survey123 

• ArcGIS Survey123 Connect 

 

Information products 
Park Infrastructure Management includes the following information products: 

Item Description 
Minimum 
user type 

Park Assignments An ArcGIS Workforce project used by maintenance 
supervisors to manage inspection and maintenance 
assignments. 

Editor 
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Park Field Map An ArcGIS Field Maps map used by park rangers to 
inventory, inspect and maintain park assets. 

Mobile 
Worker 

Park Request 
Manager 

A Crowdsource Manager app used by park operations staff 
to triage submitted problem reports and update the status 
of each report. 

Editor 

Park Request 
Dashboard 

An ArcGIS Dashboards app used by park operations staff 
to monitor park requests submitted by the general public 
and internal staff 

Viewer 

Park Asset 
Inventory 

A Sidebar app used by used by mapping technicians to 
create, edit, and review park assets. 

Editor 

Recreation 
Closure Manager 

An ArcGIS Web AppBuilder app used by public information 
staff to create and update recreation closures. 

Editor 

Create Park 
Assignment 

An ArcGIS Survey123 form used by park operations staff to 
create park assignments. 

Editor 

Park Request 
Internal 

An ArcGIS Survey123 form used by park rangers to submit 
service requests. 

Mobile 
Worker 

Park Request An ArcGIS Survey123form used by park visitors to submit 
service requests. 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Park Infrastructure Management 
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Configure Park Infrastructure Management 
Park Infrastructure Management can be used to inventory park assets, understand asset 
condition, and communicate changing asset conditions that impact park services. 

In this topic, you'll learn how to configure the Park Infrastructure Management solution to meet 
specific needs in your organization. 

 

Load data from a shapefile or file geodatabase 
Park Infrastructure Management can be used to inventory park assets, understand asset 
condition, and communicate changing asset conditions that impact park services. 

Review the layers provided with the solution and determine what source data you want to load. 
Then, load your existing data into the layers provided with the solution before sharing the maps 
or applications. 

To load data from a shapefile or file geodatabase, complete the following steps: 

1. Create a .zip file of your shapefile or file geodatabase. 

2. Sign in to your ArcGIS organization and browse to the feature layer that you want to 
populate. 

3. Open the item page and click Update Data. 

4. Follow the steps in the Update data wizard to load your data. 

  Tip: 

  For more information about uploading data, see Manage hosted feature layers—Append 
data to layers. 

 

Modify inspection and maintenance types 
The Park Infrastructure Management solution helps you assess park asset condition and record 
maintenance activities. Inspection and maintenance types are defined on the ParkAssets 
feature layer and appear in the Park Field Map when park rangers are recording their work. In 
some cases, you may want to modify inspection and maintenance types to meet your 
organization’s needs 

1. Verify that you are signed in to your ArcGIS organization and browse to the ParkAssets 
feature layer. 

2. Open the item page and click the Data tab. 

3. Click the Layer drop-down and select Trails Inspection. 

4. Click Fields. 

5. Click the Inspection Type display name. 

6. Click Create List. 

7. Type the new inspection type into the Displayed Value and Stored Value text boxes. 

8. Optionally, click Add to create additional inspection types. 

9. Optionally, click the Delete button to remove an inspection type from the list. 
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10. Repeat steps 8 and 9 to add the remaining inspection types. 

11. Optionally, drag the category to a new location in the list to reorder them. 

12. Click Save. 

13. Click the Layer drop-down and select Trails Maintenance. 

14. Click the Maintenance Type display name. 

15. In the List of Values (Domain) section, repeat steps 6-12 to add maintenance types. 

16. Repeat this process for the remaining inspection and maintenance tables (Barriers, Gates, 
Roads, Structures). 

 

Administer field assignments 
The Park Infrastructure Management solution can be used to manage work such as data 
collection, routine and ad-hoc inspections, and maintenance assigned to park rangers. Types of 
assignments appear in the Park Assignments app used by park rangers as well, the Park 
Assignments ArcGIS Workforce project and the Create Park Assignment ArcGIS Survey123 
form. 

The Park Infrastructure Management solution includes several assignment types. In some 
cases, you may want to modify inspection and maintenance types to meet your organization’s 
needs. Park rangers and dispatchers also need to be assigned roles in the Park Assignments 
ArcGIS Workforce project. 

 

Administer park assignments 

1. Sign in to your ArcGIS organization and click the Apps button  in the header of the site. 

2. From the app launcher, click Workforce to open the app. 

3.  Under Projects, hover over the Park Assignments project, and click Configure. 

4. At the bottom of the pane, click the Assignments tab. 

5. Type a new assignment type in the Enter a new type text box then click + Type button. 

6. To remove assignment types, click the X button. 

7. Click the Users tab. 

8. From the Project Role menu, assign the user either the dispatcher role or mobile worker 
role. 

9. Click +User. 

10. Click the Advanced tab. 

11. In the ArcGIS Field Maps, click Edit on any of the existing Park Field Map integrations. 

12. Click the Done button. 

 

Update create park assignment form 

1. In your ArcGIS organization, browse to the Park Assignments feature layer. 

2. Open the item page and click Open in Map Viewer. 

3. On the Contents (dark) toolbar, click Tables. 

4. Click Assignment Types layer. 

5. Click Tools in the table header and check the GlobalID field to show (unhide) in the table. 
Click Done to close the pop-up window. 
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6. Expand the GlobalID field and copy each new assignment type's ID.  

7. Paste the copied GlobaIID or GlobalIDs into a text editor for reference. 

8. Install ArcGIS Survey123 Connect. 

9. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

10. Click Create Park Assignment to download the survey. 

11. In the Download window, click Download and click OK. 

12. Click Create Park Assignment to open the survey. 

13. On the left, from the side toolbar, click the XLSForm button. 

14. At the bottom of the Microsoft Excel spreadsheet, click the choices tab. 

  This tab comprises all the selectable options for survey questions. 

15. In the list_name column type ASSIGN_TYPE.  

16. In the name column, copy and paste the GlobalID, before and after the GlobalID add curly 
braces. 

  For example, {5b3e80df-aec7-4739-929f-8cb70cdbd62c}. 

17. In the label column, type the assignment type. 

18. Repeat steps 15 through 17 for each new assignment type. 

19. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

20. In ArcGIS Survey123 Connect, in the left toolbar, click Publish to publish your changes. 

21.  Click Publish survey to publish your changes, and then click OK. 

 

Modify service request types 
The Park Infrastructure Management solution can be used to solicit park requests for service 
from park rangers as well as the general public. Service request types appear in the Park 
Request Internal and Park Request ArcGIS Survey123 forms. 

The Park Infrastructure Management solution includes several service request types. In some 
cases, you may want to modify service request types to meet your organization’s needs, for 
example you may want some requests to be available to park rangers using the Park Request 
Internal form that are not available to the general public using the Park Request form. 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Park Request to download the survey. 

3. In the Download window, click Download and click OK. 

4. Click Park Request to open the survey. 

5. On the left, from the side toolbar, click the XLSForm button. 

6. At the bottom of the Microsoft Excel spreadsheet, click the choices tab. 

  This tab comprises all the selectable options for survey questions. 

7. In the list_name column type reqtype.  

8. Type the new service request type into the name and lable columns. 

9. Repeat steps 7 and 8 for each new service request type. 

10. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

11. In ArcGIS Survey123 Connect, in the left toolbar, click Publish to publish your changes. 

12.  Click Publish survey to publish your changes, and then click OK. 
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13. Click Park Request Internal to download the survey. 

14. Repeat steps 3 through 12 to add new service request types to the Park Request Internal 
form.  
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Use Park Infrastructure Management 
The Park Infrastructure Management solution delivers a set of capabilities that help you 
inventory park assets, understand asset condition, and communicate changing asset conditions 
that impact park services. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Inventory and assess park assets in the field 
In many cases, a field assessment of existing park assets may be the most efficient way to 
develop a park asset inventory. The information collected in the field can then be augmented 
with other descriptive information that helps park staff or the general public view park 
information easily. 

You will assume the role of a park ranger in a park agency. In this workflow, you are asked to 
use the ArcGIS Field Maps mobile app to access your Park Field Map and inventory park 
assets. 

 

Collect park assets in the field 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open ArcGIS Field Maps and sign in to your ArcGIS organization. 

3. Tap the Park Field Map to open it. 

4. Browse to the collection location. 

5. Tap Add and tap Restrooms. 

6.  Swipe up on the form and tap Name to enter the name of the restroom. 

7.  Tap Park to enter the name of the park. 

8.  Tap Amenity Details to expand the form. 

9.  Tap Condition and choose a value. 

10.  Tap Owned By and choose a value. 

11.  Tap Maintained By and choose a value. 

12.  Swipe down and tap Take Photo, and then take a photo and tap Use Photo. 

13. When you're finished, at the top right, tap the check mark or Submit. 

  Note: 

  Your interface may vary depending on the type of mobile device that you use. 

14. Repeat steps 6 through 14 for each park asset. 

 

Assess park assets in the field 

1. Tap a trail in the Park Field Map. 

2.  Swipe up on the form to review the trail information. 

3. Swipe up on the form to the Related section. 
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4. Tap Trails Maintenance. 

  Previously recorded maintenance activities are displayed. When present, tap the 
maintenance record and swipe up on the form to review the information. 

5. Tap Add. 

6. Swipe up on the form to expand the form. 

7. Tap Maintenance Type to enter the type of maintenance activity completed.  

8. Tap Maintenance Status and choose Completed.  

9. Tap Date finished and choose today's date. 

10. Optionally, tap Notes to enter maintenance notes. 

11. When you're finished, at the top right, tap the check mark or Submit. 

  Note: 

  Your interface may vary depending on the type of mobile device that you use. 

12. Swipe up on the form to review the recorded maintenance information.  

13. In the Related section, tap Trails to return to the Trail feature. 

14. Swipe up on the form to the Related section. 

15. Tap Trails Inspection. 

  Previously recorded inspections are displayed. When present, tap the inspection record 
and swipe up on the form to review the information. 

16. Tap Add. 

17. Swipe up to expand the form. 

18. Tap Condition and choose a value. 

19.  Tap Inspection Type and enter a value. 

20.  Tap Needs Maintenance and choose Yes. 

21. Tap Inspection Date and choose today's date. 

22.  Swipe down and tap Take Photo, and then take a photo and tap Use Photo. 

23. When you're finished, at the top right, tap the check mark or Submit. 

  Note: 

  Your interface may vary depending on the type of mobile device that you use. 

24. Swipe up on the form to review the recorded inspection information. 

25. In the Related section, tap Trails to return to the Trail feature. 

26. Swipe up on the form and tap the Create service request button. 

27. Complete the Park Request form to report a request for service. 

28. When you're finished, at the top right, tap the check mark or Submit. 

  Note: 

  Your interface may vary depending on the type of mobile device that you use. 
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Complete field assignments 

Park Rangers will often receive work through assignments that help organize tasks to be 
completed and communicate the status of work to maintenance supervisors. In this workflow, 
you are asked to use the ArcGIS Workforce app on your mobile device to track the status of 
your work in the field. 

1. Download ArcGIS Workforce onto your mobile device. 

2. Open ArcGIS Workforce and sign in to your ArcGIS organization. 

3. Tap the Park Assignments map. 

4. In the To do list, tap an assignment to view its location on the map and see details about 
the assignment. 

5. In the assignment details, tap Directions to see a list of installed navigation apps, and then 
tap the app you want to use and allow ArcGIS Workforce to open it. 

  The app opens, generating a route to your assignment. 

6. In the assignment details, tap Start to begin working on an assignment. 

7. Optionally, tap Add Note to enter information for the maintenance supervisors. Tap Done. 

8. Optionally, tap Take Photo to take and attach a photo. 

9. Optionally, tap Attach to record video and audio and to attach other photos from your 
device. 

10. Swipe up and tap Open in Field Maps. 

  The Park Field Map opens in ArcGIS Field Maps. 

11. After you have finished collecting data or recording work in the Park Field Map return to the 
ArcGIS Workforce app. 

12. To pause, decline, or reset the assignment, tap the Overflow button  and tap the 
appropriate status, or tap Cancel. 

13. In the assignment details, tap Finish when you have completed the assignment. 

14. Optionally, tap To Do and tap Completed to view your completed assignments. 

15. Optionally, tap Sync  (  if you have edits that aren't synced) and tap Sync Now to 
sync them. 

  Changes to the status of your assignments automatically syncs with your ArcGIS 
organization at the default interval of every 15 minutes. 

   

Develop park asset inventory 
The Park Asset Inventory app can be used by mapping technicians to create, edit, and review 
park assets. Existing park assets collected in the field can be reviewed and information added to 
help park staff and the general public find information about a park. New park assets can also 
be added to a park asset inventory using imagery and record documents. 

You will assume the role of a mapping technician in a park agency. In this workflow, you are 
asked to review park assets collected by field staff and add new park assets. The steps below 
provide guidance; however, you can enter information as you see fit and examine the different 
dependencies in the form. 
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Review park assets collected in the field 

1.  Sign in to your ArcGIS organization and browse to the Park Asset Inventory app. 

2. Open the item page and click View Application. 

3. Open the Filter panel and click the Trailheads: Needs Review filter to display trailheads 
that need to be reviewed. 

4. Open the Edit panel and click Edit feature. 

5. Select a trailhead on the map. 

6. In the panel, review the attribute information and enter the remaining details for the 
trailhead. 

7. Set Status to Open, Publicly Visible to Yes, and Reviewed to Yes. 

8. When you're finished, click Update. 

 

Add a new park asset 

1. In the Park Asset Inventory app, open the Edit panel, and click Add feature. 

2. Type Trails into the Filter types search box, and click the Trails feature template. 

3. Add a new trail to the map. 

4. Enter the following trail details: 

  Parameter 
  Value 

  Asset ID   Type T1-0004. 

  Name   Type McDowell Grove Trail. 

  Park Name   Type McDowell Park. 

  Trail System   Type McDowell Park. 

  Status   Choose Open. 

  Reviewed   Choose Yes. 

  Seasonal   Choose No. 

  Hiking   Choose Yes. 

  Mountain Biking   Choose Yes. 

  eBikes   Choose No. 
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  Dogs Allowed   Choose Yes. 

  Surface Type   Choose Native. 

  Publicly Visible   Choose Yes. 

  Install Date   Choose today's date. 

  Owned By   Choose Our Agency. 

  Managed By   Choose Our Agency. 

5. Scroll to the bottom of the form and click Add. 

6. Repeat all of the steps for each park asset. 

 

Update recreation closure information 
Communicating the status of recreation opportunities helps visitors plan trips and reduces 
congestion and overuse of resources. The Recreation Closure Manager app can be used by 
public information staff to create and update recreation closures. 

 

Create recreation closure 

1.  Sign in to your ArcGIS organization and browse to the Recreation Closure Manager app. 

2. Open the item page and click View Application. 

  The Manage Recreation Closures widget is opened by default, which allows you to create 
and edit existing recreation closures. 

3. In the Search widget, type an address. 

4. In the Manage Recreation Closures widget, click the Closures template and add a new 
recreation closure to the map. 

5. Enter the following recreation closure details: 

  Parameter 
  Value 

  Name   Type Trail Maintenance. 

  Type   Choose Temporary Closure. 

  Reason   Choose Maintenance. 

  When   Type Winter 2021 to Spring 2022. 
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  Comment   Type Trail closed Winter 2021 to Spring 2022. 

6. Click Save. 

 

Update asset status 

1. Open the Update Public Status widget. 

2. Select the Freehand Polygon selection tool, and select the assets associated with the 
recreation closure. 

3. For Status, choose Closed. 

4. Click Save. 

Note: 

When you create recreation closures and update asset status information using the 
Recreation Closure Manager app, the recreation locators deployed with the Recreation 
Outreach solution will automatically be updated with the new information. 

 

Manage operations 
You will now assume the role of a maintenance supervisor responsible for organizing routine 
and ad-hoc inspections and maintenance activities. In this workflow, you are asked to monitor 
field activities and conditions, manage requests for service, and assign work. 

 

Respond to requests for service 

1.  Verify that you are signed in to your ArcGIS organization and browse to the Park Request 
Manager app. 

2. Open the item page and click View. 

3. Click the Status column filter. 

4. Click the Status is drop-down arrow and choose Submitted to view requests for service 
with a submitted status. 

5. Click the Submitted On column and choose Sort in descending order. 

6. Click one of the service request features to view its details. 

7.  On the Details tab, click the Edit button . 

8. Click the Status drop-down arrow and choose Received. 

9. Click Save. 

  You will create an assignment so the request for service can be addressed by park 
rangers. 

10. Click the service request feature in the table to view its details. 

11.  On the Details tab, click the Create Park Assignment button. 

  The Create Park Assignment form opens. 

12. Complete the form to create an assignment that you will assign to park rangers.  
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13. When you're finished, click Submit. 

 

Monitor requests for service 

1.  Verify that you are signed in to your ArcGIS organization and browse to the Park Request 
Dashboard. 

2. Open the item page and click View Dashboard. 

3. Use the graphs to filter and explore active and resolved requests for service. 

  Dashboard charts are linked. As you click and select a category in one chart, related 
details are filtered and updated in other charts on the service request to allow a manager to 
identify issues and areas that need attention. 

 

Manage field assignments 

1. Sign in to your ArcGIS organization and click the Apps button  in the header of the site. 

2. From the app launcher, click Workforce to open the app. 

3.  Under Projects, hover over the Park Assignments project, and click Open to open the 
project. 

  Tip: 

  When implementing the Park Infrastructure Management solution in your organization, 
you must add everyone responsible for verifying park assignments in the field to the Park 
Assignments ArcGIS Workforce project with a Mobile Worker role. You can add users 
and assign roles in the configuration settings of the project. To access the configuration 
settings, hover over the Park Assignments project and click Configure. Click the Users 
tab. For the purposes of this exercise, ensure that your named user account is assigned 
as a dispatcher and as a mobile worker. Click the My Projects tab to return to your 
projects. 

4. At the bottom of the pane, click the Assignments tab. 

5. If present, click on an assignment from the list of assignments.  

6. Click the Assign drop-down and select a mobile worker who will complete the work. 

7. Optionally, click the Edit button to modify the Priority, Description or other assignment 
details. When you're finished, click Save. 

8. Click the back button. 

9. On the map, select a park asset. Review the asset information then click + Create 
Assignment. 

  You can also use the search box on the map to search by address, place, or park asset ID. 

10. Choose an Assignment Type and assign a mobile worker. 

11. Click Create Assignment. 
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Racial Equity Community Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. The capabilities have been replaced with Social Equity Analysis.  

Mature phase 
Nov. 2023 – Oct. 2025 

Retired phase 
Nov. 2025 

 

Introduction to Racial Equity Community 
Outreach 
Racial Equity Community Outreach can be used to communicate progress made on racial 
equity initiatives or programs to the public and other interested stakeholders. 

Many local communities have developed equity plans, cocreated with employees and 
community partners, that serve as a road map for action and change. They serve as a guide for 
pro-equity policies, planning, services, and work practices that advance equity in a community 
and address institutional racism to ensure opportunities exist for all constituents. Promoting the 
plans and communicating progress on key initiatives or programs is critical to any pro-equity 
agenda. Racial Equity Community Outreach is typically implemented by local government 
agencies that want to take action and implement change in their communities. 

The Racial Equity Community Outreach solution delivers a set of capabilities that help you 
communicate key racial equity initiatives or programs, visualize workforce diversity metrics, 
gauge public sentiment, and share authoritative information about racial equity with the 
community. 

 

Requirements 
Racial Equity Community Outreach requires the following: 

• ArcGIS Online 

 

Information products 
Racial Equity Community Outreach includes the following information products: 

Item Description 
Minimum 
user type 

Racial Equity 
Community 
Outreach 

An ArcGIS Hub site used by the general public to 
learn more about progress made on racial equity 
initiatives or programs 

Not 
required 

Workforce An ArcGIS Hub page used by organizations to 
communicate workforce diversity metrics and 

Not 
required 
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Workforce programs designed to create a representative 
workforce 

Racial Equity and 
Inclusion Community 
Survey 

An ArcGIS Survey123 form used by the public to 
provide feedback on racial equity initiatives or 
programs 

Not 
required 

Workforce Diversity 
Dashboard 

An ArcGIS Dashboards app used by the public to 
monitor workforce diversity metrics 

Not 
required 

  

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Racial Equity Community Outreach 
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Configure Racial Equity Community Outreach 
Racial Equity Community Outreach can be used by government agencies to communicate 
progress made on racial equity initiatives or programs to the public and other interested 
stakeholders. 

In this topic, you will learn how to configure the Racial Equity Community Outreach solution to 
meet specific needs in your organization. 

 

Load data from a shapefile or file geodatabase 
Workforce or employee information must be loaded into the workforce feature layer before using 
the Workforce Diversity Dashboard. This information is typically sourced from a government 
organization’s human resources (HR) system and can be loaded from a spreadsheet into 
ArcGIS Online. If you do not have this information in an HR system, you can enter your 
workforce information directly into the ArcGIS Online feature layer. 

Review the layers provided with the solution and determine what source data you would like to 
load. Then, determine how you may source this information from a spreadsheet that you have 
exported from your HR system. 

To load data from a shapefile or file geodatabase, complete the following steps: 

1. Create a .zip file of your shapefile or file geodatabase. 

2. Sign in to your ArcGIS organization and browse to the feature layer that you want 
to populate. 

3. From the item page, click Update Data. 

4. Follow the steps in the Update layer wizard to load your data. 

 

Modify the racial equity survey 
The Racial Equity Community Outreach solution includes a Racial Equity and Inclusion 
Community Survey that can be used to gather feedback on racial equity initiatives or programs 
from the public. Review the preconfigured questions and align the survey with your 
organizational policies and desired outcomes. 

To modify the Racial Equity and Inclusion Community Survey, complete the following steps: 

• Sign in to your ArcGIS Online organization and browse to the Racial Equity and 
Inclusion Community Survey. 

• Open the item page, click Open in Survey 123 and select Manage in Survey123 
website from the drop-down list. 

• Click the Design tab. 

• Make your edits to the survey and save the changes. 

• Click Publish. 
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Configure the Racial Equity Community Outreach site 
The Racial Equity Community Outreach solution includes the Racial Equity Community 
Outreach ArcGIS Hub site. This site can be configured with your organization's branding and 
used to share information with the public. 

 

Update with organizational information 

After deploying the Racial Equity Community Outreach solution, the Racial Equity Community 
Outreach Hub site layout requires a few updates to fit your local context. 

To update the site with your organizational information, complete the following steps: 

• Verify that you are signed in to your ArcGIS organization and browse to the Racial 
Equity Community Outreach site. 

• From the item page, click Configure. 

• Scroll to any sections that you want to update, hover over the card, and click the 

edit pencil  that appears in the horizontal toolbar, and then edit the content with 
information specific to your organization.  

•  In the side panel, click Footer. 

  A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

• Click the HTML box. 

  The HTML window appears. 

• Make the necessary changes and click Apply. 

• Click Save. 

• Click the Save drop-down arrow and click Publish Draft. 

 

Share items with the public 

Several layer views, maps, and apps included in the Racial Equity Community Outreach 
solution must be shared with everyone so they can be accessed by the public on the Racial 
Equity Community Outreach site. 

To share items with the public, complete the following steps: 

• Verify that you are signed in to your ArcGIS organization and browse to the Racial 
Equity Community Outreach folder. 

• Next to each of the following items, check the check box: 

  Name 
  Item type 

  Racial Equity and Inclusion Community 
Survey_public 

  Feature layer (hosted, 
view) 
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  Workforce_dashboard   Table (hosted, view) 

  Racial Equity and Inclusion Community Survey   Form 

  Workforce Diversity Dashboard   Dashboard 

  Workforce   Hub Page 

  Racial Equity Community Outreach   Hub Site Application 

  Racial Equity Community Outreach   Hub Initiative 

    

  Note: 

  You will only have a Hub Initiative item if your organization has ArcGIS Hub Premium. 

• Click Share. 

•  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

• Click Update. 
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Use Racial Equity Community Outreach 
The Racial Equity Community Outreach solution delivers a set of capabilities that help you 
communicate key racial equity initiatives or programs, visualize workforce diversity metrics, 
gauge public sentiment, and share authoritative information about racial equity with the 
community. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Review equity programs 
Racial equity programs develop goals and outcomes that will result in improvements for all 
groups, but the strategies are targeted based on the needs of a particular group. Many 
communities have developed equity plans, cocreated with employees and community partners, 
that serve as a roadmap for action and change. They serve as a guide for pro-equity policies, 
planning, services, and work practices that advance equity in a community. Promoting equity 
plans and communicating progress on key initiatives or programs is critical to any pro-equity 
agenda. 

In this workflow, you will assume the role of a resident or member of the public. You are 
interested in equity programs or initiatives adopted by your community and progress made 
toward creating a more equitable community. 

1. In a browser, from the Racial Equity Community Outreach solution, view the Racial 
Equity Community Outreach ArcGIS Hub site. 

2. Review the message from leadership, community focus, and performance metrics. 

3. Scroll to the Tell Us How We're Doing section, and then click Share your 
feedback. 

  The Racial Equity and Inclusion Community Survey form opens in a new browser tab. 

4. Complete the survey and click Submit, and then close the browser tab. 

5. Return to the Racial Equity Community Outreach site. 

6. Scroll to the Key Program Areas section.  

7. Review the Workforce program information, and then click Learn more. 

  The Workforce program page opens to the Workforce Diversity Dashboard. The Overview 
tab displays key diversity metrics. 

8. In the upper-right corner of the dashboard, click the drop-down arrow and choose a 
department or agency.  

  The diversity metrics update with diversity metrics specific to your selection. 

9. In the lower-left corner of the dashboard, click the Details tab. 

10. Review the Featured Events and Workforce Diversity Resources parameters on 
the page. Click One Community in the upper left corner of the page when you're 
done reviewing. 
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Road Network Data Management 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. The capabilities have been replaced with Roadway Management. 

Mature phase 
Nov. 2023 – Oct. 2025 

Retired phase 
Nov. 2025 

 

Introduction to Road Network Data Management 
Road Network Data Management can be used to maintain an authoritative inventory of roads, 
intersections, and physical road characteristics and track legal agreements executed with a 
public works agency. 

It provides a series of workflows and standard road layers that streamline the maintenance of a 
public road repository, their physical characteristics, and legal agreements defining 
maintenance services provided by the organization. Road Network Data Management is 
typically implemented by public works and transportation departments that want to develop and 
maintain a public road repository that supports a variety of maintenance functions. 

The Road Network Data Management solution delivers a set of capabilities that help you 
maintain a standard set of public road layers, streamline road data management workflows, 
track maintenance agreements, and continuously improve the quality of public road information. 

 

Requirements 
Road Network Data Management requires the following: 

• ArcGIS Online 

• ArcGIS Pro 2.5 or later (Standard or Advanced) 

 

Information products 
Road Network Data Management includes the following information products: 

Item Description 
Minimum user 
type 

Road Network 
Data Management 

An ArcGIS Pro project used by mapping technicians to 
maintain an authoritative inventory of public roads, road 
intersections, and physical road characteristics 

GIS 
Professional 
Standard 

Road Maintenance 
Agreements 

An ArcGIS Web AppBuilder app used by engineers and 
operations staff to track legal agreements executed with 
a public works agency 

Editor 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Road Network Data Management 
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Use Road Network Data Management 
The Road Network Data Management solution delivers a set of capabilities that help you 
maintain a standard set of public road layers, streamline road data management workflows, 
track maintenance agreements, and continuously improve the quality of public road information. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Manage road network data 
You will start by assuming the role of a mapping technician responsible for maintaining an 
inventory of public roads, road intersections, and physical road characteristics. The Road 
Network Data Management ArcGIS Pro project includes a series of tasks to help guide you 
through these workflows. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Road Network 
Data Management solution. 

2. Download the Road Network Data Management desktop application template, and then 
unzip the folder. 

3.  From the unzipped folder, open the Road Network Data Management ArcGIS Pro project 
in ArcGIS Pro. 

4. In the Catalog pane, expand the Tasks folder, and then double-click the Road Network 
Data Management task item. 

  Note: 

  If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, expand the How to use Road Network Data Management task group 
to see the collection of tasks. 

 

Add roads 

Roads are line segments representing centerlines of all public roadways or carriageways that 
support asset management and mapping. Typically, this information is compiled from 
authoritative road centerlines maintained for addressing purposes. 

1. To add new public roads, follow the steps in the Add roads task. 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


 

Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal Page 236 

Add intersections 

When creating new roads, existing roads are split at intersections along the new road. An 
inventory of road intersections with the names of relevant crossroads is often required by 911 
systems and to manage right-of-way assets. 

1. To add new road intersections, follow the steps in the Add intersections task. 

 

Add road characteristics 

A series of map layers is used to track the characteristics (for example, ownership, functional 
classification, speed limit, physical characteristics, and special routes) of each public road. The 
feature classification and type schema for the roads is based on a functional classification of 
roads provided by the Federal Highway Administration (FHWA). Specific attributes and default 
values vary for each feature type. 

1. To add new road characteristics, follow the steps in the Add road characteristics task. 

 

Track maintenance agreements 
You will now assume the role of an engineer or operations staff at a public works agency. You 
are responsible for managing the legal agreements defining maintenance services provided by 
the agency for assets within the public right-of-way. 

1. In a browser, from the Road Network Data Management solution, view the Road 
Maintenance Agreements app. 

  The app opens with the Create Maintenance Agreement open on the right. 

2. In the Create Maintenance Agreement widget, choose a template. 

3. Click the map to start a sketch. 

4. Click the map to add additional vertices and double-click to finish the sketch. 

  After you finish the sketch, the Road Maintenance Agreements legal agreement form 
opens in the Create Maintenance Agreement widget. 

5. Complete the details of the legal agreement. 

6. Click Save. 

7. At the top right, click the Filter Maintenance Agreement button to open the widget.  

8. Filter for the asset type that you just added. 

9. On the map, select an agreement to view its details. 
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Transportation 511 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. 

Mature phase 
Mar. 2024 – Feb. 2025 

Retired phase 
Mar. 2025 

 

Introduction to Transportation 511 
Transportation 511 can be used to share road conditions and closures that may impact travel 
throughout a community or state. 

Established in July 2000 by the Federal Communications Commission, 511 is the nationally 
designated, three-digit telephone number for traveler information. 511 provides a simple number 
travelers can use to access road and traffic information from within the jurisdiction they are 
traveling. Many 511 systems now include a map-based application that includes real-time 
incident and weather information. The application provides 24/7 access to critical information, 
and the location-enabled search allows travelers to quickly find traffic incidents, travel 
restrictions, road conditions, closures, live traffic camera feeds, and other transportation 
information.  Transportation 511 is typically implemented by public works or transportation 
agencies that want to provide the public with current road conditions and traffic information. 

The Transportation 511 solution delivers a set of capabilities that help you import critical 
information from your incident management system and share roadway information with the 
public so they can make informed decisions before they travel. 

 

Requirements 
 Transportation 511 requires the following: 

• ArcGIS Online 

 

Information products 
 Transportation 511 includes the following information products: 

Item Description 
Minimum 
user type 

Transportation 
511 

An ArcGIS Web AppBuilder for the general public to 
understand roadway conditions and closures that may impact 
travel throughout a state. 

Not required 

Overwrite 
Features 

A Python script and sample file geodatabase that you can 
schedule to update the Transportation 511 app with real-time 
traffic and roadway condition information. 

Creator 
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Release notes 
The following are the release notes: 

Version Description 

1.0 (Feb 2021) • First release of Transportation 511 
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Configure Transportation 511 
In this topic, you will learn how to configure the Transportation 511 solution to meet specific 
needs in your organization. 

 

Add a real-time traffic layer 
Add additional context to your Transportation 511 app by including World Traffic Service from 
ArcGIS Living Atlas. Part of a larger collection of Esri curated content, World Traffic Service 
presents historical and near real-time traffic information for different regions of the world. This 
dynamic traffic map service is updated every 5 minutes, includes traffic incidents and provides 
visualizations for different traffic speeds relative to the free flow of traffic. 

Note: 

World Traffic Service is licensed under the Esri Master License Agreement and is exclusive 
content for Esri subscribers. Use of this service requires an ArcGIS Online organization 
subscription or an ArcGIS developer account. ArcGIS Living Atlas subscriber content does 
not consume ArcGIS Online credits. 

 

Configure map 

To leverage Esri’s World Traffic Service in your Transportation 511 app, you first must add the 
service to your map. 

1. Sign in to your ArcGIS organization and browse to the Transportation 511 map. 

2. Open the item page and click Open in Map Viewer Classic. 

3. Click Add > Browse Living Atlas Layers. 

4. Type traffic in the search text box. 

5. Click the Add button  World Traffic Service to add it to the map. 

Tip: 

You may determine you do not want to display the Traffic Incidents layers from World 
Traffic Service as this is already a layer you will provide. Before proceeding to the next 
step, click the Back button and in the Contents pane, expand the World Traffic Service 
group layer. Uncheck the North America Traffic Incidents (or your region if outside North 
America) layer group to ensure these layers are not visible in the Transportation 511 
app. 

6. Click Save. 

 

Configure the app 

Once the World Traffic Service layer is added to your map, additional steps are needed to 
configure the service to properly display in your Transportation 511 app. 
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Enable subscriber content access 

ArcGIS Web AppBuilder provides configuration options to allow public access though your 
organization to ArcGIS Living Atlas subscriber content. Follow the steps below to enable 
subscriber content in your Transportation 511 app. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Transportation 
511 app. 

2. Open the item page and click Edit Application. 

3. Click the Attribute tab. 

4. Click Subscriber content access. 

5. Under Map layers, click to ensure World Traffic Service has been enabled. 

6. Click Save. 

  When all items related to the Transportation 511 app are shared publicly, World Traffic 
Service will be available to the public through your app. 

   

Configure World Traffic Service Incidents with the Road Conditions widget 

Optionally, you can display traffic incidents from World Traffic Service in the Transportation 511 
app the same way as Road Condition layers are displayed from your feature collection. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Transportation 
511 app. 

2. Open the item page and click Edit Application. 

3. Click the Widget tab. 

4. Click Set the widgets in this controller. 

5. Hover over the Road Conditions widget and then click the Configure this widget button 

. 

6. Click Add Layer three times. 

  Each time you click Add Layer, the following layers are added to the Road Conditions 
widget: Traffic Incidents Overview, Traffic Incidents Intermediate, and Traffic Incidents 
Detailed. 

  Note: 

  The World Traffic Service Traffic Incident layers are scale dependent. If you want your 
app to display Traffic Incident information and counts at all scales, you must add all three 
layers to the Road Conditions widget configuration. 

7. Provide a label for each of the layers added, for example: World Traffic Service Incidents. 

8. Click OK. 

9. Click Save. 

 

Troubleshoot Overwrite Hosted Features script errors 
The table below describes common errors that can occur when running the Overwrite Hosted 
Features script and how to resolve each. 
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Script error Resolution 

Unable to find feature 
service with ID: {ID} 

Verify the Item ID for your feature service and the baseURL entered 
for your ArcGIS organization. 

Unable to find feature 
collection with ID: {ID} 

Verify the Item ID for your feature collection and the baseURL 
entered for your ArcGIS organization. 

File GDB: {path to 
zipped file geodatabase} 
could not be found 

Verify the path and file name for your zipped file geodatabase. 

Cannot add the item Verify that the user name used in the configuration does not already 
own a file geodatabase item with the same name as input to the 
fgdb parameter. 

IOError: [Errno 2] No 
such file or directory: 
{Log File Path} 

Verify that the script can write to the file path location configured for 
the log. 

Error Processing table 
data – check file format, 
supported data types 
and data license 

Verify that each layer in the feature service has an associated 
feature class in the geodatabase and that the published feature 
service and zipped file geodatabase contain the same number of 
layers. 

URLOpen Error 
[Errno11001] 
getaddrinfo failed 
URLOpen Error 
[Errno11004] 
getaddrinfo failed 

Verify that baseURL parameter contains a forward slash at the end 
of the address, for example, 
http://myorganization.maps.arcgis.com/. 
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Use Transportation 511 
The Transportation 511 solution delivers a set of capabilities that help you import critical 
information from your incident management system and share roadway information with the 
public so they can make informed decisions before they travel. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

View road conditions 
You will assume the role of a motorist planning travel to your next destination in search of 
information about road conditions prior to driving across state. You will use the Transportation 
511 app to discover current roadway conditions, restrictions and closures, and other alerts to 
help plan a safer trip. 

1. In a browser, from the Transportation 511 solution, view the Transportation 511 app. 

  The Road Conditions widget is open by default. Road Conditions categories are 
presented in a list with corresponding total counts. 

  Note: 

  Information shown in the Road Conditions list automatically updates as you pan and 
zoom the map to different extents or when searching for a location by address. 

2. Click a category to expand it. 

  After expanding a category, you may notice that it includes expandable lists that are 
specific to a particular road or highway. 

3. If necessary, in the category, expand a list. 

4. Click one of the listed reports. 

  On the map, a pop-up displays at the location of the incident. The pop-up includes details 
about the incident, and, for some types of incidents, it provides a link to additional 
information. 

5. In the Road Conditions widget, to the left of a category, click the button to turn the layer 
on and off. 

 

Configure data updates 
The Overwrite Hosted Features script is meant to be scheduled as a task to run regularly to 
keep road condition information current in the app. The script takes a zipped file geodatabase 
and overwrites the published feature collection with the current road condition information. The 
script can run on a machine without ArcGIS installed. You will now assume the role of a 
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employee in the transportation agency responsible for keeping the Transportation 511 app up to 
date with the latest information on road conditions across the state. 

 

Configure script parameters 

To configure the Overwrite Hosted Features script, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Transportation 511 solution item. 

2. Open the item page and click Overwrite Features. 

3. On the item page, click Download. 

4. Unzip the OverwriteFeatures folder. 

5. Download and install Python version 2.7 or version 3.4 if you do not have it installed on 
your machine. 

6. Browse to and open the overwrite_hosted_features.cfg file in a text editor, and 

update the following inputs: 

  Parameter 

  Description 

  featureServi
ceItemID 

  The item ID for your Transportation 511 feature service. 

  featureColle
ctionItemID 

  The item ID for your Transportation 511 feature collection. 

  Note: 

  Item IDs are found at the end of the URLs when viewing item 
details, for example, 
http://myorganization.maps.arcgis.com/home/item.html
?id=d7c57317a0564cafae28cdc464d63ff9. 

  fgdb   The path to the provided zipped file geodatabase, for example, 
C:\Transportation511\RoadConditions.zip. 

  Tip: 

  A sample schema geodatabase is provided in the Overwrite 
Features .zip file. 

  baseURL   Your organization's URL, for example, 
https://myorganization.maps.arcgis.com. 

  username   Your ArcGIS username. 

  pw   Your ArcGIS password. 

  maxAllowable
Offset 

  To optimize performance of the data in the application, it is 
recommended that you generalize complex line and polygon 
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features. Enter the maximum amount of simplification you want for 
the features in the feature collection. 

  Note: 

  This is defined in the units of the spatial reference of the service, 
by default, in meters. 

  nameMapping   To ensure that features in your feature collection are updated with 
data from the correct feature class in the file geodatabase, enter a 
layer mapping to match layers in the published feature layer with 
the file geodatabase feature class in this parameter following this 
pattern: 

  Feature Service Layer 1, Database Feature Class 1; Feature 
Service Layer 2, Database Feature Class 2 

  Note: 

  The defaults provided in the configuration file work against the 
provided sample geodatabase and the deployed feature service. 

  path (Optional)   The path and file name where you want the log to be written. 

  isVerbose 

(Optional) 

  True or false. To disable logging, leave this parameter blank. 

    

7. Save your edits to the configuration file. 

8. Run the Overwrite Hosted Features script, overwrite_hosted_features.py, to test your 

configuration. If necessary, refer to the troubleshooting guide below. 

 

Schedule data updates 

You can use the Overwrite Hosted Features script (overwrite_hosted_features.py) with 

Windows Task Scheduler to overwrite feature collections at a regular interval. Scheduled 
updates ensure that users have access to current information to support more timely decision-
making when traveling. 

To update the Transportation 511 feature collection on a schedule, complete the following 
steps: 

• Open Task Scheduler on the computer hosting the scripts. 

• Click Action > Create Task and name your task. 

• Click the Action tab and click New. 

• Set Action to Start a Program. 

• Click Browse and go to the location of your Python installation (for example, <default 
directory>\Python27\python.exe), and click Open. 
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• In the Add Arguments text box, type the path and name of the script 
(overwrite_hosted_features.py) and path and name of the configuration file 

(overwrite_hosted_features.cfg), and click OK. 

• Click the Trigger tab, click New, and set a schedule for your task. 

• Click the Settings tab, click the If the task is already running, then the following rule 
applies drop-down arrow, and choose Do not start a new instance. 

• Click OK. 
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Shelter Locator 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. The capabilities have been replaces by Emergency Management Operations. 

Mature phase 
Nov. 2023 – Oct. 2025 

Retired phase 
Nov. 2025 

 

Introduction to Shelter Locator 
Shelter Locator can be used to share emergency shelters activated during an incident or event. 

It provides continuous access to an organization, and the location-enabled search helps 
residents quickly find shelter information. This transparent approach improves communication 
with the public and promotes efficient use of transportation and shelter resources. Shelter 
Locator is typically implemented by emergency management agencies that want to avoid 
unnecessary travel when conditions require residents to seek protection outside of their homes. 

The Shelter Locator solution delivers a set of capabilities that help you share shelter locations 
and promote the current operating status of shelters when an incident or event occurs. 

 

Requirements 
Shelter Locator requires the following: 

• ArcGIS Online 

 

Information products 
Shelter Locator includes the following information products: 

Item Description 
Minimum 
user type 

Shelter 
Locator 

A Nearby app used by the general public to locate emergency 
shelters activated during an incident or event and understand their 
current operating status 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 
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Version Description 

1.0 • First release of Shelter Locator 
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Configure Shelter Locator 
Shelter Locator can be used to share emergency shelters activated during an incident or event. 

In this topic, you'll learn how to configure the Shelter Locator solution to meet specific needs in 
your organization. 

 

Load data from a shapefile or file geodatabase 
You can upload existing emergency shelter data to the Shelter Locator solution. 

To load data from a shapefile or file geodatabase, complete the following steps: 

1. Create a .zip file of your shapefile or file geodatabase. 

2. Sign in to your ArcGIS organization and browse to the Emergency Shelters feature layer. 

  Note: 

  Some of the feature layers have a suffix added, such as public. These are layer views of 
the of the original source feature layer. These layer views are used to share information 
with the public without showing all the details or allowing the public to edit the layers. The 
original source layers do not have a suffix. 

3. From the item page, click Update Data. 

4. Follow the steps in the Update layer wizard to load your data. 

Tip: 

When the Emergency Management Operations solution and the Shelter Locator solution 
are deployed by the same user, the EmergencyShelters layer is shared between the 
solutions. This allows the emergency shelter status to be updated using the Operations 
Response app. The shelter status is then visible in the Shelter Locator and other apps that 
are part of the Emergency Management Operations solution. 

 

Configure directions (optional) 
You can configure Shelter Locator to provide directions to the nearest shelter. Enabling 
directions will consume credits. 

Follow the steps below to connect to a routing service and configure the app to enable 
directions. 

1. If necessary, sign in to your ArcGIS organization and browse to the Shelter Locator app. 

2. From the item page, click Configure. 

  Close the Welcome to the App Setup Page splash page, if necessary. 

3. Click Nearby > Options and turn on the Show directions toggle button. 

4. Check the check box next to the Open Shelters layer. 

5. Click Publish. 

6. Click Confirm. 
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  The Authorize premium content window appears with information related to 
authorization. 

7. Click Authorize. 

8. Click Launch. 
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Use Shelter Locator 
The Shelter Locator solution delivers a set of capabilities that help you share shelter locations 
and promote the current operating status of shelters when an incident or event occurs. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Locate an emergency shelter 
You will assume the role of a resident in the community and want to learn more about available 
shelters in your area. 

Follow the steps below to locate a shelter using the sample data. 

1. In a browser, from the Shelter Locator solution, view the Shelter Locator app. 

2. Review the information about locating open emergency shelters, and then click the Close 
button. 

3. In the Shelter Locator pane, for Find address or place, type an address. 

4. In the Shelter Locator pane, drag the buffer distance slider to set a distance of 3 miles. 

  The slider allows a user to define a distance after an address is entered or a location is 
identified on the map. 

5. In the Shelter Locator pane, in the Open Shelters search results, review shelter 
information, such as address, hours of operation, status, and contact information. 
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Vaccine Coverage Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. The capabilities have been replaced with Immunization Outreach. 

Mature phase 
Mar. 2023 – Feb. 2025 

Retired phase 
Mar. 2025 

 

Introduction to Vaccine Coverage Analysis 
Vaccine Coverage Analysis can be used to identify underserved populations and optimize plans 
for disease vaccination sites. 

Comprehensive vaccination coverage is one of the most effective ways to stop a pandemic and 
reopen communities. Communities of color and socioeconomically vulnerable areas are 
disproportionately burdened when vaccinations are available but underutilized. Identifying areas 
of low vaccination rates and vulnerable populations can help ensure equitable vaccine 
distribution. Vaccine Coverage Analysis is typically implemented by health and human services 
or public safety agencies that want to optimize the location of vaccination sites, maximize limited 
resources, and ensure communities affected the most have access to vaccines. 

The Vaccine Coverage Analysis solution delivers a set of capabilities that help you identify 
priority and underserved populations, locate optimal vaccination sites, and share vaccine site 
information with internal and external stakeholders. 

 

Requirements 
Vaccine Coverage Analysis requires the following: 

• ArcGIS Online 

• ArcGIS Pro 2.7–ArcGIS Pro 2.9 (Advanced) 

• ArcGIS Geostatistical Analyst extension 

 

Information products 
Vaccine Coverage Analysis includes the following information products: 

Item Description 
Minimum user 
type 

Vaccine 
Coverage 
Analysis 

An ArcGIS Pro project used by health and human services 
analysts to identify priority and underserved populations, 
locate optimal vaccination sites, and share vaccine site 
information with internal and external stakeholders 

GIS 
Professional 
Advanced 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://doc.arcgis.com/en/arcgis-solutions/latest/reference/introduction-to-immunization-outreach.htm#GUID-E59E2102-740C-428E-AC5B-E09362F3E524


 

Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal Page 252 

Release notes 
The following are the release notes: 

Version Description 

1.2 An update to the Vaccine Coverage Analysis ArcGIS Pro project to resolve a bug in 
the Create Ranked Surface tool. 

1.1 Added support for single dose vaccines and revised vaccination rate calculation. 

Resolved an issue in the Configure Existing Sites model that prevented the Append 
tool from functioning properly in ArcGIS Pro 2.8. 

1.0 First release of Vaccine Coverage Analysis 
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Use Vaccine Coverage Analysis 
The Vaccine Coverage Analysis solution delivers a set of capabilities that help you identify 
priority and underserved populations, locate optimal vaccination sites, and share vaccine site 
information with internal and external stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

 

Identify coverage gaps 
Priority populations and vaccine rates can be used to identify underserved populations quickly 
using the Vaccine Coverage Analysis project. Current vaccination statistics collected from 
vaccination sites and priority populations will help you identify areas that have low vaccination 
rates and high-priority populations. 

You will start by assuming the role of a health and human services analyst. You are asked to 
use the Vaccine Coverage Analysis project to identify underserved populations. 

1. Sign in to your ArcGIS organization and browse to the Vaccine Coverage Analysis Desktop 
Application Template. 

2. Open the item page and click Download. 

3. Unzip and open the Vaccine Coverage Analysis ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Vaccine Coverage 
Analysis task. 

6. In the Tasks pane, click the Identify underserved populations task group to expand the 
collection of tasks. 

7. In the Tasks pane, double-click the Prepare vaccination and priority population task and 
follow the steps provided. 

8. Double-click the Create coverage map task and follow the steps provided. 

9. Double-click the Evaluate current vaccine distribution by drive time task and follow the 
steps provided. 

 

Locate vaccination sites 
The best vaccination sites can be quickly located with the Vaccine Coverage Analysis project. 
Use the previously identified coverage gaps and a list of candidate sites to locate new sites in 
your community. 

You will continue to assume the role of a health and human services analyst. You are asked to 
use the Vaccine Coverage Analysis project to select the best vaccination sites from a list of 
candidate sites that meet needs defined in the vaccine gap analysis. 

1. Open the Vaccine Coverage Analysis ArcGIS Pro project. 

On the View tab, in the Windows group, click Catalog Pane. 

2. In the Catalog pane, expand the Tasks folder, and double-click the Vaccine Coverage 
Analysis task. 

3. In the Tasks pane, click the Locate vaccination sites task group to expand the collection 
of tasks. 
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4. In the Tasks pane, double-click the Identify potential distribution sites task and follow the 
steps provided. 

5. Double-click the Select new points of distribution task and follow the steps provided. 
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Warming and Cooling Centers 

 

This solution documentation has been archived and is no longer updated. Content and links 
may be outdated. The capabilities have been replaces by Emergency Management Operations. 

Mature phase 
Nov. 2023 – Oct. 2025 

Retired phase 
Nov. 2025 

 

Introduction to Warming and Cooling Centers 
Warming and Cooling Centers can be used to inventory temporary shelters that are established 
when extreme cold or heat becomes dangerous to public health and share this information with 
the public. 

It provides a comprehensive inventory of temporary shelters, including public, nonprofit, and 
private shelters, that can be shared with the public. This collaborative approach provides a 
single inventory of facilities that provide relief from potentially dangerous conditions and ensures 
there are facilities available to meet community demand. Warming and Cooling Centers is 
typically implemented by emergency management agencies that want to develop a 
comprehensive inventory of shelters available in a community and share available resources 
with the public. 

The Warming and Cooling Centers solution delivers a set of capabilities that help you source 
the locations of warming and cooling centers from community partners, review each center to 
ensure they meet health and safety requirements, and share the locations of the temporary 
shelters with the public. 

 

Requirements 
Warming and Cooling Centers requires the following: 

• ArcGIS Online 

 

Information products 
Warming and Cooling Centers includes the following information products: 

 

Item Description 
Minimum 
user type 

Warming and 
Cooling Center 
Reporter 

A Crowdsource Reporter app used by community members 
to identify the location of warming and cooling centers used 
during extreme weather conditions. 

Not required 
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Warming and 
Cooling Center 
Manager 

A Crowdsource Manager app used by health and safety 
agencies to manage warming and cooling center locations 
submitted by community members. 

Editor 

Warming and 
Cooling Center 
Locator 

A configuration of the Nearby app used by the general 
public to locate designated warming and cooling centers 
near a given location. 

Not required 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution 
item that organizes the key information products and summarizes all the ArcGIS items 
(applications, forms, projects, maps, feature layers, feature layer views, and so on) included 
with the solution. The ArcGIS Solution item also illustrates any dependencies items have on 
each other. 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 First release of Warming and Cooling Centers 
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Configure Warming and Cooling Centers 
Warming and Cooling Centers can be used to inventory temporary shelters that are established 
when extreme cold or heat becomes dangerous to public health and share this information with 
the public. 

In this topic, you'll learn how to configure the Warming and Cooling Centers solution to meet 
specific needs of your organization. 

 

Load data from a spreadsheet 
If you already have a list of warming and cooling facilities that you want to use in your Warming 
and Cooling Centers solution, you can load them into the feature service provided. 

To load data from a spreadsheet, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the feature layer that you want to 
populate. 

2. From the item page, click Update Data. 

3. Follow the steps in the Update layer wizard to load your data. 

 

Configure directions (optional) 
Warming and Cooling Center Locator app can be configured to provide directions to the nearest 
warming and cooling centers. When directions are configured the routing service will consume 
credits. 

Complete the following steps to connect to a routing service and configure the app to enable 
directions: 

1. If necessary, sign in to your ArcGIS organization and browse to the Warming and Cooling 
Center Locator app. 

2. From the item page, click Configure. 

3. Close the Welcome to the App Setup Page splash page, if necessary. 

4. Click Nearby > Options and turn on the Show directions toggle button. 

5. Check the check box next to the Cooling Centers and Warming Centers layers. 

6. Click Publish. 

7. Click Confirm. 

8. The Authorize premium content window appears with information related to authorization. 

9. Click Authorize. 

10. Click Launch. 
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Use Warming and Cooling Centers 
The Warming and Cooling Centers solution delivers a set of capabilities that help you source 
the locations of warming and cooling centers from community partners, review each center to 
ensure they meet health and safety requirements, and share the locations of the temporary 
shelters with the public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 
the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

Report warming and cooling centers 
The Warming and Cooling Center Reporter app can be used by community organizations to 
identify warming and cooling centers in public facilities such as libraries, schools, churches, or 
community centers. 

In this workflow, you will assume the role of a community member who is reporting a facility to 
be used as a warming or cooling center. 

 

Add centers to the map 

1. In a browser, from the Warming and Cooling Centers solution, view the Warming and 
Cooling Center Reporter app. 

2. Click Proceed as Guest. 

3. At the lower right, click Report a Center. 

4. For Location, click the map or type a valid address to add a new center. 

5. Complete the report with as much information as possible. 

6. Click Report It. 

 

Manage warming and cooling centers 
Since some of the locations may be temporary, you may need to change operational days or 
hours. In addition, you may want to inspect newly reported centers before sharing them with the 
public. 

 

Manage locations 

Next, you’ll assume the role of the health and human services employee who is in charge of 
managing warming and cooling centers and their availability in the community. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Warming and 
Cooling Centers solution. 

2. View the Warming and Cooling Center Manager app. 

3. Warming and cooling centers are listed in the table at the top. 
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4. From the table, select the center that you created in the previous step. 

The center's details open at the lower left. 

5. In the details, click the Edit record button . 

6. For Public View, choose Yes. 

7. Scroll down and click Save. 

 

Locate warming and cooling centers 
The Warming and Cooling Center Locator app can be used by the public and engaged 
organizations to locate warming and cooling centers. Search for an address or click the map to 
locate a center near this location. 

 

Find a service 

Now, you’ll assume the role of a person who needs a warming or cooling center. 

1. In a browser, from the Warming and Cooling Centers solution, view the Warming and 
Cooling Center Locator app. 

2. The Warming and Cooling Center Locator app shows all centers in the community. 

3. On the left, in the search field, search for a location. 

  Warming and cooling centers closest to that address appear. 

  Tip: 

  To see more results, move the slider to increase the search radius. 

4. On the left, expand Cooling Centers or Warming Centers to see specific results. 

5. In the panel, point to a result to see it highlighted on the map or click a point on the map to 
jump to the center's information in the panel. 

6. If applicable, click Directions to show directions to the facility. 
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